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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accom-
panying such products and services. Nothing herein should be construed as constituting an additional war-
ranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Con-
sistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Doc-
umentation, and Technical Data for Commercial Items are licensed to the U.S. Government under
vendor's standard commercial license.

For information about third-party license agreements, see the license-agreements directory on the product
installation media.

Copyright Notices

© Copyright 2008 Hewlett-Packard Development Company, L.P.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).
Portions Copyright © 1999-2003 The Apache Software Foundation. All rights reserved.

This product includes ASM Bytecode Manipulation Framework software developed by Institute National de
Recherche en Informatique et Automatique (INRIA). Copyright © 2000-2005 INRIA, France Telecom. All
Rights Reserved.

This product includes Commons Discovery software developed by the Apache Software Foundation
(http://www.apache.org/). Copyright © 2002-2008 The Apache Software Foundation. All Rights Reserved.

This product includes Netscape JavaScript Browser Detection Library software, Copyright © Netscape
Communications 1999-2001

This product includes Xerces-J xml parser software developed by the Apache Software Foundation
(http://www.apache.org/). Copyright © 1999-2002 The Apache Software Foundation. All rights reserved.

This product includes software developed by the Indiana University Extreme! Lab (http://ww-
w.extreme.indiana.edu/). Xpp-3 Copyright © 2002 Extreme! Lab, Indiana University. All rights reserved.

Trademark Notices

DOM4J® is a registered trademark of MetaStuff, Ltd.

HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32 and 64-bit configurations)
on all HP 9000 computers are Open Group UNIX 95 branded products.

Java™ is a US trademark of Sun Microsystems, Inc.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

Oracle Technology— Notice of Restricted Rights

Programs delivered subject to the DOD FARSupplement are ‘commercial computer software’ and use,
duplication, and disclosure of the programs, including documentation, shall be subject to the licensing
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restrictions set forth in the applicable Oracle license agreement. Otherwise, programs delivered subject to
the Federal Acquisition Regulations are ‘restricted computer software’ and use, duplication, and dis-
closure of the programs, including documentation, shall be subject to the restrictions in FAR 52.227-19,
Commercial Computer Software-Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway,
Redwood City, CA 94065.

For the full Oracle license text, see the license-agreements directory on the NNMi product DVD.
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Using Network Node Manager

NNMi enables you to quickly detect, isolate, and troubleshoot abnormal network behavior. Using NNMi,
you can also record what has been done to date to troubleshoot or resolve a problem.

The following table describes some of the ways that NNMi assists in making your job easier and the help
topics that would be most valuable for accomplishing those tasks.

Task Help Topic

Rapidly detect, isolate, and correct the
problem

"Monitoring Devices for Problems" (on page 118) and "Inves-
tigate and Diagnose Problems" (on page 165)

Annotate information for future diag-
nosis

"Accessing Device Details" (on page 26)

Look for historical information to
proactively monitor the network

"Monitoring Incidents for Problems" (on page 130)

View an inventory of what is being
managed

"Learning Your Network Inventory" (on page 14)
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Access NNM 6.x and 7.x Features

Your NNMi administrator might have configured NNMi so that you are able to view incidents that are being
forwarded from an NNM 6.x or 7.x management station.

If your NNMi administrator has configured any NNM 6.x or 7.x management stations, you are able to view
this information using the Inventoryworkspace. The Management Stations view in the Inventorywork-
space is useful for identifying all of the NNM 6.x or 7.x management stations that might be forwarding inci-
dents to your NNMi incident views. See "Management Stations View (Inventory)" (on page 24) for more
information.

If an NNM 6.x or 7.x management station has been configured, you are also able to access the following
NNM 6.x or 7.x features from the NNMi Actions menu:

Note: You can only launch the 6.x/7.x ovw action if ovw is running on the NNM 6.x/7.x management sta-
tion.

From Incident Views

● Actions→ 6.x/7.x Neighbor View

● Actions→ 6.x/7.x Details

● Actions→ 6.x/7.x ovw

From Management Station Views

● Actions→ 6.x/7.x Home Base

● Actions→ 6.x/7.x ovw

● Actions→ 6.x/7.x Launcher

● Actions→ SNMP Viewer

● Actions→ Alarms

Note: You can only access NNM 6.x/7.x features by selecting incidents generated from NNM 6.x/7.x
events.
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Learning Your Network Inventory

After NNMi discovers your network (or rediscovers it on a regular basis), you have several options for
exploring what was discovered. See up-to-date information for each of the following:

Object
Type Purpose

Nodes Identify all nodes being managed.

Network
interfaces

Identify all network interfaces being managed, their associated node, and any interfaces
that are disabled or otherwise unavailable.

IP
addresses

Identify the IP addresses associated with each node being managed.

IP Subnets Identify all of the networks within NNMi's management domain. Browse for large and small
subnets.

VLANs identify all of the switch port VLANs configured in your network environment. NNMi ignores
VLAN-1, but higher numbered VLANs are discovered.

Types of Views Provided by NNMi

Within any table view, you can quickly view a few additional properties of your network devices. To do so,

click the  Quick View icon within the row representing a network object. Quick View provides information
at a glance for some pre-determined object attributes.

Forms are a way to gain a more in depth understanding of a particular object instance. To view the form

for the object's attributes, from a table view, click the  Open icon that precedes the object information.
The form containing the information for the object's attributes appears.

To view all of the text for an attribute value within the form, click the attribute label of interest. The attribute
value appears in a popup window. This option is useful when not all of the text is viewable within the form
field.

You can also access another form from the current one for any related objects. Related objects in a form

appear as lookup fields. Each  Lookup field includes a drop-down menu that lets you open the form
for that object.

Views can be filtered by pre-defined Node Groups and Interface Groups . Select a filter by using the

drop-down filter selection. See Filter by Node or Interface Group for
more information about filters.

In the form for that object, you can view or edit the information for the selected object as described in Work-
ing with Objects.

Related Topics

"Nodes View (Inventory)" (on page 15)

"Interfaces View (Inventory)" (on page 16)

"IP Addresses View (Inventory)" (on page 17)

"IP Subnets View (Inventory)" (on page 18)
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Filter Views by Node or Interface Group

When monitoring your network, you might be interested in only viewing information for a particular set of
nodes or interfaces. Your network administrator is able to group sets of nodes or interfaces into node or
interface groups. An example of a Node Group could be all important Cisco routers, or all routers in a par-
ticular building. As another example, all interfaces used for Voice-Over-IP might be grouped together in a
Node Group.

Note: Node Group filters are not available for the NNM 6.x/7.x Events view.

You can filter the following kinds of views by Node Group:

● Node views

● Interface views

● IP address views

● Incident views

You can filter the following views by interface group:

● Interface views

● IP address views

If a view includes filtering by both node and interface groups, NNMi lists the Node Groups first, followed
by all of the interface groups. Each list appears in alphabetical order.

To filter a view by node or interface group:

1. Navigate to the view of interest

a. From the workspace navigation panel, select the workspace that contains the view you want to
use; for example Inventory.

b. Select the view of interest; for example Nodes.

2. In the  group selector drop-down list, select the Node or Interface
Group you want to use as a filter.

Nodes View (Inventory)

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Nodes view in the Inventory workspace is useful for identifying all of the nodes being managed by
NNMi.

For each node displayed, you can identify its overall status (for example, Normal,Warning,Minor,Major,
Critical, or Unknown), device category (for example, Switch), name, hostname, management address,
system location (the current value of the sysLocation MIB variable), device profile, date indicating the last
time the node status was modified, and any notes included for the node.

Note: Your NNMi administrator is able to delete nodes and other objects from the NNMi database. If you
are viewing an object, such as a node, that has recently been deleted by another user, the node
appears in your view until your view is refreshed. See Refresh a View for information about refresh-
ing a view.

Node views are useful for quickly identifying items described in the following table.

Use Description

Uses for Nodes Views

Page 15 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Learning Your Network Inventory

View all problem nodes Sort the view by Status so that you can be quickly alerted
to existing and potential problems.

You can also access the Critical Nodes view provided by
NNMi. See "Critical Nodes View" (on page 119) for more
information.

View all device types being managed Sort the view by the Device Profile attribute.

Identify whether the problem can be iso-
lated to a particular area of your network

Sort the view by System Location. This is the current
value of the sysLocation MIB variable.

View address and subnet information asso-
ciated with a selected node to better deter-
mine the scope of the problem

From the Nodes view, open the Node form. Select the
Addresses tab.

Access a map view of a selected node and
its surrounding topology

Select the node of interest and use the Actions menu
from the main toolbar to select either the Layer 2 or Layer

3 Neighbor View. See Using Table Views for more infor-

mation

View the statuses of interfaces on the node If a node is not completely down, you might want to see
which interfaces are down for the selected node. To do
so, open the Node form and select the Interfaces tab.

The number of devices that are served by
this node.

Select the node you want and access the Layer 2 or Layer
3 Neighbor View using the Actions menu.

View the status of all of the nodes that have
been grouped together in a nodes group;
for example, all of your important Cisco
routers.

Your NNMi administrator can create Node Groups. These
groups might contain only the nodes important to you.
See Filter Information in a Table View for more infor-
mation.

Related Topics:

Using Table Views

"Node Form" (on page 27)

Print Table Information

Interfaces View (Inventory)

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Interfaces view is useful for identifying the network interfaces managed by NNMi.

For each interface displayed in the view, you can identify the interface’s overall status (for example, Nor-
mal,Warning,Minor,Major, Critical, or Unknown), its administrative (AS) and operational (OS) status,
associated node Name value (Hosted On Node), the interface name, interface type, interface speed,
input speed, output speed, the date the interface information was last changed, its description, the ifAlias
value, and any notes included for the interface.

If you see several blank columns for an interface in a table view, the interface might be an interface on a
non-SNMP node or a Nortel private interface. Click here for more information.

For interfaces on non-SNMP nodes, note the following: 
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● The interface index (ifIndex) value is always set to 0 (zero).

● The interface type (ifType) is set to Other.

● The interface Name (ifName), if none is available, is set to Pseudo Interface.

● If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP address. Otherwise, the
interface Alias (ifAlias) is set with information from neighboring SNMP devices.

● NNMi obtains the MAC address if the IP address can be resolved using ARP cache.

Note the following about Pseudo interfaces: NNMi attempts to obtain additional information using a vari-
ety of discovery protocols.

For Nortel SNMP interfaces, note the following: 

● The ifIndex value is set according the Nortel private MIB.

● NNMi tries to collect the MAC address and interface name using Nortel's private MIBs.

Interface views are useful for quickly identifying items described in the following table.

Use Description

View all network interfaces per node Sort the view by Hosted On Node. This is the current
value in NNMi’s database for the Name attribute of the
host device.

Determine the health of each of the man-
aged interfaces

Sort the view by the Status attribute.

To view only those interfaces whose status is Critical,
use the Critical Interfaces view provided by NNMi. See
"Critical Interfaces View" (on page 118) for more infor-
mation.

Access a map view of the network interface
and its surrounding topology.

Select the interface of interest and use the Actions menu
to select either the Layer 2 or Layer 3 Neighbor view.
See Using Table Views for more information.

View the status of all of the interfaces that
have been grouped together in a node or an
interfaces group; for example, all of the inter-
faces on the important Cisco routers or all of
the Voice-Over-IP interfaces within your net-
work.

Your NNMi administrator can create nodes and interface
groups. These groups might include only those nodes or
interfaces important to you. Now you can filter the inter-
faces view by a node or an interface group. See Filtering
a View by a Node or Interface Group for more infor-
mation.

Uses for Interfaces Views

Related Topics:

Using Table Views

"Interface Form" (on page 58)

Print Table Information

IP Addresses View (Inventory)

Tip: See "IP Address Form" (on page 72) for more information about the IP address attributes that appear
in this view's column headings.

The IP Addresses view in the Inventory workspace is useful for identifying all of the IP addresses being
managed by NNMi.
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For each IP address displayed, you can identify its status, state, IP address, interface name (In Interface),
associated node Name value (Hosted On Node), the subnet prefix (In Subnet) and prefix length (PL), and
any notes included for the IP address.

The IP Address view is useful for quickly identifying items described in the following table.

Use Description

View all IP addresses per node Sort the view on Hosted On Node attribute.

View the addresses per interface Sort the view on the Interface name (In Interface) attribute.

View the addresses per subnet Sort the view on the subnet (In Subnet) attribute.

View the subnet information for a
selected IP address

To access a subnet from this view:

1. Select the IP address of interest.

2. Open the IP Address form

3. Navigate to the In Subnet attribute. Click the  Lookup

icon and select  Open to access the IP Subnet form.

View the status of all of the
addresses for the nodes that have
been grouped together in a nodes
group; for example, all of your
important Cisco routers.

Your NNMi administrator can create node or interface groups.
These groups might include only those nodes or interfaces impor-
tant to you. Now you can filter the addresses view by a node or
interface group. See Filtering a View by a Node or Interface Group
for more information.

Uses for the IP Addresses View

Related Topics:

Use Table Views

"IP Address Form" (on page 72)

Print Table Information

IP Subnets View (Inventory)

Tip: See "IP Subnet Form" (on page 112) for more details about the IP subnet attributes that appear in this
view's column headings.

The IP Subnets view is useful for identifying all of the networks within your management domain.

For each IP subnet displayed, you can identify its name, the subnet prefix (In Subnet) and prefix length (
PL), the date and time its status was last changed, and any notes included for the subnet.

The IP Subnets view is useful for quickly identifying items described in the following table.

Use Description

Determine all nodes within a
subnet

Use the Layer 3 Neighbor view to easily see the number of problem
nodes within a subnet.

Browse for large and small
subnets

Scan the Name column to view the list of available subnets.

Uses for the Subnets View
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You can identify empty subnets by opening the form for a selected subnet and viewing the IP addresses
table.

Related Topics:

Use Table Views

"IP Subnet Form" (on page 112)

Print Table Information

VLANs View (Inventory)

A virtual local area network (VLAN) is a logical network within a physical network. The VLAN creates a
reduced broadcast domain. Participating devices can physically reside in different segments of a LAN.
The participating VLAN member devices behave "as if" they were all connected to one LAN.

Several VLANs can co-exist within a network. A device can participate in multiple VLANs. And a trunk port
can participate in multiple VLANs.

There are several types of VLANs. NNMi supports switch port VLANs.

Note: NNMi does not currently support protocol-based VLANs and MAC-based VLANs.

To display the VLAN view:

1. In theWorkspaces navigation pane, select the Inventoryworkspace.

2. Select the VLANs view.

Note: NNMi ignores VLAN-1, but higher numbered VLANs are discovered.

3. Use the VLAN view to quickly identify all of the switch port VLANs configured in your network envi-
ronment:

For each VLAN, the VLAN view displays the VLAN identification value, name, hostname of a rep-
resentative node, IfName of a representative interface on the node, and member node count.

If your VLAN view contains two or more VLANs with the same name, those VLANs exist in separate
broadcast domains.

Related Topics:

"VLAN Form" (on page 85)

Print Table Information

Layer 2 Connections View

Tip: See "Layer 2 Connection Form" (on page 105) for more details about the Layer 2 connection attrib-
utes that appear in this view's column headings. 

The Layer 2 Connections view in the Inventory workspace is useful for identifying all of the connections
being managed by NNMi. Sorting this view by Topology Source lets you easily identify all user added con-
nections.

For each connection displayed in the view, you can identify the status, name, the data source or protocol
(Topology Source) used to create the connection (for example CDP or USER), the date and time the con-
nection was last modified, and any notes related to the connection.

Related Topics
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Print Table Information

Nodes By Device Category View (Inventory)

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Nodes byDevice Category view lets you filter your view by the device category value. Examples of
device categories include Firewall,Gateway, Hub, and Load Balancer.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

Use this view to monitor a specific category of devices. If your NNMi administrator set up Node Groups or
Interface Groups to identify important elements of your environment, you can filter this view to show only
devices of a certain category that are within a certain group of nodes. Using the device category and Node
Group filters might be useful for troubleshooting purposes, so that you can take the same approach for
devices in the same category.

Note: If you filter your view using additional filters, such as Node Groups, NNMi uses the AND operator to
combine the filters you have selected. See Filter a Table View for more information.

For each node displayed, you can identify its overall status (for example, Normal,Warning,Minor,Major,
Critical, or Unknown), name, hostname, management address, system location (the current value of the
sysLocation MIB variable), device profile, date indicating the last time the node status was modified, and
any notes included for the node.

Related Topics

Use Table Views

Filter a Table View

Print Table Information

Interfaces by IfType View (Inventory)

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Interface by IfType view lets you filter your view by the Interface Type value. The list of interface types
contains the industry standard known values for MIB II interface types. Examples of interface types
include: asynch, atm, bsc, and ces.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

Use this view to monitor a specific type of interfaces. If your NNMi administrator set up Node Groups or
Interface Groups to identify important elements of your environment, you can filter this view to show only
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certain types of interfaces within a certain group of nodes. Using the type and Node Group filters might be
useful for troubleshooting purposes.

Note: If you filter your view using additional filters, such as Node Groups, NNMi uses the AND operator to
combine the filters you have selected. See Filter a Table View for more information.

For each interface displayed in the view, you can identify the interface’s overall status (for example, Nor-
mal,Warning,Minor,Major, Critical, or Unknown), its administrative (AS) and operational (OS) status,
associated node Name value (Hosted On Node), the interface name, interface speed, its description, its
ifAlias value, the date the interface status was last modified, the name of the Layer 2 connection asso-
ciated with the interface, and any notes that exist for the interface.

If you see several blank columns for an interface in a table view, the interface might be an interface on a
non-SNMP node or a Nortel private interface. Click here for more information.

For interfaces on non-SNMP nodes, note the following: 

● The interface index (ifIndex) value is always set to 0 (zero).

● The interface type (ifType) is set to Other.

● The interface Name (ifName), if none is available, is set to Pseudo Interface.

● If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP address. Otherwise, the
interface Alias (ifAlias) is set with information from neighboring SNMP devices.

● NNMi obtains the MAC address if the IP address can be resolved using ARP cache.

Note the following about Pseudo interfaces: NNMi attempts to obtain additional information using a vari-
ety of discovery protocols.

For Nortel SNMP interfaces, note the following: 

● The ifIndex value is set according the Nortel private MIB.

● NNMi tries to collect the MAC address and interface name using Nortel's private MIBs.

Related Topics

Using Table Views

Print Table Information

Custom Nodes View (Inventory)

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Custom Nodes view enables you to create a customized view of nodes. This view includes most of
the attributes available for the node so that you can decide which are most important for you to display.
See Use Table Views for more information about sorting, filtering, and hiding attributes within a view.

The Custom Nodes view includes the node's overall status (for example, Normal,Warning,Minor,Major,
Critical, or Unknown), device category (DC), name, fully-qualified hostname (including the domain
name, if available), management address, system location (the current value of the sysLocation
MIB variable), device profile, date indicating the last time the node status was modified, any notes that
exist for the node, its system name, system contact name, a system description, the management mode,
the system object ID (MIB II sysObjectID), the name of its SNMP agent, its discovery state, whether the
node is SNMP supported, the creation date, and the date the node was last modified.

See "Nodes View (Inventory)" (on page 15) for more information about ways to use a node view.

Related Topics:

Use Table Views
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Print Table Information

Custom Interfaces View

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Custom Interfaces view lets you choose the columns of interface information, to better meet your
needs. For example, you might want to filter the view to display only the interfaces related to a particular
set of devices.

This view includes most of the attributes available for the incident so that you can decide which are most
important for you to display. See Use Table Views for more information about sorting, filtering, and hiding
attributes within a view.

For each interface displayed, you can view its state, its administrative and operational state, the asso-
ciated hostname (Hosted On Node), its interface name, type, speed, description, the value of its alias, the
date and time the status was last modified, the name of the Layer 2 connection associated with the inter-
face, any notes related to the interface, its direct management mode, its node management mode, the
physical address, the interface index, the creation date, and the date and time the interface was last mod-
ified.

If you see several blank columns for an interface in a table view, the interface might be an interface on a
non-SNMP node or a Nortel private interface. Click here for more information.

For interfaces on non-SNMP nodes, note the following: 

● The interface index (ifIndex) value is always set to 0 (zero).

● The interface type (ifType) is set to Other.

● The interface Name (ifName), if none is available, is set to Pseudo Interface.

● If the interface hosts an IP address, the interface Alias (ifAlias) is set to the IP address. Otherwise, the
interface Alias (ifAlias) is set with information from neighboring SNMP devices.

● NNMi obtains the MAC address if the IP address can be resolved using ARP cache.

Note the following about Pseudo interfaces: NNMi attempts to obtain additional information using a vari-
ety of discovery protocols.

For Nortel SNMP interfaces, note the following: 

● The ifIndex value is set according the Nortel private MIB.

● NNMi tries to collect the MAC address and interface name using Nortel's private MIBs.

See Filter a Table View for more information about how to filter information displayed in a table.

Related Topics:

Use Table Views

Print Table Information

Router Redundancy Group View (NNMi Advanced)

Tip: See "Router Redundancy Group Form (NNMi Advanced)" (on page 78) for more details about the
Router Redundancy Group attributes that appear in this view's column headings. 
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Your network administrator might have set up groups of redundant routers to help ensure that information
packets reach their intended destination. Use the Router Redundancy Group view to see all of the avail-
able groups of redundant routers in your network.

For each Router Redundancy Group displayed in the view, you can identify the Router Redundancy Group
status, Router Redundancy Group name, the Router Redundancy Group protocol (for example, HSRP),
and the date the Router Redundancy Group status was last modified.

To see the incidents related to a Router RedundancyGroup:

1. Click the  Open icon that precedes the Router Redundancy Group of interest to open the form.

2. Navigate to the Incidents tab to see the incidents associated with the selected Router Redundancy
Group.

To view the members that belong to this group:

Click the  Open icon that precedes the Router Redundancy Group of interest to open the form.

On the Router Router RedundancyMembers tab, you should see a table view of the nodes and inter-
faces that belong to the selected Router Redundancy Group.

Related Topics

"Non-Normal Router Redundancy Group View (NNMi Advanced)" (on page 121)

"Router Redundancy Group Form (NNMi Advanced)" (on page 78)

Print Table Information

Custom IP Addresses View (Inventory)

Tip: See "IP Address Form" (on page 72) for more details about the IP address attributes that appear in
this view's column headings.

The Custom IP Addresses view displays most IP address attribute columns. Sort and filter this IP address
view to meet your needs, if the out-of-the-box views provided by NNMi don't provide exactly what you
want.

See Use Table Views) for more information about sorting, filtering, and hiding attribute columns within a
view.

For each address displayed in the view, you can identify the status, state, address, the name of the inter-
face (In Interface), associated node Name value (Hosted On Node), the subnet in which the address is
contained, the subnet prefix length (PL), the date the address status was last modified (Status Last Mod-
ified), any notes that exist for the IP address, its direct management mode, date the state of the address
was last modified (State Last Modified), date the address was created, date the address was last mod-
ified.

See "IP Address Form" (on page 72) for more information about the IP address attributes.

Related Topics

Use Table Views

Print Table Information

Node Groups View (Inventory)

Tip: See the context-sensitive link for the Node Groups form for more details about the Node Group attrib-
utes that appear in this view's column headings
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When checking your network inventory, you might be interested in only viewing information for a particular
set of nodes. Your network administrator is able to group sets of nodes into node groups. An example
node group could be all important Cisco routers, or all routers in a particular building. See About Node
and Interface Groups for more information about how your administrator sets up node groups. See Filter
by Node or Interface Group for more information about filtering views using node groups.

To find the definition for a particular Node Group filter, navigate to the Inventory workspace, and select the
Node Groups view.

For each node group displayed in the view, you can identify the node group status, name, whether the
node group appears in the filter list for node and interface views, whether the node group is available as a
filter in NNM iSPI for Performance, and any notes about the node group.

Related Topics

Print Table Information

Interface Group View

Tip: See "Interface Form" (on page 58) the "Using the Interface Groups Form" context-sensitive link for
more details about the Interface Group attributes that appear in this view's column headings.

When checking your network inventory, you might be interested in only viewing information for a particular
set of interfaces. Your network administrator is able to group sets of interfaces into interface groups. See
About Node and Interface Groups for more information about how your administrator sets up interface
groups. See Filter by Node or Interface Group for more information about filtering views using interface
groups.

To find the definition for a particular Interface Group filter, navigate to the Inventory workspace, and select
the Interface Groups view.

For each interface group displayed in the view, you can identify the interface group name,whether the
interface group appears in the filter list for interface views, whether the interface group is available as a
filter in NNM  iSPI for Performance, and any notes about the interface group.

Related Topics

Print Table Information

Management Stations View (Inventory)

Your NNMi administrator might have configured NNMi so that you are able to view incidents that are being
forwarded from a NNM  management station (from either an NNM 6.x or 7.x management stations). If
your NNMi administrator configured any NNM management stations, you are able to view this information
using the Inventoryworkspace.

To view attribute information for any NNM management stations that have been configured:

From theWorkspaces navigation pane, select Inventory→ Management Stations.

The Management Stations view in the Inventoryworkspace is useful for identifying all of the NNM 6.x or
7.x management stations that might be forwarding incidents to your NNMi incident views, as well as
launching directly to the NNM  6.x/7.x management station.

For each management station displayed, you can identify its name, the version of NNMi that is running on
that machine (either 6.x or 7.x), the IP address for the machine, the OpenView Application Server (ovas)
port number, the Web server port number, and a description for the management station that was pro-
vided by your NNMi administrator.
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Note: If an NNM management station has been configured, you are also able to access the following 6.x
or 7.x features from the NNMi Actions menu: Home Base, ovw , Launcher, and Alarms. See
"Access NNM 6.x and 7.x Features" (on page 13) for more information.

Related Topics

Print Table Information

Page 25 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Accessing Device Details

Accessing Device Details

NNMi provides forms that help you easily view all details associated with a managed object, such as a
node, SNMP agent, interface, address, subnet, or connection. NNMi also provides a Quick View that dis-
plays a small subset of information about an object.

From a table view, to view all details associated with an object:

1. From the workspace navigation panel, select a workspace containing a view of the object of interest.

2. Select a view that contains the specific object (for example, Inventory→ Nodes).

3. Click the   Open icon within the row representing the object.

4. The form displays, containing details of all information related to the object.

5. View or edit the details of the selected object:

■ "Node Form" (on page 27)"SNMP Agent Form" (on page 49)

■ "Interface Form" (on page 58)

■ "IP Address Form" (on page 72)

■ "Layer 2 Connection Form" (on page 105)

■ "IP Subnet Form" (on page 112)

■ "VLAN Form" (on page 85)

Tip: A form is also available for incidents, see "Incident Form" (on page 132).

Note: NNMi also provides forms for SNMP Agent and Port objects. The SNMP Agent form is accessed
from the Node form. The Port form is accessed from the VLAN form.

From a map view, to view all details associated with an object:

1. Display a map using the Troubleshooting workspace, or the Actions→menu.

2. Select the object and click the  Open icon in the menu bar.

3. The form displays, containing details of all information related to the object.

4. View or edit the details of the selected object:

■ "Node Form" (on page 27)"SNMP Agent Form" (on page 49)

■ "Interface Form" (on page 58)

■ "IP Address Form" (on page 72)

■ "Layer 2 Connection Form" (on page 105)

■ "IP Subnet Form" (on page 112)

■ "VLAN Form" (on page 85)

Tip: A form is also available for incidents, see "Incident Form" (on page 132).

To access the Quick View for a selected object:

1. From the workspace navigation panel, select a workspace containing a view of the object of interest.

2. Select a table view that contains the specific object (for example, Inventory→ Nodes).

3. In a table view, do one of the following:
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■ Click the  Quick View icon within the row representing the object. 

■ Using your mouse, hover over the  Quick View icon.

4. In a map view, using your mouse, hover over the object of interest.

The Quick View window displays, containing some of the details of the object.

Related Topics:

Using Table Views

Using Map Views

Node Form

The Node form provides details about the selected node. It also provides details about the interfaces, the
IP addresses, the VLANs, the ports, the SNMP agent, the device profile, and the incidents associated with
this node.

If your role allows, you can use this form to modify the Management Mode for a node (for example to indi-
cate it will be temporarily out of service) or add notes to communicate information about this node to your
team.

For information about each tab:

Attribute Description

Name The name assigned to this device (according a strategy created by your NNMi admin-
istrator). The name might be a hostname determined by the hostname resolution
strategy used in your environment (such as DNS), a MIB II sysName, or an address. Con-
tact your NNMi administrator if you have questions.

This name is used in table views and maps. This name cannot be modified in the Node
form.

Basic Attributes
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Attribute Description

Hostname The fully-qualified hostname for this device (according to any hostname resolution
strategy currently in use in your network environment; for example, DNS). 

Note: NNMi converts hostnames to all lowercase.

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to deter-
mine the hostname. Click here for details.

1. If a hostname is available, it must resolve to a valid IP address. NNMi stores the
fully-qualifiedhostname in the database as all lowercase characters.

2. If more than one address is associated with a node, the loopback address1 is used
with the following exceptions:

■ NNMi prefers loopback interfaces for management communication, where pos-
sible. However, NNMi automatically filters out addresses in the reserved loop-
back network range 127/24 (127.*.*.*).

■ NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Ren-
dezvous Point IP Address2.

3. If a node has multiple loopback addresses, NNMi uses the loopback address with
the lowest number that resolves to a hostname (for example, 10.16.42.197 is a
lower number than 10.16.197.42).

4. If no loopback address resolves to a hostname and the device supports SNMP,
NNMi uses the current value from the Management Address attribute on the Node
form.

5. If the device does not support SNMP, the IP address or DNS name found during the
current rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change
from cycle to cycle (for example, if an address did not respond to SNMP queries due to
network problems or node reconfiguration).

This name cannot be modified in the Node form.

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured
loopback for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNM identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
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Attribute Description

Notes Provided for network operators to use for any additional notes required to further explain
the node. Information might include why the node is important, if applicable, or to what
customer, department, or service the node is related. Additional information might
include where the nodes is located, who is responsible for it, and its serial number. You
might also track maintenance history using this attribute.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and under-
line characters are allowed.

Note: You can sort your node table views based on this value. Therefore, you might want
to include keywords for this attribute value.
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Attribute Description

Status Overall status for the current node. NNMi follows the ISO standard for status clas-
sification. See the "Node Form: Status Tab" (on page 47) for more information. Possible
values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

The status of all IP addresses and the SNMP Agent associated with this node contribute
to node status. For information about how the current status was determined, see the
Conclusions tab. Status reflects the most serious outstanding conclusion. See "Watch
Status Colors" (on page 126) for more information about possible status values.

Note: The icons are displayed only in table views.

Node Man-
agement
Mode

Indicates whether the current node is being managed. This field also lets you specify
whether a node is temporarily out of service. Possible values are:

Managed – Indicates the node is managed by NNMi.

Not Managed – Indicates the node is intentionally not managed. For example, the
node might not be accessible because it is in a private network. NNMi does not
update discovery information or monitor these nodes.

Out of Service – Indicates a node is unavailable because it is out of service. NNMi
does not update discovery information or monitor these nodes.

This attribute is useful for notifying NNMi when a device has been temporarily out of
service, or should never be managed.

SNMP Agent State Attributes

SNMP Sup-
ported

Indicates whether the node responded to SNMP requests to determine whether the node
has an SNMP agent.
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Attribute Description

State Indicates whether the SNMP Agent assigned to this node is available and how NNMi is
using SNMP to interact with this SNMP Agent. Possible values are:

Normal – Indicates that the agent responded to an SNMP query.

Unresponsive – Indicates that the SNMP agent did not respond to an SNMP query.

Note: State is determined by the State Poller Service. The current state contributes
towards the status calculation for the node. See the Status tab for more infor-
mation.

State Last
Modified

Indicates the date and time when the State value was last modified.

SNMP Agent IP address of the SNMP Agent assigned to the current node. This can be the address of
either the SNMP agent on the device or an SNMP Proxy Server configured to pass along
information from that SNMP agent.

Click the  Lookup icon and select  Open to display the the "SNMP Agent Form"
(on page 49) for more information.

Discovery Attribute

Device Pro-
file

Name of the device profile that determines how devices of this type are managed and
the icon and background shape displayed on maps.

Click the  Lookup icon and select  Open to display the "Device Profile Form" (on
page 54) for more information.

Discovery
State

Current discovery status for the node. Possible values are:

Newly Created – Indicates the node and its IP addresses are in the NNMi database, but
further information needs to be collected before state and status are determined.

Discovery Completed – Indicates that all of the discovery information for the node has
been collected.

Rediscovery in Process – Indicates discovery is updating information that has been col-
lected for the node.

Last Com-
pleted

Time of the last discovery cycle.

Notes Provided for network operators to use for any additional notes required to further explain
the node. Information might include why the node is important, if applicable, or to what
customer, department, or service the node is related. Additional information might
include where the nodes is located, who is responsible for it, and its serial number. You
might also track maintenance history using this attribute.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and under-
line characters are allowed.

Note: You can sort your node table views based on this value. Therefore, you might want
to include keywords for this attribute value.
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Node Form: General Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

System
Name

The MIB II sysName value returned from the device's SNMP agent. This attribute is set by
the device administrator.

If sysName is part of the strategy used to populate the node Name attribute value, NNMi
avoids populating the NNMi database with multiple devices having the same man-
ufacturer's default name by following a set of rules. Click here for details.

For each device type, NNMi has a Device Profile that includes a record of the man-
ufacturer's default sysName. Other settings within the Device Profile can change the way
NNMi determines sysName values.

To view the Device Profile associated with this node, locate the Device Profile attribute in

the Basics section of the Node form, and click the   Lookup icon. Your NNMi admin-
istrator can make changes to a Device Profile, if necessary.

System
Contact

Optional MIB II sysContact value. This attribute is set by the device administrator. It usually
includes the contact person for the managed node as well as information about how to
contact this person.

System
Description

Optional MIB II sysDescr value for the device description. This attribute is set by the device
administrator.

System
Object ID

MIB II sysObjectID value provided by the vendor. This value identifies the device vendor,
type, and model. For example, all Cisco 6509 devices have the same system object ID.

System
Location

Optional MIB sysLocation value for the physical location of the current node. For example,
Building K, 3rd floor. This attribute is set by the device administrator.

SNMP Values

Node Form: IP Addresses Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

IP
Addresses

Table view of the IP addresses associated with the selected node. You can use this table to
determine the status, state, address, interface, and subnet for each address associated with
the selected node.

Click the  Open icon to open the"IP Address Form" (on page 72) and view more infor-
mation about a specific address.

IP Addresses Table

Node Form: Interfaces Tab

The "Node Form" (on page 27) provides details about the selected node.
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For information about each tab:

Attribute Description

Interfaces Table view of all of the interfaces associated with the current node. You can use this table to
determine the status, administrative state, operational state, name, type, interface speed,
and Layer 2 connection for each interface associated with the selected node.

Click the  Open icon to open the "Interface Form" (on page 58) and view more infor-
mation about a specific interface.

Interfaces Table

Node Form: VLAN Ports Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

VLAN
Ports

Table view of all of the VLAN ports associated with the current node. Use this table to deter-
mine all port and VLAN combinations associated with this node.

Click the  Open icon to open the Port form and view more information about a specific
VLAN port.

VLAN Ports Table

Node Form: Ports Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

Ports Table view of all of the ports associated with the current node. You can use this table to deter-
mine the VLAN membership of each port associated with the selected node.

Click the  Open icon to open the "Port Form" (on page 86) and view more information
about a specific port.

Ports Table

Node Form: Capabilities Tab

The Node Form: Capabilities Tab displays a table view of any capabilities added to the node object by
NNMi or an external application. Capabilities enable NNMi and application programmers to provide more
information about a node than is initially stored in the NNMi database. For example, NNMi Advanced uses
the capability com.hp.nnm.capability.rrp.hsrp when a node is a member of an HSRP group.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified.

For information about each tab:
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Attribute Description

Capability The name of the capability added to a node object by either NNMi or an external appli-
cation. For more information, see:

● "Node Capability Form" (on page 36)

● "Node Capabilities Provided by NNMi" (on page 34)

Unique
Key

The database identifier for the capability that either NNMi or an external application added
to this node.

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "Node Capabilities Provided by NNMi" (on page 34)
for a description of the capabilities provided by NNMi that might appear on the Node
Form: Capabilities Tab.

Capabilities Table

Node Capabilities Provided by NNMi

The Node Form: Capabilities Tab displays a table view of any capabilities added to the node object.
Capabilities that begin with com.hp.nnm.capability represent capabilities that NNMi provides. External
applications can also add node capabilities.

Note: NNMi also provides Capabilities on the Interface form Capabilities tab, additional abilities assigned
to an interface by either NNMi or an external application. Capabilities enable NNMi and application
programmers to provide more information about an interface than is initially stored in the NNMi
database.

The following table includes the node capabilities NNMi provides to assist in determining node com-
ponent health metrics. See "Node Form: Component Health Tab" (on page 38) for more information about
health metrics.

Virtual Router Redundancy Protocol (VRRP) or Hot Standby Router Protocol (HSRP)

Capability Unique Key Description

CHASSISMGREXT
-MIB MIB

com.hp.nnm.capability.metric.cme The node supports the
indicated MIB.

CISCO-
ENHANCED-
BUFFER-MIB

com.hp.nnm.capability.metric.ceb The node supports the
indicated MIB.

CISCO-
ENHANCED-MEM-
ORY-POOL-MIB

com.hp.nnm.capability.metric.cem The node supports the
indicated MIB.

CISCO-ENVMON-
MIB

com.hp.nnm.capability.metric.cenv The node supports the
indicated MIB.

Cisco Env Fan com.hp.com.capability.metric.cisco.env.fan The node supports
CISCO-ENVMON-MIB.

Cisco Env Power com.hp.com.capability.metric.cisco.env.power The node supports
CISCO-ENVMON-MIB.

NNMi Node Capabilities
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Capability Unique Key Description

Cisco Stack Fan com.hp.nnm.capability.metric.cisco.stack.fan The node supports
CISCO-STACK-MIB.

Cisco Stack Power com.hp.nnm.capability.metric.cisco.stack.power The node supports
CISCO-STACK-MIB.

CISCO-MEMORY-
POOL-MIB

com.hp.nnm.capability.metric.cmp The node supports the
indicated MIB.

CISCO-PROCESS
-MIBv1

com.hp.nnm.capability.metric.cpm1 The node supports the
indicated MIB.

CISCO-PROCESS
-MIBv2

com.hp.nnm.capability.metric.cpm2 The node supports the
indicated MIB.

CISCO-SYSTEM-
EXT-MIB

com.hp.nnm.capability.metric.cse The node supports the
indicated MIB.

HOST-
RESOURCES-MIB

com.hp.nnm.capability.metric.hr The node supports the
indicated MIB.

IP Forwarding
(Layer 3)

com.hp.nnm.capability.node.ipforwarding Value that indicates
NNMi identified the
selected node as a
router that forwards
Layer 3 data. NNMi eval-
uates SNMP MIB-II sys-
Services and other
clues to determine this
value and set the sym-
bols in map views. The
NNMi administrator can
override this value
using the Device Profile
form, Force Device
attribute (see "Device
Profile Form" (on page

54)).

LAN Switching
(Layer 2)

com.hp.nnm.capability.node.lanswitching Value that indicates
NNMi identified the
selected node as a
switch for Layer 2 data.
NNMi evaluates SNMP
MIB-II sysServices and
other clues to deter-
mine this value and set
the symbols in map
views. The NNMi admin-
istrator can override this
value using the Device
Profile form, Force
Device attribute (see
"Device Profile Form"
(on page 54)).
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Capability Unique Key Description

Nortel Passport
Metrics

com.hp.nnm.capability.metric.rc The node is a Nortel
Passport device.

Nortel BayStack
Metrics

com.hp.nnm.capability.metric.s5 The node is a Nortel
BayStack devices.

OLD-CISCO-
BUFFER-MIB

com.hp.nnm.capability.metric.ocb The node supports the
indicated MIB.

OLD-CISCO-CPU-
MIB

com.hp.nnm.capability.metric.occ The node supports the
indicated MIB.

OLD-CISCO-MEM-
ORY-MI

com.hp.nnm.capability.metric.ocm The node supports the
indicated MIB.

Capability Unique Key Description

FDVRRP com.hp.nnm.capability.rrp.fdvrrp NNMi Advanced. The node is a member of a
Foundry Virtual Router Redundancy Protocol
(FDVRRP) group.

HPVRRP com.hp.nnm.capability.rrp.hpvrrp NNMi Advanced. The node is a member of an
HP Virtual Router Redundancy Protocol
(HPVRRP) group.

HSRP com.hp.nnm.capability.rrp.hsrp NNMi Advanced. The node is a member of an
Hot Standby Router Protocol (HSRP) group.

RCVRRP com.hp.nnm.capability.rrp.rcvrrp NNMi Advanced. The node is a member of a Nor-
tel Rapid City Virtual Router Redundancy Protocol
(RCVRRP) group.

VRRP com.hp.nnm.capability.rrp.vrrp NNMi Advanced. The node is a member of a Vir-
tual Router Redundancy Protocol (VRRP)group.

NNMi Advanced Additional Capabilities

Node Capability Form

This form describes a capability added to the node object by NNMi or an external application. Capabilities
enable NNMi and application programmers to provide more information about a node than what is initially
stored in the NNMi database. For example, NNMi Advanced uses the capability com.hp.nnm-
.capability.rrp.hsrp to identify when a node is a member of an HSRP group.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified.

Each of the Capability attributes is described in the table below.
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Attribute Description

Capability Label used to identify the Capability that was added to the node object. The Capability value
is listed in the table on the Capabilities tab in a Node form. See "Node Form: Capabilities
Tab" (on page 33).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi begins with
the prefix com.hp.nnm.capability.

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "Node Capabilities Provided by NNMi" (on page 34)
for a description of the capabilities provided by NNMi that might appear on the Node
Form: Capabilities Tab.

Basics Attributes

Node Form: Custom Attributes Tab

Custom Attributes enable an NNMi administrator to add information to the Node object . Custom Attributes
can also be set by external applications that have been integrated with NNMi.

The Node Form: Custom Attributes Tab displays a table view of any Custom Attributes that have been
added to the selected node. For example, your NNMi administrator might have added Serial Number as
another attribute for the nodes in your network.

Note: If your role allows, you can edit a Custom Attribute. Only user accounts with NNMi Administrator role
can add a Custom Attribute.

For information about each tab:

Attribute Description

Name Name used to identify the Custom Attribute.

Value The actual value for the Custom Attribute for the selected node. For example, the value for
the Serial Number attribute might be: UHF536697J3

Custom Attributes Table

Node Custom Attributes Form

Custom Attributes enable an NNMi administrator to add information to a node object . For example, your
NNMi administrator might have added Serial Number as another attribute for the nodes in your network.
Custom Attributes can also be set by external applications that have been integrated with NNMi.

The Custom Attributes form displays the Name and Value for each of the Custom Attributes that were
added to the node object. Each of these attributes is described in the table below.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on the Cus-
tom Attributes tab in Node forms.

Value Value assigned to the Custom Attribute for the selected node. For example, the value for the
Serial Number attribute might be: UHF536697J3.

Basics Attributes
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Node Form: Node Groups Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

Node
Groups

Table view of all Node Groups to which this node belongs.

Click the  Open icon to view more information about a specific Node Group filter con-
figuration.

Node Groups Table

Node Form: Component Health Tab

The "Node Form" (on page 27) provides details about the selected node.

The Node Form: Component Health tab displays information about node health related to the following
fault metrics:

● Fan

● Power Supply

● Temperature

● Voltage

NNM iSPI for Performance. If the NNM iSPI for Performance is installed and configured within your envi-
ronment, the Node Form: Component Health tab also displays information about node health related to
the following performance metrics:

● CPU utilization

● Memory utilization

● Buffer utilization

● Buffer miss rate

● Buffer failure rate

For information about each tab:

Attribute Description

Component
Health

Table view of the health metrics associated with the current node. You can use this table
to determine the Status, Name, and Type for each health metric associated with the
selected node.

Click the  Open icon to open the "Node Component Form" (on page 38) and view more
information about a specific metric and its monitored attributes.

Component Health Table

Node Component Form

This form describes the fault and performance metrics used to monitor node component health. NNMi
obtains fault metrics from the node's MIB files. The NNMi administrator can set threshold values for each
of the performance health metrics displayed.

Fault metrics include the following:
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● Fan

● Power Supply

● Temperature

● Voltage

NNM iSPI for Performance. The following performance metrics require an NNM  iSPI for Performance
license:

● CPU utilization

● Memory utilization

● Buffer utilization

● Buffer failures

● Buffer misses

For information about each tab:

Attribute Description

Status Overall status for the current node. NNMi follows the ISO standard for status classification.
See the "Node Component Form: Status Tab " (on page 43) for more information. Possible
values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see the Conclusions tab.
Status reflects the most serious outstanding conclusion. See "Watch Status Colors" (on page
126) for more information about possible status values.

Note: The icons are displayed only in table views.

Basic Attributes
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Attribute Description

Name Name of the node component whose health attribute is being measured, For example, NNMi
measures fault metrics for Fan, Power Supply, Temperature, and Voltage node components.

NNM iSPI for Performance. If licensed and installed, NNM iSPI for Performance also meas-
ures performance metrics for CPU, memory, and buffer utilization, as well as for buffer fail-
ures and misses.

When possible, NNMi obtains the Name value for the node component from the associated
MIB file. The number of MIBs available and subsequently the number of health attributes that
are measured for each node component vary. For example, if the node component is of
type Buffer, up to five MIBs that contain information about the Buffer component are avail-
able (Small, Medium, Large, Big, and Huge). NNMi collects information from each MIB that is
available and lists a node component Name value for each. For example, If all five MIBs are
available, you see the following node components listed in the Component Health table:
Small Buffers, Medium Buffers, Large Buffers, Big Buffers, and Huge Buffers.

Note: If the associated MIB file does not provide a name value, NNMi uses the value con-
tained in the Type attribute.

Type Identifies the aspect of node health that is being monitored. Possible values include:

● Fan

● Power Supply

● Temperature

● Voltage

NNM iSPI for Performance. The following performance types require an NNM iSPI for Per-
formance license:

● CPU utilization

● Memory utilization

● Buffer utilization

● Buffer failures

● Buffer misses

Hosted

On Node

Node on which the health metric is being measured. This is the current value in NNMi’s data-

base for the Name attribute of the host device. The value could be a DNS name, a MIB II
sysName, or an address (depending on how your NNMi administrator configured the dis-
covery process).

Node Component Form: Health Attributes Tab

The "Node Component Form" (on page 38) provides details about the monitored attributes for the current
node.  

For information about each tab:
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Description

Table view of the Name and State of each monitored attribute associated with the health metric for the
selected node component. Use this view to determine the State of the monitored attributes for the
selected node.

Click the  Open icon to open the "Health Attribute Form" (on page 41) and view more information
about a specific attribute.

Attributes Table

Health Attribute Form

The Health Attribute form displays information about node component health related to the selected attrib-
ute .

Fault metrics are available for the following node components

● Fan

● Power Supply

● Temperature

● Voltage

NNMi obtains fault metric information from the associated MIB.

NNM iSPI for Performance. If the NNM iSPI for Performance is installed and configured within your envi-
ronment, the Node Form: Component Health tab also displays information about node health related to
the following performance metrics. The NNMi administrator sets the threshold for node components
related to performance metrics:

● CPU utilization

● Memory utilization

● Buffer utilization

● Buffer miss rate

● Buffer failure rate

Attribute Description

Name Name used to identify the attribute being monitored.

The number of health attributes available vary depending on the number of MIBs available
for the current node component. See "Node Component Form" (on page 38) for more infor-
mation.

The Name of each health attribute identifies the attribute being measured as well as the type
of MIB used to gather this information. For example, when monitoring CPU utilization, NNMi
uses values measured for 1-minute, 5-minute, and 5-second intervals. Each of these values
might be available from an old, standard, or most recent (revised) MIB file. The following
example health attribute names indicate the CPU measurement interval as well as the fact
that the information was collected from the most recent (revised) MIB:

● CPU Revised 1 Minute

● CPU Revised 5 Minute

● CPU Revised 5 Second

Basics Attributes
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Attribute Description

State Normalized value used to indicate the State of the health attribute on the selected node. Pos-
sible values are listed below.

Note: The NNMi State Poller interprets and normalizes the State value returned for the mon-
itored attribute to handle the differences between vendor-specific nodes.

Normal - Indicates there are no known problems related to the associated object.

Warning - Indicates there may or may not be a problem related to the associated object.

Minor - Indicates NNMi has detected problems related to the associated object that
require further investigation.

Major - Indicates NNMi detected problems that could precede a critical situation.

Critical - Indicates NNMi detected problems that require immediate attention.

One of following States is returned when the monitored attribute is not polled or when the
State data returned for the monitored attribute is either unavailable or in error:

Not Polled - Indicates that this health attribute is intentionally not polled, based on current
Monitoring Configuration settings, current Communication Configuration settings, or
because the parent Node is set to Not Managed or Out of Service

No Polling Policy - No polling policy exists for this monitored attribute.

Unavailable - Unable to determine the State. For example, the value returned might be
outside the range of possible values.

Note: State is determined by the State Poller Service. The current state contributes towards
the status calculation for the node. See the Status tab for more information.

NNM iSPI for Performance. Additional States for performance metrics include the following (
Warning and Critical states are not used for performance metrics):

High - The High threshold was crossed.

Low - The Low threshold was crossed.

None - The threshold value returned is zero.

.

Node Component Form: Incidents Tab

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in the inci-
dent view's column headings.

The "Node Component Form" (on page 38) provides details about the monitored attributes for the
selected node.

For information about each tab:
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Description

Table view of the incidents associated with the selected monitored attribute. These incidents are sorted
by creation time so that you can view the incidents in chronological order. Use this view to determine
which incidents are still open for the monitored attribute.

Click the  Open icon to open the "Incident Form" (on page 132) and view more information about a
specific incident.

Incidents Table

Node Component Form: Status Tab

The "Node Component Form" (on page 38) provides details about the selected health metric for the cur-
rent node. 

For information about each tab:

Attribute Description

Status Overall status for the current node. NNMi follows the ISO standard for status classification.
Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

Note: Your NNMi administrator might have disabled polling of Node Component Health
using the Monitoring Configuration workspace.

The status of the health metric associated with this node contributes to the node's overall
status. For information about how the current status was determined, see the "Node Com-
ponent Form: Conclusions Tab" (on page 44). Status reflects the most serious outstanding
conclusion. See "Watch Status Colors" (on page 126) for more information about possible
status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Overall Status
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Node Component Form: Conclusions Tab

The "Node Component Form" (on page 38) provides details about the selected health metric for the cur-
rent node.

For information about each tab:

Attribute Description

Status Con-
clusions

The dynamically generated list of summary statuses of the monitored attribute at points in
time that contributed to the current overall status of the selected node. Status is set by the
Causal Engine.

Each conclusion listed is outstanding and contributes to the current overall status.

This view is useful for obtaining a quick summary of the problem description for the cur-
rent monitored attribute that led up to the node's most current status.

The status value is correlated based on the most critical conclusions.

To see more information about a specific conclusion:

1. Select the conclusion of interest by checking the selection box that precedes the
object information.

2. Click the Open icon to view more information about a specific conclusion.

Outstanding Status Conclusions Table

Node Form: Diagnostics Tab (NNM iSPI NET)

The "Node Form" (on page 27) provides details about the selected node.

When you access the Node Form: Diagnostics Tab, you can view the history of all the NNM iSPI NET Diag-
nostic reports that have been run for this Node. Diagnostics are sets of automated commands specific to
one or more device types, including Cisco routers and switches, Cisco switch/routers, and Nortel switches.

To generate a new instance of these Diagnostics reports, click Actions→ Run Diagnostics.

For information about each tab:

Attribute Description

Start Time Date and time NNM iSPI NET created this instance of the Diagnostics report. NNM iSPI NET
uses the locale of the client and the date and time from the NNMi management server.

Definition The name of the NNM iSPI NET Diagnostics report definition.

Diagnostics Table
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Attribute Description

Status The current status of this NNM iSPI NET Diagnostics report. Possible values include:

New - The Diagnostic is in the queue, but is not yet running

In Progress -The Diagnostic has been submitted and is not finished running

Completed - The Diagnostic has finished running

Not Submitted - An error condition prevented the Diagnostic from being submitted

Timed Out - NNMi was unable to submit or run the Diagnostic due to a time out error. The
time out limit for submitting a Diagnostic is one hour. The time out limit for running a
Diagnostic is four hours.

Example error conditions include the following:

● The number of Diagnostics in the queue might prevent NNMI from submitting the Diag-
nostic.

● A configuration error, such as an incorrect user name or password, might prevent
NNMi from accessing the required Operations Orchestration server.

Contact your NNMi administrator for Diagnostic log file information.

Report Click this link to open the actual report.

Note: You might be prompted to provide a user name and password to access the Oper-
ations Orchestration software. See the iSPI NET Planning and Installation Guide for
more information.

Last
Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report. NNM iSPI
NET uses the locale of the client and the date and time from the NNMi management server.

Node Diagnostic Results Form (Flow Run Result) (NNM iSPI NET)

NNM iSPI NET automatically prepares diagnostic reports about the source node when certain incidents
are generated and when using Actions→ Run Diagnostics. This form shows details about the currently
selected diagnostic report instance.

Note: Because the values on this form are generated by NNM iSPI NET, these attribute values cannot be
modified.

See "Node Form: Diagnostics Tab (NNM iSPI NET)" (on page 44) for more information.

Attribute Description

Start
Time

The time that NNM iSPI NET created the selected diagnostic report instance.

Definition The name of the flow as defined in NNM iSPI NET.

Diagnostic Results Details
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Attribute Description

Status The current status of this NNM iSPI NET Diagnostics report. Possible values include:

New - The Diagnostic is in the queue, but is not yet running

In Progress -The Diagnostic has been submitted and is not finished running

Completed - The Diagnostic has finished running

Not Submitted - An error condition prevented the Diagnostic from being submitted

Timed Out - NNMi was unable to submit or run the Diagnostic due to a time out error. The
time out limit for submitting a Diagnostic is one hour. The time out limit for running a
Diagnostic is four hours.

Example error conditions include the following:

● The number of Diagnostics in the queue might prevent NNMI from submitting the Diag-
nostic.

● A configuration error, such as an incorrect user name or password, might prevent NNMi
from accessing the required Operations Orchestration server.

Contact your NNMi administrator for Diagnostic log file information.

Report NNM iSPI NET uses this text string to display the selected instance of the diagnostics report
in a browser window.

Lifecycle
State

The Incident's Lifecycle State that determines when this Diagnostic runs. Possible values
include:

● Registered

● In Progress

● Completed

● Closed

See About the Incident Lifecycle for more information about Lifecycle State.

When the Incident is set to this Lifecycle State, the selected Diagnostics (Flow Definitions) is
automatically run on each applicable Source Node in the specified Node Group.

Last
Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report. NNM iSPI
NET uses the locale of the client and the date and time from the NNMi management server.

Node Form: Incidents Tab

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in the inci-
dent table view's column headings.

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:
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Description

Table view of the incidents associated with the selected node. These incidents are sorted by creation
time so that you can view the incidents in chronological order. Use this view to determine which inci-
dents are still open for the selected node.

Click the  Open icon to open the "Incident Form" (on page 132) and view more information about a
specific incident.

Incidents Table

Node Form: Status Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

Status Overall status for the current node. NNMi follows the ISO standard for status classification.
Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

The status of all IP addresses and the SNMP Agent associated with this node, and well as

interface health contribute to node status. For information about how the current status was
determined, see the "Node Form: Conclusions Tab" (on page 48). Status reflects the most
serious outstanding conclusion. See "Watch Status Colors" (on page 126) for more infor-
mation about possible status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Overall Status
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Attribute Description

Status
History

List of up to the last five changes in status for the selected node. This view is useful for obtain-
ing a quick summary of the node status so that you can better determine any patterns in
node behavior and activity.

Click the  Open icon to view more information about a specific status.

Status History Table

Node Form: Conclusions Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

Status Con-
clusions

The dynamically generated list of summary statuses of the node at points in time that con-
tributed to the current overall status of the selected node. Status is set by the Causal
Engine.

Each conclusion listed is still outstanding and applies to the current overall status.

This view is useful for obtaining a quick summary of the status and problem description
for the current node's interfaces that led up to the node's most current status.

Examples of conclusions that might appear together are listed below:

● SNMP Agent Not Responding

● Interface Down

● Address Down

The status value is correlated based on the most critical conclusions. Click the Open
icon to view more information about a specific conclusion.

Outstanding Status Conclusions Table

Node Form: Registration Tab

The "Node Form" (on page 27) provides details about the selected node.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration
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SNMP Agent Form

The SNMP Agent form provides details about the SNMP Agent assigned to the currently selected node.
This form is useful when you want to view more details about the SNMP Agent, including the agent's
status. You can also use the form to determine all of the attributes in the NNMi database associated with
the SNMP Agent.

For information about each tab:

Attribute Description

Name Name used to identify the agent. By default, this name is the DNS resolved hostname
for the node.

Basic Attributes
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Attribute Description

Management
Address

IP address NNMi uses to communicate with this SNMP agent.

: The NNMi administrator can specify an address (Communication Configurations
workspace, Specific Node settings tab), or NNMi can dynamically select one.

When NNMi determines the Management Address, NNMi handles cases where the
SNMP agent supports multiple IP addresses by following a set of rules. Click here for
details.

1. If the node has only one loopback address1, that address is used with the fol-
lowing exceptions:

■ NNMi prefers loopback interfaces for management communication, where
possible. However, NNMi automatically filters out addresses in the reserved
loopback network range 127/24 (127.*.*.*).

■ NNMi ignores any address that is virtual (HSRP/VRRP), an Anycast Ren-
dezvous Point IP Address2, or whose interface is administratively down.

2. If an SNMP agent supports multiple loopback addresses, NNMi uses the loopback
address with the lowest number to which this SNMP agent responds (for example,
10.16.42.197 is a lower number than 10.16.197.42).

3. If no loopback address is supported, NNMi uses the address that meets the fol-
lowing criteria:

■ During initial discovery, NNMi uses the first address to which the associated
SNMP agent responded.

Note: The first address might be either a discovery seed address or an
ARP cache address gathered in the path to this node.

■ During any other discovery cycle, NNMi uses the current Management Address
value.

For this sequence, if the SNMP agent does not respond to any of the above addresses,
NNMi automatically repeats the sequence with SNMPv2c, SNMPv1, and SNMPv3
(according to the current NNMi Communication Configuration settings established by
your NNMi administrator).

This sequence is repeated during each configuration polling cycle. And the address
could change over time (for example, if an address did not respond to SNMP queries
due to network problems or node reconfiguration).

Protocol Ver-
sion

Version of the SNMP protocol in use. NNMi supports SNMP version 1 and 2.

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured
loopback for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNM identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
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Attribute Description

Read Com-
munity String

Community string value that was discovered for the selected SNMP agent.

Note: The community string is an SNMPv1 or SNMPv2c password. The actual com-
munity string is only visible if you are assigned to the Administrator role.

UDP Port User Datagram Protocol port configuration for this SNMP agent.

Default 161. Port NNMi is instructed to use when contacting this SNMP agent to collect
SNMP data. Both the Discovery Process and the State Poller Service use this setting.

SNMP Proxy
Address

Prerequisite: The NNMi administrator must specify one or more SNMP Proxy Servers in
the NNMi Communication Configuration settings.

The IP address of the server that is acting as the SNMP Proxy Server for this
SNMP agent. Your NNMi administrator might have set up one or more SNMP Proxy
Servers to allow communication with nodes that otherwise might be unreachable. For
example, when a node to be managed is behind a firewall. The SNMP Proxy Server
enables NNMi to manage these nodes in the same way as nodes that provide
SNMP access directly.

SNMP Proxy
Port

Prerequisite: The NNMi administrator must specify one or more SNMP Proxy Servers in
the NNMi Communication Configuration settings.

The port number on the server that is acting as the SNMP Proxy Server for this
SNMP Agent. See SNMP Proxy Address (previous attribute) for more information.

SNMP Time-
out

(Seconds:Milliseconds) Time that NNMi waits for a response to an SNMP query before
reissuing the request.

SNMP Retries Maximum number of retries that NNMi issues for an SNMP query before determining
the query result to be "unresponsive". Zero means no retries.

SNMP Agent State Attributes

State Indicates whether the SNMP agent is available and how NNMi is using SNMP to interact
with this SNMP agent. Possible values are:

Normal – Indicates that the agent is being polled and responded to SNMP queries.

Unresponsive – Indicates that the agent is being polled, but did not respond to
SNMP queries.

Note: NNMi's State Poller sets this state. The current state contributes towards the status
calculation for the agent. See "SNMP Agent Form: Status Tab" (on page 52) for
more information.

State Last
Modified

Indicates the date and time when the State value was last modified.

Hosted On
Node

Node on which the SNMP Agent resides. This is the current value in NNMi’s database
for the Name attribute of the host device. The value could be a DNS name, a MIB II
sysName, or an address (depending on how your NNMi administrator configured the
discovery process).

Click the Lookup icon and select  Quick View or Open to display more infor-
mation about the node.
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SNMP Agent Form: Status Tab

The "SNMP Agent Form" (on page 49) provides details about the SNMP Agent of the selected node or
interface.

For information about each tab:

Attribute Description

Status Overall status for the current SNMP agent. NNMi follows the ISO standard for status clas-
sification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see "SNMP Agent Form: Con-
clusions Tab" (on page 52). Status reflects the most serious outstanding conclusion.

Status
Last Mod-
ified

Date and time indicating when the status was last set.

Status
History

List of the changes in the status for the SNMP agent.

Click the Open icon to view more information about a specific status.

Status

SNMP Agent Form: Conclusions Tab

The "SNMP Agent Form" (on page 49) provides details about the SNMP Agent of the selected node or
interface.

For information about each tab:
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Attribute Description

Outstanding
Status Con-
clusion

The dynamically generated list of summary statuses for the SNMP agent at points in
time that contributed to the current overall status of the selected SNMP agent. Status is
set by the Causal Engine.

Each conclusion listed is still outstanding and applies to the current overall status.

This view is useful for obtaining a quick summary of the status and problem description
for the current node's interfaces that led up to the node's most current status.

Examples of conclusions that might appear together are listed below:

● SNMP Agent Not Responding

● Interface Down

● Some Unresponsive Addresses In Node

● Address Not Responding

The status value is correlated based on the most critical conclusions.

Click the Open icon to view more information about a specific conclusion.

Conclusions Table

SNMP Agent Form: Incidents Tab

The "SNMP Agent Form" (on page 49) provides details about the SNMP Agent of the selected node or
interface.

For information about each tab:

Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected SNMP agent. These incidents are
sorted by creation time so that you can view the incidents in chronological order. Use this
view to determine which incidents are still open for the selected SNMP agent.

Click the  Open icon to open the "Incident Form" (on page 132) and view more infor-
mation about a specific incident.

Incidents Table

SNMP Agent Form: Registration Tab

The "SNMP Agent Form" (on page 49) provides details about the SNMP Agent of the selected node or
interface.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration
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Device Profile Form

According to industry standards (RFC 1213, MIB II), each combination of vendor, device type, and model
number is assigned a unique SNMP system object ID (sysObjectID). For example, all Cisco 6500 series
switches have the same sysObjectID prefix: .1.3.6.1.4.1.9.* See the Basic Attributes.

NNMi uses the Advanced Settings to make decisions about how devices are discovered and depicted on
the NNMi maps.

Attribute Description

Device
Model

Device model name or number designator, determined by the vendor.

SNMP
Object ID

MIB II sysObjectID number issued for this device type. These numbers are unique across
all vendors.

Description The description, based on information from the MIB II sysDescr string provided by the ven-
dor.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and underline char-
acters allowed.

Device
Family

Device family name provided by the vendor; for example Cisco Catalyst 6500 Series
Switches or HP AdvanceStack Routers.

Click the  Lookup icon to access the "Device Family Form" (on page 56) for more
details.

Device
Vendor

Name of the vendor that manufactures the device.

Click the  Lookup icon to access the "Device Vendor Form" (on page 56) for more
details.

Device Cat-
egory

The value of this attribute determines which background shape NNMi uses for the map
icon representing devices of this type. See "About Map Symbols" for more information
about the possible values.

Click the  Lookup icon to access the "Device Category Form" (on page 57) for more
details.

OUI Organizationally unique identifier. The first three octets of the MAC address for the device
that identify the device's vendor.

Author Indicates who created the device profile. All profiles provided by NNMi have the value "HP
Network Node Manager".

Click the  Lookup icon to access the "Device Profile Author Form" (on page 57) for
more details.

Basic Attributes

Attribute Description

Use of SNMP SysName for Node Name Resolution

Advanced Settings Tab
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Attribute Description

Never Use
sysName

If   enabled, Spiral Discovery does not allow a MIB II sysName value for the Name attrib-
ute for discovered Nodes of this type. If sysName is part of the current node Name
strategy, NNMi uses the next designated node Name choice in the strategy established by
your NNMi administrator.

If  disabled, MIB II sysName can potentially be used as the Name attribute value for
nodes of this type.

Do not Use
sysName
Starting
With

The vendor's default sysName text string, from MIB II sysName.

If the SNMP agent responds to a sysName request with a value that matches or starts with
the entry in this field (case-sensitive), Spiral Discovery ignores the sysName and considers
sysName to be unset. As a result, NNMi instead tries to find a DNS name or IP address for
this node (according to the strategy established by your NNMi administrator).

For example, when an SNMP agent responds with a default sysName, NNMi's maps might
display multiple icons with the same name (one for every device of that type in your envi-
ronment that responded to an SNMP query with the default sysName). Usually, the device
administrator changes the default sysName value to something more meaningful, so this
problem is avoided.

Device Behaviors

Force
Device

This attribute enables the NNMi administrator to override the IP Forwarding (Layer 3) and
LAN Switching (Layer 2) settings provided by Spiral Discovery (displayed on the "Node
Form: Capabilities Tab" (on page 33)).

Possible values are:

● Force to router

● Force to switch

● Force to end node

● Force to switch and router

Reasons the NNMi administrator might want to use this attribute to override the IP For-
warding (Layer 3) and LAN Switching (Layer 2) capabilities setting for the device include
the following:

● The sysServices setting in the MIB that is used to determine the IP Forwarding (Layer
3) and LAN Switching (Layer 2) capability during discovery is not accurate due to an
IOS defect on the device

● The device serves as a router, switch, or switch and router and the NNMi administrator
wants to force the device to be treated as only one of the following: 1) a router, 2) a
switch, or 3) a switch and router.

Devices whose Force Device attribute is set to either of the following are included in
Layer 3 Neighbor View maps: 1) Force to router or 2) Force to switch and router.

● The device serves as a virtual router, but should not be managed as a router.

Setting the Force Device attribute to Force to end node enables the NNMi admin-
istrator to configure discovery so NNMi ignores this device.
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Attribute Description

Interface
Reindexing
Type

When an interface within a device changes (old one removed, new one added), the inter-
face index number changes. State Poller uses the attribute specified here to detect the
change. Your NNMi administrator chooses which interface attribute indicates a change: ifIn-
dex, ifName, ifDescr, ifAlias, or a combination of ifName and ifDescr. See the General
Interface Attributes (SNMP Values) in Interface Form for more information.

Device Family Form

The Device Family attribute value indicates the family name assigned by the vendor when the device was
manufactured; for example, the Cisco Catalyst 6500 Series Switches.

● NNMi monitoring behavior can potentially be configured differently for each family.

● Membership in a Node Group can potentially be determined by device family.

This form is accessed from the "Device Profile Form" (on page 54).

Attribute Description

Label Device family name. For example, Cisco Catalyst 6500 Series Switches or HP Advance-
Stack Routers.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and underline
characters allowed.

Unique Key The required unique identifier that is important when exporting and importing device pro-
file information within NNMi.

The value must be unique. One possible strategy is to use the Java name space con-
vention. For example:

com.<your_company_name>.nnm.deviceProfile.family.<family_label>

Maximum length 80 alpha-numeric characters. Periods allowed. No spaces allowed.

Management
URL

Optional. The URL to the device's management page (provided by the vendor). This
page is used to provide configuration information for the device and is usually organized
by device family.

Device Family Definition

Device Vendor Form

The Device Vendor attribute value indicates the name of the manufacturer of this device type; for exam-
ple, HP or Cisco. 

● NNMi monitoring behavior can potentially be configured differently for each vendor.

● Membership in a Node Group can potentially be determined by device vendor.

This form is accessed from the "Device Profile Form" (on page 54).
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Attribute Description

Label Vendor name.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and underline char-
acters allowed.

Unique
Key

The required unique identifier that is important when exporting and importing device profile
information within NNMi.

The value must be unique. One possible strategy is to use the Java name space convention.
For example:

com.<your_company_name>.nnm.deviceProfile.vendor.<vendor_label>

Maximum length 80 alpha-numeric characters. Periods allowed. No spaces allowed.

Device Vendor Definition

Device Category Form

The Device Category attribute value indicates the category of this device; for example, router, switch, or
printer. This attribute:

● In Map views, determines which background shape NNMi uses for the icon representing devices of
this type.

● In table views, the category value can be used when sorting/filtering the Category column.

● During discovery, NNMi behavior changes based on the device category. For example, routers and
switches are discovered by default.

● NNMi monitoring behavior can potentially be configured differently for each category.

● Membership in a Node Group can potentially be determined by device category.

This form is accessed from the "Device Profile Form" (on page 54).

Attribute Description

Label Category name.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and underline char-
acters allowed.

Unique
Key The required unique identifier that is important when exporting and importing device profile

information within NNMi.

The value must be unique. One possible strategy is to use the Java name space convention.
For example:

com.<your_company_name>.nnm.deviceProfile.category.<category_label>

Maximum length 80 alpha-numeric characters. Periods allowed. No spaces allowed.

Device Category Definition

Device Profile Author Form

The Author attribute value indicates who created the device profile.

This form is accessed from the "Device Profile Form" (on page 54).
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Attribute Description

Label Author name. If your NNMi administrator modified the default Device Profile provided by
NNMi, a value other than HP Network Node Manager should appear.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and underline char-
acters allowed.

Unique
Key

The required unique identifier that is important when exporting and importing device profile
information within NNMi.

The value must be unique. One possible strategy is to use the Java name space convention.
For example:

com.<your_company_name>.nnm.deviceProfile.author.<author_label>

Maximum length 80 alpha-numeric characters. Periods allowed. No spaces allowed.

Device Category Author

Interface Form

The Interface form provides details about the network interface selected. From this form you can access
more details about the parent node, addresses, current network connection, and incidents associated with
this interface.

If your role allows, you can use this form to modify the Management Mode for an interface (for example to
indicate it will be temporarily out of service) or add notes to communicate information about this interface
to your team.

If you see several blank fields for an interface in a form, the interface is a Nortel private interface. This
means the following:

● The interface has no information in the MIB file.

● NNMi is not able to access the information that is normally available for other interfaces. Only limited
attributes can be determined. Possible attribute values that might be collected include the MAC
address and interface index.

For information about each tab:

Attribute Description

Name The most accurate interface name available to the initial discovery process. First choice
is the IF MIB ifName value. Second choice is the ifAlias value. Third choice is a com-
bination of the ifType[ifIndex] value (for example, ethernetCsmacd[17]).

Basic Attributes
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Attribute Description

Status Overall status for the current interface. NNMi follows the ISO standard for status clas-
sification. See the "Interface Form: Status Tab" (on page 70) for more information. Pos-
sible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Interface status is derived from SNMP polling results for ifAdminStatus and IfOp-
erStatus, as well as from any conclusions. Status reflects the most serious outstanding
conclusion. See the "Interface Form: Conclusions Tab" (on page 71) for information
about how the current status was determined. See "Watch Status Colors" (on page 126)
for more information about possible status values.

Note: The icons are displayed only in table views.

Management
Mode

The calculated Management Mode for the interface. This value should reflect the man-
agement mode assigned to the node on which the selected interface resides. For exam-
ple, if the node's management mode is Managed, and the Direct Management Mode of
the interface is Inherited, the interface's Management Mode value is Managed.

Direct Man-
agement
Mode

Indicates whether the current interface is being managed. This attribute is set by the
administrator and specifies whether an interface should be managed or whether an
interface is temporarily out of service. Possible values are:

Inherited – Used to indicate that the interface should inherit the Management Mode
from the node on which it resides.

Not Managed – Used to indicate that NNMi does not discover or monitor the inter-
face. For example, the interface might not be accessible because it is in a private
network.

Out of Service – Used to indicate an interface is unavailable because it is out of
service. NNMi does not discover or monitor these interfaces.

This attribute is useful for notifying NNMi when an interface is temporarily out of serv-
ice, or should never be managed.

Note: If you change the Direct Management Mode, NNMi updates the calculated Man-
agement Mode on the form. If you manually set the Direct Management Mode
and then Save your changes, the Management Mode value is not updated until
you refresh the form.
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Attribute Description

Hosted On
Node

Node on which the interface resides. This is the current value in NNMi’s database for
the Name attribute of the host device. The value could be a DNS name, a MIB
II sysName, or an address (depending on how your NNMi administrator configured the
discovery process).

Click the  Lookup icon and select  Quick View or  Open to display more infor-
mation about the node.

Physical
Address

The interface’s address at the physical layer, also known as the MAC address. This is
the globally unique serial number assigned to each interface at the factory.

Layer 2 Con-
nection

Used to indicate whether the selected interface is part of a Layer 2 connection. If the
interface is part of a connection, use this attribute to access information about its Layer
2 connection and the neighboring device. Click here for instructions.

1. Navigate to the Layer 2 Connection attribute. Click the Lookup icon, and

select  Open.

2. In the Layer 2 Connection form, locate the Interfaces tab.

3. Click the  Open icon of the other interface participating in this connection.

4. In the Interface form, locate the Hosted On Node attribute.

5. The Node form contains all known information about the neighboring node.

Interface State Attributes

Administrative
State

Either the current MIB II ifAdminStatus value (set by the device's administrator) or a
value calculated by the State Poller Service. The current Administrative State con-
tributes towards the status calculation for this interface. See the "Interface Form: Status
Tab" (on page 70) for more information.

Possible values are:

Up – The SNMP agent responded with an ifAdminStatus value of Up.

Down – The SNMP agent responded with an ifAdminStatus value of Down.

Testing – The SNMP agent responded with an ifAdminStatus value of Testing.

Other – The SNMP agent responded with a value for ifAdminStatus that is not rec-
ognized.

Not Polled – Indicates that this interface is intentionally not polled, based on current
Monitoring Configuration settings, current Communication Configuration settings, or
because the Interface or parent Node is set to Not Managed or Out of Service.

Agent Error – Indicates an SNMP error was returned in response to an SNMP
query to this agent.
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Attribute Description

Operational
State

Either the current MIB II ifOperStatus value or a value calculated by the State Poller
Service. The current Operational State contributes towards the status calculation for this
interface. See the "Interface Form: Status Tab" (on page 70) for more information.

Possible values are:

Up – The SNMP agent responded that the interface is operationally up, ready to
receive and send network traffic.

Down – The SNMP agent responded that the interface is operationally down.

Testing – The SNMP agent responded that the interface is in test mode.

Other – The SNMP agent responded with a value for ifOperStatus that is not rec-
ognized.

Unknown – The SNMP agent responded with an ifOperStatus value of Unknown.

Dormant – Indicates the SNMP agent responded that the interface is in a "pending”
state, waiting for some external event.

Not Present – Indicates that the interface is missing some hardware component.

Lower Layer Down – Indicates the interface is down due to the state of lower-level
interfaces.

Unavailable – The SNMP agent responded, but returned a null value for the ifOp-
erStatus request.

Not Polled – Indicates that this interface is intentionally not polled, based on current
Monitoring Configuration settings, current Communication Configuration settings, or
because the parent Node or Interface is set to Not Managed or Out of Service.

Agent Error – Indicates an SNMP error was returned in response to an SNMP
query to this agent.

State Last
Modified

Indicates the date and time when the Administrative State, Operational State, or both
were last modified.

Notes Provided for network operators to use for any additional notes required to further
explain the interface. Information might include to what service or customer the inter-
face is connected.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and under-
line characters are allowed.

Note: You can sort your interface table views based on this value. Therefore, you might
want to include keywords for this attribute value.

Interface Form: General Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:
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Attribute Description

IfName Optional Interface MIB variable for ifName assigned to the interface by the vendor. If no
IfName value is provided, SNMP uses the ifType+ifIndex which is dynamically con-
figured and can change. This name is not guaranteed to be unique or consistent across
reboots.

IfAlias Optional Interface MIB variable for ifAlias assigned to the interface. This value is set by
the device administrator. An ifAlias could be useful if the interface vendor did not provide
an ifName value.

IfDescription Optional Interface MIB variable for ifDescr for the interface. This attribute is set by the
device administrator. 

IfIndex Interface MIB variable for the row number in the interface table (ifTable) for this interface.
The row number can change with each reboot.

Note: Interfaces on non-SNMP nodes have an ifIndex value of 0 (zero).

IfSpeed Interface MIB variable for the interface’s bandwidth in bits per second. Depending on the
device vendor, this value may indicate current speed or potential speed.

IfType Interface MIB variable for the physical link protocol type of the interface. Possible values
include: Ethernet and frameRelay.

Note: Interfaces on non-SNMP nodes have an ifType value of other.

Input Speed Indicates the speed at which an interface is capable of receiving data in bits per second
("Gbps", "Mbps").

You can type a value to override the ifSpeed value returned by the device's SNMP agent.
NNMi retains the value you enter.

A reason you might want to override this value include the following:

Sometimes the value returned by the device's SNMP agent is not accurate or causes
problems when NNMi calculates performance monitoring. For example, the input speed

might be restricted due to circumstances in your environment, or bandwidth controls
might limit the connection speed regardless of what the physical connection is capable of
(such as within a WAN).

Output
Speed

Indicates the speed at which an interface is capable of transmitting data in bits per sec-
ond ("Gbps", "Mbps").

You can type a value to override the output speed value returned by the device's
SNMP agent. NNMi retains the value you enter.

A reason you might want to override this value include the following:

Sometimes the value returned by the device's SNMP agent is not accurate or causes
problems when NNMi calculates performance monitoring. For example, the output speed
might be restricted due to circumstances in your environment, or bandwidth controls
might limit the connection speed regardless of what the physical connection is capable of
(such as within a WAN).

General SNMP Values

Interface Form: IP Addresses Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

Page 62 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Accessing Device Details

For information about each tab:

Attribute Description

IP
Address

Table view of the IP addresses associated with the selected interface. You can use this table
to determine the state and address for each IP address.

Click the Open icon to open the "IP Address Form" (on page 72) and view more infor-
mation about a specific address.

IP Addresses Table

Interface Form: VLAN Ports Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:

Attribute
Description

VLAN
Ports

Table view of all of the VLAN ports associated with the current interface. Use this table to
determine all port and VLAN combinations associated with this interface.

Click the  Open icon to open the Port Form and view more information about a specific
VLAN port.

VLAN Ports Table

Interface Form: Link Aggregation Tab (NNMi Advanced)

The "Interface Form" (on page 58) provides details about the selected network interface.

For more information about each tab:

The Interface Form: Link Aggregation Tab appears if the selected interface participates in a Link Aggre-
gation1 protocol. The contents of the tab differ based on the Interface's role in the Link Aggregation
(Member or Aggregator).

A Member Interface's Link Aggregation Tab displays the Link Aggregation protocol and a reference to the
Aggregation's Aggregator Interface. Click here for more details about the attributes displayed.

Attribute Description

Aggregator Name of the Aggregator Interface for the selected physical Member Interface. The Aggre-
gator Interface represents the collection of physical interfaces for one end of a Link Aggre-
gation.

See Layer 2 Neighbor View Map Objects for more information.

This name will be the most accurate interface name available to the initial discovery proc-
ess. First choice is the IF MIB ifName value. Second choice is the ifAlias value. Third
choice is a combination of the ifType[ifIndex] value (for example, eth-
ernetCsmacd[17]).

Click the Lookup icon, and choose Open to open the form for the Aggregator
Interface.

Link Aggregation Tab

1A Link Aggregation is comprised of an Aggregator Link, Aggregator Interface, and the physical interfaces
and connections that they represent. An Aggregator Link object represents many-to-many physical con-
nections. For example, two nodes might be connected with four physical connections. These four physical
connections are depicted as a single Aggregator Link object using a thick line on the Layer 2 Neighbor
View map. The interface depicted at each end of the Aggregator Link object is an Aggregator Interface
object. An Aggregator Interface object represents the collection of physical interfaces for one end of an
Aggregator Link.
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Attribute Description

Aggregator Name of the Aggregator Interface for the selected physical Member Interface. The Aggre-
gator Interface represents the collection of physical interfaces for one end of a Link Aggre-
gation.

See Layer 2 Neighbor View Map Objects for more information.

This name will be the most accurate interface name available to the initial discovery proc-
ess. First choice is the IF MIB ifName value. Second choice is the ifAlias value. Third
choice is a combination of the ifType[ifIndex] value (for example, eth-
ernetCsmacd[17]).

Click the Lookup icon, and choose Open to open the form for the Aggregator
Interface.

The Aggregator Interface's Link Aggregation Tab lists the Member Interfaces of its end of the Link Aggre-
gation and provides cumulative bandwidth statistics. Click here more details about the attributes dis-
played.

Attribute Description

Link Aggre-
gation Pro-
tocol

Protocol used to create the Link Aggregation, including the Aggregator Interface and its
physical Members.

Possible values include:

● Cisco Systems Port Aggregation Protocol (pagp)

● Multi-Link Trunk technology (mlt)

● Split Mutli-Link Trunk technology (smlt)

● Inter-switch trunk that is part of a Split Multi-Link Trunk configuration (istMlt)

Available
Bandwidth

Sum of the interface Input Speed attribute values of the Member Interfaces whose MIB II
ifOperStatus is not Down. If the sum of the interface Output Speed attribute values is dif-
ferent, NNMi displays separate Available Input Bandwidth and Available Output Band-
width attributes.

Maximum
Bandwidth

Sum of the interface Input Speed attribute values of the Member Interfaces, regardless of
MIB II ifOperStatus . If the sum of the interface Output Speed attribute values is different,
NNMi displays separate Maximum Input Bandwidth and Maximum Output Bandwidth
attributes.

Available
Bandwidth
Percentage

Percentage value computed using Available Bandwidth divided by the Maximum Band-
width.

Members Table view of the physical Member Interfaces.

Click the Open icon to view more information about a specific interface.

Link Aggregation Tab
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Interface Form: Capabilities Tab

The Interface Form: Capabilities Tab displays a table view of any capabilities added to the interface object
by NNMi or an external application. For example, NNMi uses the capability feature to identify interfaces
for which NNMi can obtain only limited information. Examples of these interfaces include Nortel inter-
faces as well as any interface on a non-SNMP node. To help identify these interfaces, NNMi assigns the
interface the capability of com.hp.nnm.capability.iface.private.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified.

For information about each tab:

Attribute Description

Capability The name of the capability added to an interface object by either NNMi or an external appli-
cation. For more information, see: 

● "Interface Capability Form" (on page 67)

● "Interface Capabilities Provided by NNMi" (on page 65)

Unique
Key

The database identifier for the capability that either NNMi or an external application added
to this interface. 

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "Interface Capabilities Provided by NNMi" (on page
65) for a description of the capabilities provided by NNMi that might appear under the
Interface Form: Capabilities Tab.

Capabilities Table

Interface Capabilities Provided by NNMi

The Interface Form: Capabilities Tab displays a table view of any capabilities that have been added to the
interface object. Capabilities that begin with com.hp.nnm.capability represent capabilities that NNMi
provides. External applications can also add interface capabilities.
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Capability Unique Key Description

Private com.hp.nnm.capability.iface.private Indicates the interface was discovered in
either a non-SNMP node or a Nortel node. Pri-
vate interfaces are not monitored for Status.

For interfaces on non-SNMP nodes, note the
following: 

● The interface index (ifIndex) value is
always set to 0 (zero).

● The interface type (ifType) is set to Other.

● The interface Name (ifName), if none is
available, is set to Pseudo Interface.

● If the interface hosts an IP address, the
interface Alias (ifAlias) is set to the IP
address. Otherwise, the interface Alias
(ifAlias) is set with information from
neighboring SNMP devices.

● NNMi obtains the MAC address if the IP
address can be resolved using
ARP cache.

Note the following about Pseudo interfaces:
NNMi attempts to obtain additional infor-
mation using a variety of discovery protocols.

For Nortel SNMP interfaces, note the
following: 

● The ifIndex value is set according the Nor-
tel private MIB.

● NNMi tries to collect the MAC address
and interface name using Nortel's private
MIBs.

NNMi Interface Capabilities

Capability Unique Key Description

Aggregate
Interface

com.hp.nnm.capability.lag.aggregator Indicates the interface represents the col-
lection of physical interfaces for one end of
an Aggregator Link.

See Layer 2 Neighbor View Map Objects for
more information.

Aggregate
Member

com.hp.nnm.capability.lag.member Indicates the interface is a physical interface
that is a member of an Aggregator Interface.

See Layer 2 Neighbor View Map Objects for
more information.

NNMi Advanced. The capabilities in the following table identify whether the interface par-

ticipating in a Link Aggregation is an aggregator or member.

NNMi Advanced. Link Aggregation Interface Capabilities: Roles
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NNMi Advanced. The capabilities in the following table are used to identify the Link Aggregation protocol
used.

Capability Unique Key Description

Cisco Port Aggre-
gation Protocol

com.hp.nnm.capability.lag.protocol.pagp Indicates an interface using
Cisco Systems Port Aggre-
gation Protocol.

Inter-Switch Trunk
MLT

com.hp.nnm.capability.lag.protocol.istmlt Indicates an inter-switch trunk
that is part of a Split Multi-
Link Trunk configuration.

Nortel Multi-Link
Trunking

com.hp.nnm.capability.lag.protocol.mlt Indicates an interface using
the Multi-Link Trunk tech-
nology.

Split MLT com.hp.nnm.capability.lag.protocol.smlt Indicates an interface using
Split Multi-Link Trunk tech-
nology.

Static/Manual Con-
figured Link Aggre-
gation

com.hp.nnm.capability.lag.protocol.static Indicates the Cisco device
has been manually con-
figured for aggregation.

NNMi Advanced. Link Aggregation Interface Capabilities: Protocols 

Interface Capability Form

This form describes a capability added to the interface object by NNMi or an external application. For
example, NNMi uses the capability feature to identify interfaces for which NNMi can obtain only limited
information. Examples of these interfaces include Nortel interfaces as well as any interface on a non-
SNMP node. To help identify these interfaces, NNMi assigns the interface the capability of com.hp.nnm-
.capability.iface.private.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified. 

Each Capability attribute is described in the table below.

Attribute Description

Capability Label used to identify the Capability that was added to the interface object. The Capability
value is listed in the table on the Capabilities tab in an Interface form. See "Interface Form:
Capabilities Tab" (on page 65).

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi begins with
the prefix com.hp.nnm.capability.

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "Interface Capabilities Provided by NNMi" (on page
65) for a description of the capabilities provided by NNMi that might appear under the
Interface Form: Capabilities Tab.

Basics Attributes
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Interface Form: Custom Attributes Tab

Custom Attributes enable an NNMi administrator to add information to the Interface object.  Custom Attrib-
utes can also be set by external applications that have been integrated with NNMi.

The Interface Form: Custom Attributes Tab displays a table view of any Custom Attributes that have been
added to the interface object. For example, your NNMi administrator might have added Role as another
attribute for the interfaces in your network.

Note: If your role allows, you can edit a Custom Attribute. Only user accounts with NNMi Administrator role
can add a Custom Attribute.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on the Cus-
tom Attributes tab in Interface forms.

Value The actual value for the Custom Attribute for the selected interface. For example, the value
for Role might be WAN interface to the London office. For more information, see "Interface
Capabilities Provided by NNMi" (on page 65).

Custom Attributes Table

Interface Custom Attributes Form

Custom Attributes enable an NNMi administrator to add information to the interface object . For example,
your NNMi administrator might have added Role as another attribute for the interfaces in your network.
Custom Attributes can also be set by external applications that have been integrated with NNMi.

The Custom Attributes form displays the Name and Value for each of the Custom Attributes that were
added to the interface object. Each of these attributes is described in the table below.

Attribute Description

Name Name used to identify the Custom Attribute. This name appears in the table view on the Cus-
tom Attributes tab in the Interface forms.

Value Value assigned to the Custom Attribute for the selected interface object. For example, the
value for Role might be WAN interface to the London office.

Basics Attributes

Interface Form: Interface Groups Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:

Attribute Description

Interface
Groups

Table view of Interface Groups to which the selected interface belongs. Interface groups
are based on specific characteristics of interfaces.

Click the Open icon to view more information about a specific Interface Group.

Interface Groups Membership Table
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Interface Form: Performance Tab (NNM iSPI for Performance)

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:

The Performance tab displays data if the NNM  iSPI for Performance is installed and configured within
your environment. The NNMi administrator can configure an optional high/low threshold.

The icons on the Performance tab indicate the value of the most recent interface performance states: 

High - The High
threshold was crossed.

Nominal - Meas-
ured within healthy
range. (Or no thresh-
olds are being mon-
itored.)

Low - The Low
threshold was crossed.

None - The value
returned was zero.

Not Polled - Indicates that this interface is intentionally not polled. Possible
reasons are: Performance Monitoring is not enabled, because of current Com-
munication Configuration settings in NNMi, or because the parent Node or
Interface is set to Not Managed or Out of Service.

Unavailable - Unable to compute the performance state or the computed
value is outside of the valid range (0.00 - 100.00).

Agent Error - The SNMP agent responded with an error, rather than a
value.

Attribute Description

Input Util-
ization

The total number of incoming octets traversing the interface as a percentage of the total pos-
sible number of octets (based on the ifSpeed value). From Interface to Interface, the exact

MIB variables queried vary based on interface speed and whether the system supports the
high speed counters for interfaces.

Tip: Sometimes the value returned by the device's SNMP agent is not accurate and causes
problems when NNMi calculates input utilization. NNMi lets you manually override the
ifSpeed provided by the SNMP agent for this interface. See Input Speed.

Output
Utilization

For full-duplex interfaces, the total number of outbound octets traversing the interface as a
percentage of the total possible number of octets (based on the ifSpeed value). From Inter-
face to Interface, the exact MIB variables queried vary based on interface speed and
whether the system supports the high speed counters for interfaces.

Tip: Sometimes the value returned by the device's SNMP agent is not accurate and causes
problems when NNMi calculates output utilization. NNMi lets you manually override the
output speed provided by the SNMP agent for this interface. See Output Speed.

Input
Error
Rate

Percentage based on the reported change in the number of input packets on the interface
and the packet error count. What constitutes an error is system specific, but likely includes
such issues as bad packet checksums, incorrect header information, and runt packets.

Performance Results Table
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Attribute Description

Output
Error
Rate

Percentage based on the reported change in the number of output packets on the interface
and the packet error count. What constitutes an error is system specific, but likely includes
such issues as collisions and buffer errors.

Input Dis-
card Rate

Percentage based on the reported change in the number of input packets on the interface
and the discarded packet count. Packets may be discarded because of a variety of issues,
including receive buffer overflows, congestion, or system specific issues.

Output
Discard
Rate

Percentage based on the reported change in the number of output packets on the interface
and the discarded packet count. Packets may be discarded because of a variety of issues,
including transmission buffer overflows, congestion, or system specific issues.

Interface Form: Incidents Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:

Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected interface. These incidents are
sorted by creation time so that you can view the incidents in chronological order. Use this
view to determine which incidents are still open for the selected interface.

Click the Open icon to open the "Incident Form" (on page 132) and view more infor-
mation about a specific incident.

Incidents Table

Interface Form: Status Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:
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Attribute Description

Status Overall status for the current interface. NNMi follows the ISO standard for status clas-
sification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

Interface status is derived from SNMP polling results for ifAdminStatus and IfOperStatus, as
well as any conclusions. For information about how the current status was determined, see
the "Interface Form: Conclusions Tab" (on page 71). Status reflects the most serious out-
standing conclusion. See "Watch Status Colors" (on page 126) for more information about
possible status values.

NNMi Advanced. If the interface is an Aggregator Interface, the Status is calculated using the
Status of the Aggregator Interface members. Click here for more information.

A Status of Minor indicates the Status of at least one of the Aggregator Interface members is
Critical. A Status of Critical indicates the Status of all the Aggregator Interface members is
Critical.

Also see Layer 2 Neighbor View Map Objects.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Status
History

List of up to the last five changes in the status for the interface.

Click the Open icon to view more information about a specific status.

Status Tab

Interface Form: Conclusions Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:
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Attribute Description

Outstanding
Status Con-
clusions

The dynamically generated list of summary statuses of the interface at points in time
that contributed to the current overall status of the selected interface. Status is set by the
Causal Engine.

Each conclusion listed is still outstanding and applies to the current overall status.

This view is useful for obtaining a quick summary of the status and problem description
for the current node’s interfaces that led up to the node’s most current status.

Examples of conclusions that might appear together are listed below:

● SNMP Agent Not Responding

● Interface Down

● Address Down

The status value is correlated based on the most critical conclusions.

Click the Open icon to view more information about a specific conclusion.

Conclusions Table for Status Calculations

Interface Form: Registration Tab

The "Interface Form" (on page 58) provides details about the selected network interface.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration

IP Address Form

The IP Address form provides information for the IP address selected. This form is useful for trou-
bleshooting purposes because you can access additional information about the node, interface, subnet,
and incidents associated with this address.

If your role allows, you can use this form to modify the Management Mode for an address (for example, to
indicate it will be temporarily out of service) or add notes to communicate information about this address
to your team.

For information about each tab:

Attribute Description

Address An IP address provided by your NNMi administrator as a discovery seed or an IP
address gathered by Spiral Discovery.

Basic Attributes
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Attribute Description

Prefix Length The number of significant bits in the subnet prefix associated with this IP address.

For IPv4 addresses, this value is derived from the subnet mask.

Status Overall status for the current IP address. NNMi follows the ISO standard for status clas-
sification. See "IP Address Form: Status Tab" (on page 74).

Management
Mode

The calculated Management Mode for the address used to indicate whether the current
IP address is being managed.

This value should reflect the management mode assigned to the node on which the
selected address resides as well as on any associated interfaces. For example, if the
node's management mode is Managed, and the Management Mode of the interface is
Inherited, the Management Mode value for the address is Managed.

Direct Man-
agement

Mode

This attribute is set by the administrator and specifies whether an address should be
managed or is temporarily out of service. Possible values are:

Inherited – Used to indicate that the address should inherit the Management Mode
from the associated interface, if any. Otherwise the address inherits the Management
Mode of the node on which it resides.

Not Managed – Used to indicate that you do not plan to manage the address. For
example, the address might not be accessible because it is in a private network.
NNMi does not discover or monitor these addresses.

Out of Service – Used to indicate the address is unavailable because it is out of serv-
ice. NNMi does not discover or monitor these addresses.

This attribute is useful for notifying NNMi when an address is been temporarily out of
service, or should never be managed.

Note: If you change the Direct Management Mode, NNMi updates the calculated Man-
agement Mode on the form. If you manually set the Direct Management Mode
and then Save your changes, the Management Mode value is not updated until
you refresh the form.

State Indicates whether the IP address is available and how NNMi is using SNMP to interact
with this IP address. Possible values are:

Responding – Indicates that the IP address is being polled and is responding to an
ICMP ping.

Not Responding – Indicates that the IP address is being polled, but is not respond-
ing to an ICMP ping.

Note: NNMi's State Poller determines the State. The current state contributes towards the
status calculation for the address. See the Status tab for more information.

State Last
Modified

Indicates the date and time when the State value was last modified.

In Interface MIB II ipAddrTable value indicating the interface that owns this IP address. Click the

 Lookup icon and select  Open to display more information about the interface.

Page 73 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Accessing Device Details

Attribute Description

Hosted On
Node

Node on which the address resides. This is the current value in NNMi’s database for the
Name attribute of the host device. The value could be a DNS name, a MIB II sysName,
or an address (depending on how your NNMi administrator configured the discovery
process).

Click the  Lookup icon and select  Quick View or  Open to display more infor-
mation about the node.

In Subnet Subnet on which the IP address resides. NNMi derives this subnet based on the IP

address and the subnet prefix information. Click the  Lookup icon and select
 Open to display more information about the IP subnet.

Notes Provided for network operators to use for any additional notes required to further explain
the IP address. Information might include whether the address is a backup address. You
might also use this attribute to track which geographical group might use the address.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and under-
line characters are allowed.

Note: You can sort your IP address table views based on this value. Therefore, you might
want to include keywords for this attribute value.

IP Address Form: Incidents Tab

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in the inci-
dent view's column headings.

The "IP Address Form" (on page 72) provides details about the selected IP address.

For information about each tab:

Description

Table view of the incidents associated with the selected address. These incidents are sorted by creation
time so that you can view the incidents in chronological order. Use this view to determine which inci-
dents are still open for the selected address.

Click the  Open icon to open the "Incident Form" (on page 132) and view more information about a
specific incident.

Incidents Table

IP Address Form: Status Tab

The "IP Address Form" (on page 72) provides details about the selected IP address .

For information about each tab:

Page 74 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Accessing Device Details

Attribute Description

Status Overall status for the current IP address. NNMi follows the ISO standard for status clas-
sification. Possible values are:

 No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

  Critical

IP address status is derived from ICMP ping results, as well as any conclusions. For infor-
mation about how the current status was determined, see the "IP Address Form: Conclusions
Tab" (on page 75). Status reflects the most serious outstanding conclusion. See "Watch
Status Colors" (on page 126) for more information about possible status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Indicates the date and time when the Status value was last modified.

Status
History

List of up to the last five changes in status for the selected IP Address. This view is useful for
obtaining a quick summary of the IP address status so that you can better determine any pat-
terns in node behavior and activity.

Click the  Open icon to view more information about a specific status.

Status of thiis IP Address

IP Address Form: Conclusions Tab

The "IP Address Form" (on page 72) provides details about the selected IP address .

For information about each tab:
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Attribute Description

Outstanding
Status Con-
clusions

The dynamically generated list of summary statuses of the IP address at points in time
that contributed to the current overall status of the selected IP address. Status is set by
the Causal Engine.

Each conclusion listed is still outstanding and applies to the current overall status.

This view is useful for obtaining a quick summary of the status and problem description
for the current node's interfaces that led up to the node's most current status.

Examples of conclusions that might appear together are listed below:

● SNMP Agent Not Responding

● Interface Down

● Address Down

The status value is correlated based on the most critical conclusions. Click the Open
icon to view more information about a specific conclusion.

Conclusions Table

IP Address Form: Capabilities Tab

The "IP Address Form" (on page 72) provides details about the selected IP address .

For information about each tab:

The IP Address Form: Capabilities tab displays a table view of any capabilities added to the IP Address
object by NNMi or an external application. For example, NNMi uses the capability feature to identify an
Anycast Rendezvous Point IP Address1 so it is not polled. NNMi assigns the Anycast Rendezvous Point
IP address the following capability: com.hp.nnm.capability.address.anycast.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified.

Attribute Description

Capability The name of the capability added to an IP address object by either NNMi or an external

application. For more information, see: 

● "IP Address Capability Form" (on page 77)

● "IP Address Capabilities Provided by NNMi" (on page 77)

Unique
Key

The database identifier for the capability that either NNMi or an external application added
to this interface. 

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "IP Address Capabilities Provided by NNMi" (on
page 77) for a description of the capabilities provided by NNMi that might appear
under the IP Address Form: Capabilities Tab.

Capabilities Table

1Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
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IP Address Capabilities Provided by NNMi

The IP Address Form: Capabilities Tab displays a table view of any capabilities that have been added to
the IP Address object. Capabilities that begin with com.hp.nnm.capability represent capabilities that
NNMi provides. External applications can also add IP address capabilities.

Capability Unique Key Description

loopback com.hp.nnm.capability.address.loopback Used to identify a loopback address1.

anycast com.hp.nnm.capability.address.anycast Used to identify a loopback address that is
an Anycast Rendezvous Point
IP Address2.

Anycast Rendezvous Point IP Addresses
are loopback addresses used for routers
in multi-cast network configurations.
These duplicate IP addresses are
excluded from monitoring.

NNMi IP Address Capabilities

IP Address Capability Form

This form describes a capability added to the IP address object by NNMi or an external application. For
example, NNMi uses the capability feature to identify an Anycast Rendezvous Point IP Address3. To
help identify the Anycast Rendezvous Point IP addresses so they are not polled, NNMi assigns the
IP address the following capability:com.hp.nnm.capability.address.anycast.

Note: Because the values are generated by NNMi or an external application, Capability values cannot be
modified. 

Each Capability attribute is described in the table below.

Attribute Description

Capability Label used to identify the Capability that was added to the IP address object. The Capability
value is listed in the table on the Capabilities tab in an IP Address form. See "IP Address
Capability Form" (on page 77).

Basics Attributes

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured
loopback for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNM identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
3Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
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Attribute Description

Unique
Key

Used as a unique identifier for the Capability. Any capability provided by NNMi begins with
the prefix com.hp.nnm.capability.

Note: Capabilities added by NNMi use a Unique Key value that begins with the prefix:

com.hp.nnm.capability. See "IP Address Capabilities Provided by NNMi" (on
page 77) for a description of the capabilities provided by NNMi that might appear
under the IP Address Form: Capabilities Tab.

IP Address Form: Registration Tab

The "IP Address Form" (on page 72) provides details about the selected IP address .

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration

Router Redundancy Group Form (NNMi Advanced)

The Router Redundancy Group Form provides details about the Router Redundancy Group selected. This
form is useful for troubleshooting purposes. You can access information about the name, status, and
Router Redundancy Members (routers) associated with this Router Redundancy Group.

For information about each tab:

Attribute Description

Name The name assigned to this Router Redundancy Group. This name is the virtual IP address
protected by this group and used by the router that is actively routing information packets (for
example, HSRP Active or VRRP Master).

Basics Attributes
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Attribute Description

Status Router Redundancy Group Status reflects the most serious Severity value of the incidents
associated with the Router Redundancy Group. Possible values are:

  Normal

 Warning

  Minor

  Major

  Critical

See "Watch Status Colors" (on page 126) for more information about Severity values.

Note: The icons are displayed only in table views.

Group
Number

The group number that was configured for the current Router Redundancy Group.

Number
of
Members

Specifies the number of members that belong to the current Router Redundancy Group.

Related Topics

"Router Redundancy Group View (NNMi Advanced)" (on page 22)

"Non-Normal Router Redundancy Group View (NNMi Advanced)" (on page 121)

"Router Redundancy Member Form (NNMi Advanced)" (on page 80)

Router Redundancy Group Form: Router Redundancy Members Tab (NNMi
Advanced)

The table on this tab lists all routers and the associated interface that currently belong to the Redundancy
Router Group. The "Router Redundancy Group Form (NNMi Advanced)" (on page 78) provides details
about the selected Router Redundancy Group.

For information about each tab:

Attribute Description

Current
State

The current HSRP or VRRP state for the selected Router Redundancy Group Member.

See "Router Redundancy Member Form (NNMi Advanced)" (on page 80) for more infor-
mation about the possible state values.

Previous
State

The previous HSRP or VRRP state for the selected Router Redundancy Group Member.

See "Router Redundancy Member Form (NNMi Advanced)" (on page 80) for more infor-
mation about the possible state values.

Priority Number used to rank the Router Redundancy Members. The member with the numer-
ically higher priority becomes the Active (HSRP) or Master (VRRP).

Router Redundancy Members Table
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Attribute Description

Hosted On
Node

Name of the selected router that is a member of the current Router Redundancy Group.
The name is the hostname assigned to the router.

See "Node Form" (on page 27) for more information about node names.

Redundancy
Interface

The interface that is being used by the router to participate in the Router Redundancy
Group.

To see more details about a particular Router RedundancyMember:

Click the  Open icon that precedes the Router Redundancy Member of interest to open the "Router
Redundancy Group Form (NNMi Advanced)" (on page 78) .

Router Redundancy Member Form (NNMi Advanced)

The Router Redundancy Member form provides details about a router in the Router Redundancy Group.

This form is useful for troubleshooting purposes. You can access information about the router name and
status, as well as conclusions information to assist you in understanding the router's HSRP or VRRP state.
You can also see the name of each tracked object associated with the router. A tracked object represents
the interface responsible for delivering the outbound information packet that was originally sent to the cur-
rent Router Redundancy Member.

For information about each tab:

Attribute Description

Name Name of the selected router and its associated interface that is a member of the current
Router Redundancy Group.

Note: NNMi determines this Name value.

The name includes the fully qualified DNS name assigned to the router and the Name
assigned to the interface.

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name:group_number]

For example:  HSRPRouter1.xyz.ab.com[Se1/1:1]

See "Node Form" (on page 27) for more information about node names.

Redundancy
Interface

The interface that is being used by the router to participate in the Router Redundancy
Group.

To find out more information about this interface:

Click the Lookup icon and choose one of the following options:

● Quick View to view a summary of the interface details.

● Open to open the interface form.

Basics Attributes
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Attribute Description

Current
State

HSRP or VRRP State of the Router Redundancy Member. Possible states for routers
using the HSRP or VRRP protocol are listed below.

HSRP States

Active - Indicates the router is forwarding packets that are sent to the router redun-
dancy group.

Initial - Indicates HSRP is not running. This state occurs when an interface first comes
up.

Learn - Indicates the router has not yet determined the virtual IP address. This state
occurs when the router is waiting to hear from the active router.

Listen - Indicates the router knows the virtual IP address, but it is neither the active or
standby router. In this state, the router is waiting for a message from the active and
standby routers.

Speak - Indicates the router knows the virtual IP address. In this state, the router sends
periodic messages and is ready to become an active or standby router.

Standby - Indicates the router is a candidate to become the next active router.

VRRP States

Initialize - Indicates the router is not running VRRP. This state occurs when an inter-
face first comes up.

Master - Indicates the router is forwarding packets that are sent to the router redun-
dancy group.

Backup - Indicates the router is a candidate to become the next master router.

If NNMi is unable to poll the interface used to identify the selected router in the Router
Redundancy Group, one of the following states is set for the selected router's interface:

Agent Error – Indicates an SNMP error was returned in response to an SNMP query
to the interface's SNMP agent.

Other – The SNMP agent on the interface responded with a value for the MIB var-
iable used to determine the Router Redundancy Member State that is not recognized. 

Unavailable – The SNMP agent on the interface responded, but returned a null value
for the request to the MIB variable used to determine the Router Redundancy Member
State. 

Previous
State

The previous HSRP or VRRP State of the Router Redundancy Member. Possible values
are described under Current State.

Priority Number used to rank the Router Redundancy Members. The member with the numer-
ically higher priority becomes the Active (HSRP) or Master (VRRP).
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Router Redundancy Member Form: Tracked Objects Tab (NNMi Advanced)

A tracked object is the outbound interface responsible for delivering the outbound information packet that
was originally sent to a selected inbound interface on a router that is part of the Router Redundancy
Group. A Router Redundancy Member can have one or more associated tracked objects

The "Router Redundancy Member Form (NNMi Advanced)" (on page 80) provides details about the
selected Router Redundancy Member. Each Router Redundancy Member is a router in the Router Redun-
dancy Group.

For information about each tab:

Attribute Description

Track
Priority

Number used to rank the tracked object. This number is used indirectly in the calculation that
determines the next Active or Master member of the Router Redundancy Group whenever a
State change occurs.

When a tracked object goes down, the priority of the tracked object (Track Priority) is sub-
tracted from its Router Redundancy Member Priority value to produce a smaller member
Priority number. If this new Priority number is smaller than one of the other member Priority
numbers, the member with the highest Priority value becomes the new Master or Active
router in the current Router Redundancy Group.

For example, if an interface whose Track Priority is 20 goes down on a Router Redundancy
Member whose member Priority is 250:

● The Track Priority (20) is subtracted from its member Priority (250-20=230).

● The new member Priority (230) is then compared to the Priority value of the other
members in the Router Redundancy Group.

● If one of the members in the Router Redundancy Group has a higher member Priority,
for example, 240, that member becomes the Active or Master router in the group.

Name Name of the selected router and its associated interface that is a member of the current
Router Redundancy Group.

Note: NNMi determines this Name value.

The name includes the fully qualified DNS name assigned to the router and the name
assigned to the interface.

See "Tracked Objects Form (NNMi Advanced)" (on page 82) for more information about
tracked objects.

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name]

For example:  HSRPRouter1.xyz.ab.com[Se1/1]

See "Node Form" (on page 27) for more information about node names.

Tracked Objects Table

Tracked Objects Form (NNMi Advanced)

Your network administrator might have set up groups of redundant routers to help ensure that information
packets reach their intended destination. A tracked object is the outbound interface responsible for deliv-
ering the outbound information packet that was originally sent to a selected inbound interface on a router
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that is part of the Router Redundancy Group. A Router Redundancy Member can have one or more asso-
ciated tracked objects.

Attribute Description

Tracked
Object

Name used to identify the selected tracked object. The name includes the fully-qualified
DNS name assigned to the router and the name assigned to its associated tracked object .

This name appears in the following format:

<fully qualified hostname assigned to the router>[Interface Name]

For example:  HSRPRouter1.xyz.ab.com[Se1/1]

To find out more information about this interface: 

Click the Lookup icon and choose one of the following options:

● Quick View to view a summary of the interface details.

● Open to open the Interface form.

Track
Priority

Number used to rank the tracked object. This number is used indirectly in the calculation that
determines the next Active or Master member of the Router Redundancy Group whenever a
State change occurs.

When a tracked object goes down, the priority of the tracked object (Track Priority) is sub-
tracted from its Router Redundancy Member Priority value to produce a smaller member
Priority number. If this new Priority number is smaller than one of the other member Priority
numbers, the member with the highest Priority value becomes the new Master or Active
router in the current Router Redundancy Group.

For example, if an interface whose Track Priority is 20 goes down on a Router Redundancy
Member whose member Priority is 250:

● The Track Priority (20) is subtracted from its member Priority (250-20=230).

● The new member Priority (230) is then compared to the Priority value of the other

members in the Router Redundancy Group.

● If one of the members in the Router Redundancy Group has a higher member Priority,
for example, 240, that member becomes the Active or Master router in the group.

Basics Attributes

Router Redundancy Group Form: Virtual IP Addresses Tab (NNMi
Advanced)

Tip: See "IP Address Form" (on page 72) for an explanation of the columns in the Virtual IP Addresses
table view.

The "Router Redundancy Group Form (NNMi Advanced)" (on page 78) provides details about the selected
Router Redundancy Group.

For information about each tab:
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Description

The Virtual IP addresses Tab displays a table view of the virtual IP addresses associated with the
selected Router Redundancy Group. The virtual IP address is the IP address protected by this group and
used by any router that is actively routing information packets (for example, HSRP Active or VRRP
Master). For each virtual IP address displayed, you can see the IP address value.

To see more information about a specific IP address:

1. Select the IP address of interest by checking the selection box that precedes the object infor-
mation.

2. Click the  Open icon to open the "IP Address Form" (on page 72) and view more information
about the specific IP address.

Virtual IP Addresses Table View

Virtual IP addresses Form (NNMi Advanced)

A virtual IP address is an address protected by the Router Redundancy Group and used by the router that
is actively routing information packed (for example, HSRP Active or VRRP Master).

Basic Attributes

Attribute Description

Value IP address value for the virtual IP address.

Virtual IP Addresses

Router Redundancy Group Form: Incidents Tab (NNMi Advanced)

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in the inci-
dent view's column headings.

The "Router Redundancy Group Form (NNMi Advanced)" (on page 78) provides details about the selected
Router Redundancy Group.

For information about each tab:

Description

Table view of the incidents associated with the selected Router Redundancy Group. These incidents are
sorted by creation time so that you can view the incidents in chronological order. Use this view to deter-
mine which incidents are still open for the selected Router Redundancy Group.

To see more information about an incident:

1. Select the incident of interest by checking the selection box that precedes the object information.

2. Click the  Open icon to open the "Incident Form" (on page 132) and view more information about
a specific incident.

Incidents Table
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VLAN Form

The VLAN form provides details about the selected virtual local area network, and lists all ports known to
participate in this VLAN.

Note: A trunk port can participate in multiple VLANs.

For information about each tab:

Attribute Description

VLAN Id The identification value for the current VLAN. This value is taken directly from the MIB file
provided by the Vendor.

Name The name value from the MIB provided by the Vendor. If no name is provided in the MIB
file, the same string as the VLAN Id is used.

Member
Node [Inter-
face]

NNMi selects a representative Member Node and Member Interface for the current VLAN.
These members help to distinguish VLANs that use the same identification number.

NNMi selects the Member Node using the following criteria:

● The node is a member of the VLAN.

● The node has the lexicographically ordered first node hostname.

NNMi selects the Member Interface using the following criteria:

● The interface must be on the Member Node.

● The interface is a member of the VLAN.

● The interface has the lexicographically ordered first interface name.

Member
Node Count

Specifies the number of nodes that belong to the current VLAN.

Basic Attributes

Related Topics:

"VLANs View (Inventory)" (on page 19)

VLAN Form: Ports Tab

Note: A trunk port can participate in multiple VLANs.

The "VLAN Form" (on page 85) provides details about the selected VLAN.

Attribute Description

Ports Table view of the ports associated with the selected VLAN. Use this table to access infor-
mation about each port associated with the selected VLAN across all member devices.

Click the  Open icon to open the "Port Form" (on page 86) and view more information
about a port.

Ports Associated with this VLAN

Related Topics:
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"VLANs View (Inventory)" (on page 19)

Port Form

The Port form provides details about the port you selected on the Node form or VLAN form. The following
table describes the fields included on the Port form.

For information about each tab:

Attribute Description

Name The port name consists of <Card-number / Port-number>.

Hosted on
Node

Node on which the port resides. This is the current value in NNMi’s database for the Name
attribute of the host device. The value could be a DNS name, a MIB II sysName, or an
address (depending on how your NNMi administrator configured the discovery process).

Click the  Lookup icon and select  Quick View or  Open to display more infor-
mation about the node.

Associated
Interface

The current value from the Name attribute on the Interface form. The most accurate inter-
face name available to the initial discovery process: IF MIB ifName, ifAlias, or ifType+ifI-
ndex values.

Click the  Lookup icon and select  Quick View or  Open to display more infor-
mation about the interface.

Basic Attributes

Related Topics:

"Node Form" (on page 27)

"VLAN Form" (on page 85)

Port Form: VLANs Tab

The Port form provides details about the port you selected on the Node form or VLAN form. The following
table describes the fields included on the Port form.

The "Port Form" (on page 86) provides details about the selected VLAN.

Attribute Description

VLANs Table view of the VLANs to which the selected port belongs. You can use this table to deter-
mine the VLAN ID number and name for each VLAN associated with the selected port.

Click the  Open icon to open the "VLAN Form" (on page 85) and view more information
about a specific VLAN.

VLANs Attributes

Related Topics:

"Node Form" (on page 27)

"VLAN Form" (on page 85)
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Node Group Form

Note: Island Node Groups are a special kind of Node Group that NNMi manages internally. Therefore,
NNMi administrators should not modify Island Node Group configurations. NNMi overrides any
user changes the next time NNMi updates the Island Node Group discovery information. See
"Help for Administrators" for more information about Island Node Groups.

Membership in each node group is determined by a number of factors specified on the Node Group form.
The NNMi administrator can create and modify Node Group definitions. The NNMi administrator can also
configure Node Groups as filters in table views. NNMi monitors the status of each Node Group over time.
NNMi also provides a map of each Node Group.

Each node group includes one or more of the following:

● Device Filters (by any combination of category, vendor, family, profile)

● Additional Filters

● Additional Nodes (specific nodes identified by Hostname)

If Device Filters and Additional Filters are in use, nodes must match both the Device Filters and the Addi-
tional Filters specifications to belong to this Node Group. Nodes that are specified as Additional Nodes are
always included in the Node Group.

For information about each tab:

Tip: Special Actions are available within the Node Group view and Interface Group view.

Depending on your role, Node Groups can be used in several ways:

Attribute Description

Name The name of this group (text string specified by the NNMi administrator).

Status Overall status for the specified node group. NNMi follows the ISO standard for status clas-
sification. See the "Node Group Form: Status Tab" (on page 92) for more information.

Add to
View Filter
List

If disabled  , this node group does not appear in any node group filter lists for node, inter-
face, IP address, and incident views.

If enabled  , this node group is available as a filter for all node, interface, IP address, and
incident views.

Notes Optional. If your role allows, enter any information that might be useful to you and your
team.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Node Group Basic Settings
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Attribute Description

Add to
Filter List

NNM iSPI for Performance. Using this feature is entirely optional. The NNM iSPI for Per-
formance can monitor your network without any exported filter.

Enable only for groups that are needed as filters in performance reports. It may take up to an
hour before the results are visible in NNM iSPI for Performance reports. Choose wisely
because establishing a filter requires significant NNM iSPI for Performance processing time.

If disabled  , this group is not available as a filter in NNM iSPI for Performance reports.

If enabled  , this group appears in the Optional Filters selection panel of NNM iSPI for Per-
formance reports.

NNM iSPI for Performance. Node Group Settings

Node Group Form: Device Filters Tab

Optional: Determine Node Group members by vendor, family, model, or other device characteristics such
as SNMP object identifiers.

If any hostname wildcards or device filters are in use:

● By default, when the hostname wildcard or device filter list is empty, no nodes match the criteria. To
match all nodes, use the * (asterisk) wildcard.

● When either or both hostname wildcard and device filters are enabled, nodes must match ALL spec-
ifications to belong to this node group.

 The "Node Group Form" (on page 87) provides details about the selected node group. 

For information about each tab:

Attribute Description

Device
Filter

Table view of the device category, vendor, product family, or product model filters associated
with the selected node group.

Click the  Open icon to open the"Node Device Filter Form" (on page 88) and view more
information about a filter specification.

Device-Characteristic Filters Table

Node Device Filter Form

Optional: Node Group definitions can specify membership by device vendor, family, model, or
SNMP object identifiers.

When using node Device Filters, note the following:

● If Device Filters and Additional Filters are in use, nodes must match both the Device Filters and the
Additional Filters specifications to belong to this Node Group.

● Nodes that are specified as Additional Nodes always pass any filters.

Page 88 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Accessing Device Details

Attribute Description

Device
Category

Optional: A particular category of devices. The drop-down list displays all available choices.

Device
Vendor

Optional: A particular vendor. The drop-down list displays all available choices.

Device
Family

Optional: A particular family of devices. To see all available choices, click the  Open icon

and use the  Quick Find icon.

Device
Profile

Optional: A particular device model or SNMP object ID. To see all available choices, click

the  Open icon and use the  Quick Find icon.

Device Attribute Filters Table

Node Group Form: Additional Filters Tab

Tip: If you are an NNMi Administrator, see the "Help for Administrators" for more information about how to
use the Additional Filters Editor.

The Additional Filters tab enables the NNMi administrator to use expressions to further define which
nodes to include in a Node Group.

If any Additional Filters are created:

● NNMi first evaluates any hostname filters and device filters. Nodes must match at least one spec-
ification to belong to this Node Group.

● NNMi then evaluates any Additional Filter expression. Nodes must also match all Additional Filters
expression specifications to belong to this Node Group.

 The "Node Group Form" (on page 87) provides details about the selected Node Group. 

For information about each tab:

If an NNMi administrator created any Additional Filters for the selected Node Group, NNMi displays the
Additional Filters expression.

Node Group Form: Additional Nodes Tab

Optional: Determine Node Group members by specifying each device hostname (or address when host-
name is not available).

Nodes that are specifically listed are always included in this node group.

The "Node Group Form" (on page 87) provides details about the selected node group. 

For information about each tab:

Attribute Description

Node Host-
name

Table view of the hostnames for the additional nodes added to the selected Node Group.

Note: NNMi always converts hostnames to all lowercase.

Click the  Open icon to open the"Additional Node Form" (on page 90) and view more
information about a filter specification.

Specific-Device Filters Table
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Additional Node Form

Optional: Node Group definitions can identify specific devices by hostname (or address when hostname
is not available).

Nodes that are specified as Additional Nodes are always included in the Node Group.

The "Node Group Form" (on page 87) provides details about the selected Node Group. 

Attribute Description

Node
Hostname

The Hostname attribute value on the Node form of the discovered node must match what is
entered here (see the Hostname attribute the "Node Form" (on page 27) for more infor-
mation).

Note: NNMi always converts hostnames to all lowercase.

If a device has multiple hostnames or no hostname, NNMi follows a set of rules to deter-
mine the hostname. Click here for details.

1. If a hostname is available, it must resolve to a valid IP address. NNMi stores the fully-
qualifiedhostname in the database as all lowercase characters.

2. If more than one address is associated with a node, the loopback address1 is used
with the following exceptions:

■ NNMi prefers loopback interfaces for management communication, where pos-
sible. However, NNMi automatically filters out addresses in the reserved loopback
network range 127/24 (127.*.*.*).

■ NNMi ignores any address that is virtual (HSRP/VRRP) or an Anycast Ren-
dezvous Point IP Address2.

3. If a node has multiple loopback addresses, NNMi uses the loopback address with the
lowest number that resolves to a hostname (for example, 10.16.42.197 is a lower
number than 10.16.197.42).

4. If no loopback address resolves to a hostname and the device supports SNMP,
NNMi uses the current value from the Management Address attribute on the Node
form.

5. If the device does not support SNMP, the IP address or DNS name found during the
current rediscovery cycle is used as the hostname.

This sequence is repeated during each rediscovery cycle. The hostname could change
from cycle to cycle (for example, if an address did not respond to SNMP queries due to net-
work problems or node reconfiguration).

Specific Device Filter

1The address associated with the loopback interface. The loopback interface is a virtual interface on a
device that provides a route for internal communication. Many vendors provide a specially configured
loopback for management purposes. Exact details of how loopbacks are configured varies by vendor and
model. See each device's documentation for details. NNM identifies these loopback addresses by using
IfType 24, softwareloopback from the IANA ifType-MIB.
2Rendezvous Point addresses are loopback addresses used for routers in multi-cast network con-
figurations
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Node Group Form: Child Node Groups Tab

The "Node Group Form" (on page 87) provides details about the selected Node Group. 

Child Node Groups can be created to associate groups of nodes in a hierarchy. For example, a hier-
archical set of Node Groups might be based on geographical location. The Parent Node Group might be
named United States to represent all of the nodes in the United States. Additional Node Groups might
exist for each state in which your business offices reside (for example Colorado and California). Each of
these individual state Node Groups are added as Child Node Group of the United States Node Group.

For information about each of the columns displayed in the Child Node Groups table, see "Node Group
Hierarchy (Child Node Group) Form" (on page 91)

By default, each Child Node Group is represented by a hexagon that appears with the other Node objects
of the Parent Node Group in the Node Group Map. Child Node Group objects can be moved and have
their locations saved with other Node objects in the map. Unlike other Node objects, double-clicking a
Child Node Group object displays a map of the nodes in the Child Node Group rather than the object's
form.

An NNMi administrator alternatively can configure the map to display all nodes in a Child Node Group as
though its contents are directly in the Parent Node Group by setting the Expand Child in Parent Node
Group Map attribute. An NNMi administrator must set this option for each Child Node Group that should
be expanded. See "Node Group Hierarchy (Child Node Group) Form" (on page 91) for more information.

For information about each tab:

"Node Group Hierarchy (Child Node Group) Form" (on page 91)Related Topics

"Node Group Maps" (on page 98)

"Navigating within a Node Group Map" (on page 99)

"Position Nodes on a Node Group Map" (on page 100)

Node Group Hierarchy (Child Node Group) Form

Child Node Groups associate groups of nodes in a hierarchical order. For example, the Parent Node
Group might be named United States to represent all of the nodes in the United States. Additional Node
Groups might exist for each state in which your business offices reside (for example Colorado and Cal-
ifornia). Each of these individual state Node Groups can be a Child Node Group of the United States
Node Group.

The following table describes each of the Basics attributes in the Node Group Hierarchy form.
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Attribute Description

Child Node
Group

Indicates the name of a Node Group that is below the current Node Group in the hier-
archical order. For example, Colorado could be a Child Node Group to a Node
Group named United States.

Note: This attribute appears as the Name column in the Child Node Groups table
view.

Expand Child in
Parent Node
Group Map

Used to indicate whether all of the nodes contained in a Child Node Group are dis-
played in the Node Group Map as though they were directly contained in the parent
node group.

If enabled, each node in the group appears as a separate node on the Node Group
Map.

If disabled, a single object represents a Child Node Group on the Node Group Map.

Note the following:

● If the current Node Group has one or more Child Node Groups, each Child
Node Group is also displayed. Child Node Groups are indicated using a hex-
agon as shown below:

● If any Child Node Group is a parent to other Child Node Groups, those Child
Node Groups are also displayed on the map as follows:

■ If the Child Node Group has the Expand Child in Parent Node Group Map
attribute disabled, the Child Node Group appears as a hexagon.

■ If any Child Node Group has the Expand Child in Parent Node Group Map
attribute enabled, NNMi displays each of the nodes in that Child Node
Group.

Note: This attribute appears in the ECiNM column in the Child Node Groups table
view.

Basics Attributes

Related Topics

"Node Group Maps" (on page 98)

"Position Nodes on a Node Group Map" (on page 100)

Node Group Form: Status Tab

The Node Group status is calculated based on the status of the nodes within the group.

The "Node Group Form" (on page 87) provides details about the selected Node Group.

For information about each tab:
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Attribute
Description Minor — At least 20 percent of the nodes in the Node Group have a Status
of Minor.

Status The Node Group status is calculated based on the status of the nodes within the group. NNMi
follows the ISO standard for status classification. Possible values are:

Note: Your NNMi administrator can configure how a Node Group Status is calculated. The
percentages listed below represent the default percentages, which might have been
changed. By default, NNMi sets up the Node Group status so that it is equal to the
most severe Status of any node in the Node Group. See "Help for Administrators" for
more information.

No Status— The Node Group has just been added and NNMi has not yet calculated the
status.

Normal— All nodes in the Node Group have a status of Normal or the threshold spec-
ified for this Target Status has not been reached.

Unknown— All nodes within the Node Group have a status of Unknown.

Warning— At least 30 percent of the nodes within the Node Group have a status of
Warning.

Minor— At least 20 percent of the nodes in the Node Group have a Status of Minor.

Major— At least 10 percent of the nodes within the Node Group have a status of Major.

Critical— At least 5 percent of the nodes in the group have a status of Critical.

Note: When the percentages for more than one Status has been exceeded, NNMi prop-
agates the most severe status. For example, if 40 percent of the nodes in a Node
Group are in Warning Status and 30 percent are in Minor Status, NNMi assigns the
Node Group a Status of Minor.

See "Watch Status Colors" (on page 126) for more information about possible status values.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Status
History

List of up to the last five changes in status for the selected node. This view is useful for obtain-
ing a quick summary of the node status so that you can better determine any patterns in
node behavior and activity.

Click the  Open icon to view more information about a specific status.

Status Attributes

Interface Group Form

Each interface group can include one or more interface-type specifications (based on industry-standard
IANA ifType-MIB variables). The NNMi administrator can create and modify interface group definitions.
The NNMi administrator can also configure interface groups as filters in table views.

For information about each tab:

Tip: Special Actions are available within the Node Group and Interface Group views.
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Depending on your role, Interface Groups can be used in several ways:

Attribute Description

Name The name of this group (text string specified by the NNMi administrator).

Add to View
Filter List

If disabled  , this interface group does not appear in any interface group filter lists for
interface and IP address views.

If enabled  , this interface group is a filter for all interface and IP address views.

Node Group Optional. If configured, this Interface Group is associated with a Node Group and
serves as a filter for that Node Group.

Notes Optional. If your role allows, enter any information that might be useful to you and your
team.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and under-

line characters are allowed.

Interface Group Basics

Attribute Description

Add to
Filter List

NNM iSPI for Performance. Using this feature is entirely optional. The NNM iSPI for Per-
formance can monitor your network without any exported filter.

Enable only for groups that are needed as filters in performance reports. It may take up to an
hour before the results are visible in NNM iSPI for Performance reports. Choose wisely
because establishing a filter requires significant NNM iSPI for Performance processing time.

If disabled  , this group is not available as a filter in NNM iSPI for Performance reports.

If enabled  , this group appears in the Optional Filters selection panel of NNM iSPI for Per-
formance reports.

NNM iSPI for Performance. Interface Group Settings

Interface Group Form: IfType Filters Tab

Interface Group members are filtered by industry-standard IANA ifType-MIB variables.

Note: To be included in this Interface Group, interfaces must match ALL criteria listed on this tab.

The "Interface Group Form" (on page 93) provides details about the selected interface group. 

For information about each tab:

Attribute Description

IfType
Filters

Table view of all IfType filters associated with the selected interface group.

Click the  Open icon to open the"IfType Filter Form" (on page 95) and view more infor-
mation about a filter specification.

IfType Filters Table
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IfType Filter Form

Displays the specification of the selected interface-type filter. This filter is based on an industry-standard
IANA ifType-MIB variable.

Attribute Description

IfType Click the  Lookup icon and select  Open to display the "IfType (Interface Type) Form"
(on page 95) and view more information about the specified IANA ifType-MIB variable.

If your role allows, you can easily choose from a list of all known industry-standard IANAif-
Type-MIB variables (as of the time NNMi was released). You can also add a new value. (For
more information, see http://www.iana.org/assignments/ianaiftype-mib)

IfType Specification

IfType (Interface Type) Form

Displays information about the selected industry-standard IANA ifType-MIB variable.

The NNMi administrator can change these settings.

Attribute Description

IfType Text string. The IANA ifType TEXTUAL-CONVENTION values extracted from the IANA
ifType-MIB. This text string displays as the Interface Type attribute value in Interfaces
views. (For more information, see http://www.iana.org/assignments/ianaiftype-
mib.)

If your role allows, click the  Lookup icon and select one of the options from the drop-
down menu:

● Quick View to display summary information for the currently selected IfType.

●  Quick Find to view and select from the list of all existing IfTypes.

●  Open to display the details of the currently selected IfType.

●  New to create a new SNMPv3 Setting.

Number Industry-standard number assigned to this ifType.

Description Optional. If your role allows, provide any description that would be useful for com-
munication purposes within your team.

Type a maximum of 2048 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Interface Type Definition

Interface Group Form: Additional Filters Tab

Additional Filters enable the NNMi administrator to use expressions to further define which interfaces to
include in an Interface Group.

If any Additional Filters are created:
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● NNMi first evaluates any ifType filters. Interfaces must match all specifications to belong to this Inter-
face Group.

● NNMi then evaluates any Additional Filters expression. Interfaces must also match all Additional
Filters expression specifications to belong to this Interface Group.

Note:  The Additional Filters Editor requires that your user name be assigned a role of Administrator. If you
are an NNMi Administrator, see the "Help for Administrators" for more information about how to use
the Additional Filters Editor.

 The "Interface Group Form" (on page 93) provides details about the selected Interface Group. 

For information about each tab:

If an NNMi administrator created any Additional Filters for the selected Interface Group, NNMi displays the
Additional Filters expression.

Management Station Form

Management Station configurations are used for a variety of purposes:

● Enable NNM  6.x or 7.x to forward events to NNMi.

● Enable access to NNM  6.x or 7.x features from incidents that were forwarded from NNM 6.x/7.x. (See
"Access NNM 6.x and 7.x Features" (on page 13) for more information.)

● Filter incident views by NNM  6.x or 7.x Management Station. 

Name Description

Name The name your team uses to identify this remote NNM 6.x or 7.x man-
agement station.

NNM Version The version of NNM (6.x or 7.x) in use on this remote management station.

IP Address The IP address used for communication with this remote NNM 6.x or 7.x
management station.

ovas Port (OpenView Appli-
cation Server)

The port number used by the OpenView Application Server (ovas) on this
NNM 6.x or 7.x management station.

The port number is usually 7510.

Web Server Port The port number used by the web server on this NNM 6.x or 7.x man-
agement station:

● For NNM 7.x management stations on all operating systems, the port
number is usually 3443.

● For NNM 6.x management stations running UNIX, the port is usually
3443.

● For NNM 6.x management stations running Windows systems, it is
usually 80.

Description Optional. Notes your NNMi administrator added about this NNM 6.x or 7.x
management station.

Maximum length 255 characters. Alpha-numeric, punctuation, spaces, and
underline characters allowed.

NNM 6.x or 7.x Management Station Attributes
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Viewing Maps (Network Connectivity)

NNMi provides several views that display maps of how a specific device is connected to the rest of the net-
work. You can access these views in the Troubleshooting workspace or by using the Actions→menu.
These views include:

● Layer 2 Neighbor View

● Layer 3 Neighbor View

● Path View

● "Node Group Maps" (on page 98)

The OSI initiative identified seven layers for communication and computer network protocol design. The
Layer 21 and Layer 32 Neighbor Views display data according to the Open Systems Interconnection (OSI)
model.

The Path view combines real-time data about both Layer 2 and Layer 3 information.

On the maps, the lines between devices indicate the connections.

In Layer 2 Neighbor View maps, interfaces that are connected to a neighbor are indicated by little squares
around the background shape of the parent node. Pay special attention to the color of the lines, which rep-
resent connections. For example:

See About Status Colors for more information.

In Layer 3 Neighbor View maps, addresses connected to neighbors within the same IP subnet are indi-
cated by little hexagons around the background shape of the parent node. The lines indicate the subnets,
so the lines are beige (no status). For example:

Node Group Maps show the members of a Node Group (defined by the NNMi administrator). The map dis-
plays the status and connectivity of each member. Your NNMi administrator can also specify a back-
ground image (for example, a map of North America). Child Node Groups display the hierarchy of nodes
in a Node Group.

1Refers to the Data Link layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Data Link layer moves data across the physical links in the network. The switches and bridges
are devices that redirect data messages at the layer 2 level, using the destination Media Access Control
(MAC) address to determine where to direct the message.
2Refers to the Network layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Network layer is concerned with knowing the address of the neighboring nodes in the network,
selecting routes and quality of service, and recognizing and forwarding incoming messages to local host
domains. The router and switch-router are the devices that redirect data messages at the Layer 3 level.
Everything in a subnet is connected at the Layer 3 (IP) level.
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Node Group Maps

Node Group Maps enable you to see the members of a Node Group (defined by the NNMi administrator).
The map displays the status and connectivity of each member. Your NNMi administrator can specify a
background image (for example, a map of North America).

Note: If your role allows, you can configure the settings for a Node Group map, including selecting the
background image. To do so, use the File→ Open Node Group Map Settings option. See "Help for
Administrators" for more information.

Because node membership is based on the Node Group, not connectivity, one or more nodes might not
be connected on a Node Group Map.

To display a Node Group Map using the Troubleshooting workspace:

1. From theWorkspaces navigation panel, select the Troubleshooting workspace.

2. Select Node Group Map.

3. In the Node Group field, enter the name of the Node Group whose map you want to display.

Note: As you start typing the first few letters (case-sensitive) of the name of the node group you want
to use, you will view a list that includes all potential node groups with names that match the
letters as you enter them.

To display a Node Group Map using the Actions menu:

1. From theWorkspaces navigation panel, select the Incident,Monitoring or Inventoryworkspace.

2. From the Incident or Monitoring workspace, select Node Groups.

3. From the Incident Management or Incident Browsing workspace, select the Island Node Group inci-
dent view of interest.

Note: Incidents whose Source Object is an Island Node Group include Remote site in the incident
message. See "Island Node Group Map" (on page 146) for more information.

4. In the Node Group or Incident view, click the  selection box that precedes the Node Group or Island
Node Group incident of interest.

5. Select Actions→ Node Group Map.

Note:When you use the Actions menu to display a map, each unique map appears in a new window. See
Using Actions to Perform Tasks for more information.

When viewing nodes on a Node Group Map, keep in mind the following:

● By default, each Child Node Group is represented by a single hexagon that appears with the other
Node objects of the Parent Node Group in the Node Group Map. Child Node Group objects can be
moved and have their locations saved with other Node objects in the map. Unlike other Node objects,
double-clicking a Child Node Group object displays a map of the nodes in the Child Node Group
rather than the object's form.

● To display the nodes within a Child Node Group, do one of the following:

■ Double-click the Child Node Group object.

■ Select the Child Node Group object and do one of the following:

o Click the Open Node Group Map icon.

o Select Actions→ (Child Node Group Name) Map.

● An NNMi administrator alternatively can configure the map to display all nodes in a Child Node
Group as though its contents are directly in the Parent Node Group by setting the Expand Child in Par-
ent Node Group Map attribute. An NNMi administrator must set this option for each Child Node Group
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that should be expanded. See "Node Group Hierarchy (Child Node Group) Form" (on page 91) for
more information.

● To view more information about the selected Node Group, open the Node Group form using the File
→ Open Node Group for Map option.

● NNMi enlarges any node on a Node Group map that has an open root cause incident associated with
it. To view an associated incident for a node on a Node Group map, double-click the node of interest.
In the Node form, select the Incidents tab.

To disable the open root cause indicator, clear the Indicate Root Cause Incidents check box in the
map view toolbar.

To refresh node and Node Group status at any time, use the Refresh Status icon. See Refresh Only
Node Status on a Map for more information. You can also refresh connectivity, map objects, as well as

node and Node Group status using the Refresh All icon.

To return to the previous Node Group map, click the Back to Previous Node Group icon. See "Navi-
gating within a Node Group Map" (on page 99) for more information about ways to navigate within a Node
Group Map."Navigating within a Node Group Map" (on page 99)

NNMi provides the following Node Group Map views:

● "Node Group Overview Map" (on page 100)

● "Network Overview Map" (on page 101)

● "Important Nodes Map"

● "Networking Infrastructure Devices Map" (on page 101)

● "Routers Map" (on page 102)

● "Switches Map" (on page 102)

Related Topics

"Navigating within a Node Group Map" (on page 99)

"Position Nodes on a Node Group Map" (on page 100)

Navigating within a Node Group Map

Navigation and accessing node details on a Node Group Map are the similar to those for the Layer 2
Neighbor and Layer 3 Neighbor maps with the following exceptions:

● To display a Node Group map of a Child Node Group in the same window:

a. Double-click the Child Node Group object: 

b. Select the Child Node Group object and click the Open Node Group Map icon.

● To display a Node Group Map for a Child Node Group in a new window, use Actions→ Node Group
Map.

Note: The Child Node Group map must be unique to be displayed in a new window. See Using
Actions to Perform Tasks for more information.

● To return to the previous Node Group Map, use the Back to Previous Node Group icon .

● To open the Node Group form for a Node Group map, select File→ Open Node Group for Map.
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● To open the Node Group Map Settings form from a Node Group map, select File→ Open Node
Group Map Settings.

● You can manually reposition the nodes on the background image, and, if your role allows, save the
map for later use. See "Position Nodes on a Node Group Map" (on page 100) for more information.

● If Indicate Key Incidents is enabled, NNMi enlarges any node on a Node Group map that has an
open Key Incident associated with it. To view an associated incident for a node on a Node Group
map, double-click the node of interest. In the Node form, select the Incidents tab.

To enable the Key Incident indicator, select the Indicate Key Incidents check box in the map view tool-
bar.

To disable the Key Incident indicator, clear the Indicate Key Incidents check box in the map view tool-
bar.

As in other maps, clicking the Open icon after selecting a node on the map, displays the Node form.

Clicking the Open icon after selecting a Child Node Group, opens the Child Node Group form. See
Use Map Views and Access More Details (Quick View and Forms) for more information.

Position Nodes on a Node Group Map

You can manually reposition the nodes on the map, and, if your role allows, save the map. NNMi users
see your change the next time the map is refreshed.

Note: If your role allows, to return to the original layout that NNMi automatically determines, use File→
Clear Layout.

To position and save node locations on a Node Group Map view:

1. Navigate to the Node Group Map:

a. From the workspace navigation panel, select the Inventory or Monitoring workspace.

b. Select Node Groups.

c. In the Node Group view, click the  selection box that precedes the Node Group of interest.

d. Select Actions→ Node Group Map.

2. Manually re-position the node locations by dragging and dropping the nodes to the location you want.

3. If your role allows, select Save Layout from the toolbar menu to save all node locations on the
map.

Note: Each time you select Save Layout, NNMi deletes any previous node location information for the
map.

Node Group Overview Map

This Node Group map displays all top-level Node Groups that have been configured for your network.

Use this view when you want to do any of the following tasks:

● Determine the Node Groups created for your network.

● Determine the Node Group hierarchy for the Node Groups created for your network.

To display the Node Group Overview map using the TopologyMaps workspace:

1. From the workspace navigation panel, select the TopologyMaps workspace.

2. Select Node Group Overview.

Related Topics
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Views Provided by NNMi

Node Group Map Objects

Network Overview Map

Displays a map containing the most highly connected nodes in the Layer 3 network. This map periodically
updates both topology and status. The update interval is more frequent when the topology is changing,
and less frequent when the topology is not changing.

Note: Automatic refresh cancels any modifications, such as selecting or zooming, you make to this view.

Use this view when you want to do any of the following tasks:

● View a high level overview of your network

● Determine the most highly connected nodes in the Layer 3 network

● Determine discovery progress

To display the Network Overview map using the TopologyMaps workspace:

1. From the workspace navigation panel, select the TopologyMaps workspace.

2. Select Network Overview.

Related Topics

Views Provided by NNMi

Node Group Map Objects

Networking Infrastructure Devices Map

Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the Net-
working Infrastructure Devices map is not available, your NNMi administrator might have chosen to
remove this map from the Topology Maps workspace. 

The Networking Infrastructure Device map provides representative Node Groups for the Switches and for
the Routers in your network. Each of the following device types, if applicable, are also included on the
map:

● Chassis

● Firewalls

● Voice Gateways

To view the connectivity within each device type (Node Group), click the Node Group of interest. See
"Node Groups View (Inventory)" (on page 23) for more information about Node Groups.

Use this view when you want to do any of the following tasks:

● Determine the types of devices in your network.

● View the connectivity within a group of devices of the same type.

● Determine the number of devices of a specific type.

To display the Networking Infrastructure Devices map using the TopologyMaps workspace:

1. From the workspace navigation panel, select the TopologyMaps workspace.
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2. Select Networking Infrastructure Devices.

Related Topics

Views Provided by NNMi

Node Group Map Objects

Routers Map

Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the Routers
Map is not available, your NNMi administrator might have chosen to remove this map from the
Topology Maps workspace.

The Routers map shows a graphical representation of the Layer 3 connectivity in your network. Connector
devices on Layer 3 maps are routers, switch-routers, and gateways. (See About Map Symbols for more
information.) 

Note: If the number of nodes in your network is greater than the maximum number of nodes configured to
be displayed on the map, NNMi filters the map to display routers that have interfaces with
addresses in the largest number of overall subnets in the network. This means that routers with little
or no connectivity are only displayed for smaller networks.

Use this view when you want to do any of the following tasks:

● Understand the router connectivity between your devices.

● Determine the routers that are connected to the largest number of subnets.

To display the Routers map using the TopologyMaps workspace:

1. From the workspace navigation panel, select the TopologyMaps workspace.

2. Select Routers.

Related Topics

Views Provided by NNMi

Node Group Map Objects

Switches Map

Tip: Your NNMi administrator can add or delete maps from the Topology Maps workspace. If the Switches
map is not available, your NNMi administrator might have chosen to remove this map from the Topol-
ogy Maps workspace.

The Switches map shows a graphical representation of the Layer 2 connectivity in your network. Con-
nector devices on Layer 2 maps are switches, ATM switches, and switch-routers. (See About Map Sym-
bols for more information.) 

Note: If the number of nodes in your network is greater than the maximum number of nodes configured to
be displayed on the map, NNMi filters the map to display switches that are the most highly con-
nected.

Use this view when you want to do any of the following tasks:

● Understand the switch connectivity between your devices.

● Determine the switches that are connected to the largest number of devices.

To display the Switches map using the TopologyMaps workspace:

1. From the workspace navigation panel, select the TopologyMaps workspace.
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2. Select Switches.

Related Topics

Views Provided by NNMi

Node Group Map Objects

Display the Layer 2 Neighbor View

The Layer 21 Neighbor View shows a graphical representation of the selected device and any con-
nections with other devices within a specified number of hops from the selected device. Connector
devices on Layer 2 are switches and bridges. (See About Map Symbols for more information.)

Use this neighbor view when you want to do any of the following tasks:

● Understand the switch connectivity between your devices.

● Assist in finding the cause of a connectivity problem (see which device along the communication
chain has a status other than normal).

● Identify the highly-connected nodes in your environment.

● Determine what else might be affected by a problem device, such as a problem interface.

To display the Layer 2 Neighbor View using the Troubleshooting workpspace:

1. From the workspace navigation panel, select the Troubleshooting workspace.

2. Select Layer 2 Neighbor View.

3. In the Node or IP field, type the name or IP address of a node in your network. (NNMi provides a case
-sensitive drop-down list to help speed up your selection.)

4. A hop is a node representing any network device, such as a workstation, gateway, or switch, which is
connected by a link with no intermediate nodes.

Click the Number of Hops drop-down list, and select the number of hops to display (1-9). The default
number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection ( See "Viewing Maps
(Network Connectivity)" (on page 97)).

A mesh connection represents the location of multiple devices interconnected with each other. A
mesh is represented by the following icon:

To display the Layer 2 Neighbor View using the Actions menu in a table view or in a form:

1. From the workspace navigation panel, select the table view of interest.

1Refers to the Data Link layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Data Link layer moves data across the physical links in the network. The switches and bridges
are devices that redirect data messages at the layer 2 level, using the destination Media Access Control
(MAC) address to determine where to direct the message.
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For example the Inventory→ Nodes view.

2. Select the object instance of interest (node, interface, or address).

For example, click the  selection box that precedes the node of interest from the Nodes view.

3. Select Actions→ Layer 2 Neighbor View. The starting node appears with a bold label on a map.

Note: When you use the Actions menu to display a map, each unique map appears in a new win-
dow. See Using Actions to Perform Tasks for more information.

4. A hop is node representing any network device, such as a workstation, gateway, or switch, which is
connected by a link with no intermediate nodes.

Click the Number of Hops drop-down list, and select the number of hops to display (1-9). The default
number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection ( See "Viewing Maps
(Network Connectivity)" (on page 97)).

A mesh connection represents the location of multiple devices interconnected with each other. A
mesh is represented by the following icon:

To see more information about a specific connection on the map:

1.
Select the line or (mesh connection) icon of interest.

2. Click the  Open icon on the map toolbar.

3. The Layer 2 Connection form displays, showing all information for the connection. See "Layer 2 Con-
nection Form" (on page 105) for information.

To view the addresses for a particular interface:

1. Click to select the interface of interest.

Note: If the interface is difficult to select, use the + (plus) key to zoom in on the map.

2. From the map view toolbar, select the Open icon.

3. In the Interface form, select the Addresses tab.

4. Each address associated with the interface appears in the IP addresses table.

To view the port number for an interface:

Click the interface of interest.

The port number for the interface appears as a new label.

To view the interface name at each end of a connection:

Click the line representing the connection.

The interface name for each end of the connection appears as a new label.

Tip: Use Ctrl-Click to select mutiple lines and display more interface names.
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Related Topics:

Using Map Views

"Layer 2 Connection Form" (on page 105)

Layer 2 Connection Form

The Layer 2 Connection form provides details about a managed connection. These details include the
interfaces that make up the connection, the protocol used to create this connection, and the current status
of the connection. For example, if all interfaces are down within a connection, the connection status is
listed as Critical.

For information about each tab:

Attribute Description

Name Name that NNMi assigned to the Layer 2 Connection. This name contains the list of member
interface names separated by a comma. Each interface name appears in the format: Node_
Name[Interface_Name].

Status Overall status for the current connection. NNMi follows the ISO standard for status clas-
sification. See the "Layer 2 Connection Form: Status Tab" (on page 107) for more infor-
mation. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see the "Layer 2 Connection
Form: Conclusions Tab" (on page 108). Status reflects the most serious outstanding con-
clusion. See "Watch Status Colors" (on page 126) for more information about possible status
values.

Note: The icons are displayed only in table views.

Basic Attributes
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Attribute Description

Topology
Source

Indicates the data source used to create this connection:

CDP - Cisco Discovery Protocol

EDP - Extreme Discovery Protocol

ENDP - Enterasys Discovery Protocol (also known as CDP - Cabletron Discovery Protocol)

FDB - Forwarding Database (also known as AFT - Address Forwarding Table on a
bridge/switch)

FDP - Foundry Discovery Protocol

LLDP - Link Layer Discovery Protocol

MLT - Multi-Link Trunk technology (NNMi Advanced)

PAgP - Cisco Systems Port Aggregation Protocol (NNMi Advanced)

SONMP - SynOptics Network Management Protocol

SUBNET CONNECTION - Subnet Connection Rule. See "Help for Administrators" for more
information.

USER - This connection was configured by your NNMi administrator (using the Connection
Editor). See "Help for Administrators" for more information.

Notes Provided for network operators to use for any additional notes required to further explain the
Layer 2 connection. Information might include when a cable was last replaced.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Layer 2 Connection Form: Interfaces Tab

The "Layer 2 Connection Form" (on page 105) provides details about a managed connection. These
details include the interfaces that make up the connection, the protocol used to create this connection, and
the current status of the connection. For example, if all interfaces are down within a connection, the con-
nection status is listed as Critical.

For information about each tab:

Attribute Description

Interfaces Table view of both of the interfaces that are part of the current connection. You can use this
table to determine the status, administrative state, operational state, name, type, interface
speed, and Layer 2 connection for each interface associated with the selected Layer 2 Con-
nection.

Click the  Open icon to view more information about a specific interface.

Interfaces Table

Layer 2 Connection Form: Incidents Tab

The "Layer 2 Connection Form" (on page 105) provides details about a managed connection.

For information about each tab:
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Attribute Description

Associated
Incidents

Table view of the incidents associated with the selected Layer 2 connection. These inci-
dents are sorted by creation time so that you can view the incidents in chronological order.
Use this view to determine which incidents are still open for the selected connection.

Click the Open icon to open the "Incident Form" (on page 132) and view more infor-
mation about a specific incident.

Incidents Table

Layer 2 Connection Form: Status Tab

The "Layer 2 Connection Form" (on page 105) provides details about a managed connection.

For information about each tab:

Attribute Description

Status Overall status for the current connection. NNMi follows the ISO standard for status clas-
sification. Possible values are:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major

Critical

For information about how the current status was determined, see "Layer 2 Connection

Form: Conclusions Tab" (on page 108). Status reflects the most serious outstanding con-
clusion. See "Watch Status Colors" (on page 126) for more information about possible status
values.

NNMi Advanced. If the Layer 2 Connection is an Aggregator Link, the Status is calculated
using the Status of the Aggregator Interface members. Click here for more information.

An Aggregator Link Status of Minor indicates the Status of at least one of the Aggregator Inter-
faces that is a member of the Aggregator Link is Minor. A Status of Critical indicates the
Status of at least one of the Aggregator Interfaces that is a member of the Aggregator Link is
Critical.

Also see Layer 2 Neighbor View Map Objects.

Note: The icons are displayed only in table views.

Status
Last
Modified

Date and time indicating when the status was last set.

Status Attributes
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Attribute Description

Status
History

List of up to the last five changes in status for the selected connection. This view is useful for
obtaining a quick summary of the connection status so that you can better determine any pat-
terns in connection behavior and activity.

Click the  Open icon to view more information about a specific status.

Layer 2 Connection Form: Conclusions Tab

The "Layer 2 Connection Form" (on page 105) provides details about a managed connection.

For information about each tab:

Attribute Description

Status Con-
clusions

The dynamically generated list of summary statuses of the connection at points in time
that contributed to the current overall status of the selected connection. Status is set by
Causal Engine.

Each conclusion listed is still outstanding and applies to the current overall status.

This view is useful for obtaining a quick summary of the status and problem description
for the current connection that led up to the connection's most current status.

Examples of conclusions that might appear together are listed below:

● SNMP Agent Not Responding

● Interface Down

● Address Down

The status value is correlated based on the most critical conclusions. Click the Open
icon to view more information about a specific conclusion.

Conclusions Table (for Status)

Layer 2 Connection Form: Link Aggregation Tab (NNMi Advanced)

The "Layer 2 Connection Form" (on page 105) provides details about the selected Layer 2 connection.

For information about each tab:

The Layer 2 Connection Form: Link Aggregation Tab provides information about the Link Aggregation1 in
which the Layer 2 Connection belongs. This tab only appears if the selected Layer 2 Connection par-
ticipates in a Link Aggregation protocol. The contents of the tab differ based on the Layer 2 Connection's
role in the Link Aggregation (Member or Aggregator).

A Member Layer 2 Connection's Link Aggregation Tab displays the Link Aggregation protocol and a

1A Link Aggregation is comprised of an Aggregator Link, Aggregator Interface, and the physical interfaces
and connections that they represent. An Aggregator Link object represents many-to-many physical con-
nections. For example, two nodes might be connected with four physical connections. These four physical
connections are depicted as a single Aggregator Link object using a thick line on the Layer 2 Neighbor
View map. The interface depicted at each end of the Aggregator Link object is an Aggregator Interface
object. An Aggregator Interface object represents the collection of physical interfaces for one end of an
Aggregator Link.
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reference to the Aggregation's Aggregator Layer 2 Connection. Click here for more details about the attrib-
utes displayed.

Attribute Description

Link Aggre-
gation Pro-
tocol

Protocol used to create the Link Aggregation, including the Aggregator Layer 2 Con-
nection and its physical Members. Possible values include:

● Cisco Systems Port Aggregation Protocol (pagp)

● Multi-Link Trunk technology (mlt)

● Split Mutli-Link Trunk technology (splitMlt)

● Inter-switch trunk that is part of a Split Multi-Link Trunk configuration (istMlt)

Note: In rare cases, it is possible for a Layer 2 Connection to connect sets of Aggre-
gator/Member Interfaces that are configured using different Link Aggregation pro-
tocols. In these cases, the Layer 2 Connection's Link Aggregation Protocol attribute
value contains multiple protocols separated with a slash (/).

Aggregator Name of the Aggregator Layer 2 Connection that is part of the Link Aggregation. The
Aggregator represents the collection of physical Layer 2 Connections that are Members
of the Link Aggregation.

See Layer 2 Neighbor View Map Objects for more information.

The name value is the Name that the NNMi administrator provided to identify this Layer 2
Connection.

Click the Lookup icon, and choose Open to open the form for the Aggregator
Link.

Link Aggregation Tab

The Aggregator Layer 2 Connection's Link Aggregation Tab lists the Member Layer 2 Connections of the
Link Aggregation and provides cumulative bandwidth statistics for the Link Aggregation Layer 2 Con-
nections. Click here for more details of the attributes displayed.

Attribute Description

Link Aggre-
gation Pro-
tocol

Protocol used to create the Link Aggregation, including the Aggregator Interface and its
physical Members. Possible values include:

● Cisco Systems Port Aggregation Protocol (pagp)

● Multi-Link Trunk technology (mlt)

● Split Mutli-Link Trunk technology (splitMlt)

● Inter-switch trunk that is part of a Split Multi-Link Trunk configuration (istMlt)

Note: In rare cases, it is possible for a Layer 2 Connection to connect sets of Aggre-
gator/Member Interfaces that are configured using different Link Aggregation pro-
tocols. In these cases, the Layer 2 Connection's Link Aggregation Protocol attribute
value contains multiple protocols separated with a slash (/).

Available
Bandwidth

The lowest Available Bandwidth value of the Aggregator Interfaces connected by this
Layer 2 Connection.

Link Aggregation Tab
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Attribute Description

Maximum
Bandwidth

The lowest Maximum Bandwidth value of the Aggregator Interfaces connected by this
Layer 2 Connection.

Available
Bandwidth
Percentage

Percentage value computed using the Available Bandwidth divided by the Maximum
Bandwidth values.

Members Table view of the Layer 2 Connections that are Members of the selected Aggregator Link.

Click the Open icon to view more information about a specific Layer 2 Connection.

Layer 2 Connection Form: Registration Tab

The "Layer 2 Connection Form" (on page 105) provides details about a managed connection.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration

Display the Layer 3 Neighbor View

The Layer 31 Neighbor View is a graphical representation of the subnets in which the starting node par-
ticipates, and the health of the routers in those subnets. Connector devices on Layer 3 are routers and
switch/routers. (See About Map Symbols for more information.)

Use this neighbor view when you want to do any of the following tasks:

● Determine whether a subnet is down.

● Understand the router connectivity between your devices.

● Assist in finding the root cause of a connectivity problem (see which device along the communication
chain has a status other than normal).

● Identify the highly-connected nodes in your environment.

To display a Layer 3 Neighbor View using the Troubleshooting workpspace:

1. From the workspace navigation panel, select the Troubleshooting workspace.

2. Select Layer 3 Neighbor View.

1Refers to the Network layer of the multilayered communication model, Open Systems Interconnection
(OSI). The Network layer is concerned with knowing the address of the neighboring nodes in the network,
selecting routes and quality of service, and recognizing and forwarding incoming messages to local host
domains. The router and switch-router are the devices that redirect data messages at the Layer 3 level.
Everything in a subnet is connected at the Layer 3 (IP) level.
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3. In the Node or IP field, type the name or IP address of a node in your network. (NNMi provides a case
-sensitive drop-down list to help speed up your selection.)

4. A hop represents any network device, such as a workstation, gateway, or switch, that is connected by
a link with no intermediate nodes.

Click the Number of Hops drop-down list, and select the number of hops to display (1-9). The default
number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the subnet between the devices (see
"Viewing Maps (Network Connectivity)" (on page 97)).

To display the Layer 3 Neighbor View using the Actions menu in a table view or in a form:

1. From the workspace navigation panel, select the table view of interest.

For example the Inventory→ Nodes view.

2. Select the initial object of interest.

For example, click the  selection box that precedes the node of interest from the Nodes view.

3. Select Actions→ Layer 3 Neighbor View.

Note:  When you use the Actions menu to display a map, each unique map appears in a new win-
dow. See Using Actions to Perform Tasks for more information.

4. A hop represents any network device, such as a workstation, gateway, or switch, that is connected by
a link with no intermediate nodes.

Click the Number of Hops drop-down list, and select the number of hops to display (1-9). The default
number of hops is 1.

5. All devices connected to the initial object within the specified number of hops are displayed.

The color of the line between the devices indicates the health of the connection (see "Viewing Maps
(Network Connectivity)" (on page 97)).

To see more information about a specific subnet on the map:

1. Select the line that represents the subnet of interest.

2. Click the  Open icon on the map toolbar.

The IP Subnet form displays, showing all details of the subnet. See"IP Subnet Form" (on page 112) for
more information.

To view address information for an interface at each end of a connection:

Click the line representing the connection of interest.

The IP address for each interface appears as a new label.

Tip: Use Ctrl-Click to select multiple lines and display more IP addresses.

Related Topics:

Using Map Views
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IP Subnet Form

The IP Subnet form provides details about the selected subnet.

If your role allows, you can add notes to communicate information about this subnet to your team.

For information about each tab:

Attribute Description

Name Subnet for the IP network. This value is determined by the discovery process (calculated
from IP Addresses and the subnet prefix information).

Prefix The value of the prefix for the current subnet (also known as the subnet address).

Prefix
Length

The number of significant bits in the subnet prefix. This value is used to determine the size of
the subnet.

Notes Provided for network operators to use for any additional notes required to further explain the

subnet. Information might include its use; for example, point to point for dialup. You might
also use this attribute to track which geographical group might use the subnet.

Type a maximum of 1024 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Note: You can sort your subnet table views based on this value. Therefore, you might want to
include keywords for this attribute value.

Basic Attributes

IP Subnet Form: IP Addresses Tab

The "IP Subnet Form" (on page 112) provides details about the selected subnet.

For information about each tab:

Attribute Description

IP
Addresses

Table view of the IP addresses associated with the selected subnet. You can use this table
to determine the state, address, and interface, and parent node for each address asso-
ciated with the selected subnet.

Click the  Open icon to open the "IP Address Form" (on page 72) and view more infor-
mation about a specific address.

IP Addresses Table

IP Subnet Form: Registration Tab

The "IP Subnet Form" (on page 112) provides details about the subnet selected.

For information about each tab:

Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Registration
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Attribute Description

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Path Between Two Nodes that Have IPv4 Addresses

Note: If NNMi Advanced is licensed and installed, also see "Enhanced Path View (NNMi Advanced) " (on
page 116).

Path View calculates the route that data flows between two nodes, and provides a map of that information.
The two nodes can be any combination of end nodes, switches, or routers.

Note: End nodes are the primary use case for this view. If you specify switches or routers as the Source or
Destination, the path is a best effort.

Each connection between the two nodes is a line on the map. If more than one route is possible, NNMi
uses a set of rules to choose the displayed route (see "Path Calculation Rules" (on page 114)). NNMi indi-
cates there is more than one possible path under either of the following conditions:

● NNMi Advanced. NNMi finds more than one Active router in a Router Redundancy Group. See
"Router Redundancy Group View (NNMi Advanced)" (on page 22) for more information about Router
Redundancy Groups. See "Path Calculation Rules" (on page 114) for more information about Active
router paths.

● NNMi Advanced. HP Router Analytics Management System (RAMS) determines more than one equal
cost path and, therefore, cannot determine which path is in use. See "Enhanced Path View (NNMi
Advanced) " (on page 116) for more information.

Note: Your NNMi administrator can configure Path View connections using a PathConnections.xml
file. This file enables Path View to traverse undiscovered regions of your network. Each time NNMi
determines a node in the Path View, NNMi checks whether the node is specified as a Start node in
the  PathConnections.xml file. If the node is specified as a Start node, each path segment con-
figured in PathConnections. xml is inserted in the Path View map.

NNMi Advanced. When RAMS data is used to determine the router paths, NNMi ignores the  Path-
Connections.xml file. See "Enhanced Path View (NNMi Advanced) " (on page 116) for more infor-
mation.

Path View is a  flow diagram rather than a  connection diagram. It displays the flow of network traffic
rather than all of the available connections. To view all possible connections between nodes, use the
Layer 2 Neighbor View. See "Display the Layer 2 Neighbor View" (on page 103) for more information.

Note: Intermediate devices that are physically connected might appear in a Path View. For example, if 
two end nodes connect to the same switch, but exist in different VLANs, the path includes the
access router where the VLAN and subnet determination is made.

Path View is useful for diagnosing connectivity problems. Path View shows each switch (and the port on
that switch) that participates in the current path. You can quickly identify problematic switch ports that need

to be shut down. Select any map symbol and click the  Open icon to display all known details about that
object. Mouse over any object on the map to access the Quick View information about that object.

Tip: Click the  Swap icon to switch the Source and  Destination values, and then click the
 Compute Path. Sometimes NNMi can detect more information from one direction or the other.

Using Path View from the Troubleshooting workspace:

1. From the workspace navigation panel, select the Troubleshooting workspace.
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2. Select Path View.

3. In the  Source  field, type the name or IPv4 address of a node in your network. (NNMi provides a case
-sensitive drop-down list to help speed up your selection.)

4. Optional. In the  Destination field, type a node name or IPv4 address.

If a  Destination value is not provided, NNMi displays the path from the Source node to its access
router.

5. Click the  Compute Path icon.

Using Path View from the Actions menu in a table view or in a form:

1. Access a table view of nodes, interfaces, or IPv4 addresses.

2. Decide which object you want to use as the starting point in the path (Source). Click the  selection
box in the row representing that object.

3. Optional. Decide which object you want to use as the destination point in the path (Destination). Click

the  selection box in the row representing that object.

If a  Destination value is not provided, NNMi displays the path from the  Source node to its access
router.

4. In the menu bar, select Actions→ Path View.

Note: When you use the  Actions  menu to display a map, each unique map appears in a new win-
dow. See  Using Actions to Perform Tasks for more information.

5. Click the  Compute Path icon to display the map of the path.

Related Topics:

"Path Calculation Rules" (on page 114)

"Investigate Errors and Performance Issues" (on page 116)

"Access Node Details" (on page 127)

Path Calculation Rules

Note: If NNMi Advanced is licensed and installed, also see "Enhanced Path View (NNMi Advanced) " (on
page 116)

Path View calculates the active flow of data between devices at the time the view is requested. The active
path includes the following devices:

● Source and destination nodes

● Layer 2 devices between the source node and its access router

● Layer 2 devices between the destination node and its access router

● Layer 2 and Layer 3 routing core between the two access routers

Note: The path calculated can include one or more VLANs when applicable.

NNMi starts with the specified source and follows the active path to the specified destination. If no missing
connections are detected, the Path View shows the source node, destination node, and each router and
switch in between.

Note: Your NNMi administrator can configure Path View connections using a PathConnections.xml
file. This file enables Path View to traverse undiscovered regions of your network. Each time NNMi
determines a node in the Path View, NNMi checks whether the node is specified as a Start node in
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the PathConnections.xml file. If the nodes is specified as a Start node, each path segment con-
figured in PathConnections. xml is inserted in the Path View map.

NNMi Advanced. When RAMS data is used to determine the router paths, NNMi ignores the Path-
Connections.xml file. NNMi also shows all Equal Cost Multi-Paths (ECMP). See "Enhanced Path View
(NNMi Advanced) " (on page 116) for more information.

A cloud symbol can represent the following types of information. The map can include multiple cloud
symbols:

● If a missing connection is detected (no response to SNMP and no entry in PathConnections.xml),
the cloud symbol appears in the routing core between the access routers.

● If the port connecting the end node to the first switch is forwarding more than one MAC address, this
indicates an intermediate device (such as a hub or one or more undiscovered switches). A cloud
appears at that location in the path.

When interpreting Path View results, note the following:

● The Source and Destination nodes must meet  either of the following criteria:

■ Support SNMP and be previously discovered by NNMi (recorded in the topology database)

■ Have traceroute available

● All access routers and any Layer 2 devices between the Source and Destination nodes must meet the
following criteria:

■ Support SNMP

■ Be previously discovered by NNMi (recorded in the topology database)

● Optional. Each router and switch is monitored by NNMi.

● The time stamp provided in the final Path View is the time at which the final active path was deter-
mined.

● NNMi Advanced. If the Router Redundancy Group has more than one Active router, NNMi selects one
Active router for the path. To indicate there is more than one possible path, NNMi connects any addi-
tional Active routers to the chosen router as shown in the following example:

NNM iSPI for Performance. You can access performance data from Path Views that contain single or
multiple paths. See "Investigate Errors and Performance Issues" (on page 116)" for more information.

Related Topics:

Use Map Views (and accessing Quick View information)

"Path View Limitations" (on page 116)
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Path View Limitations

Path View cannot calculate accurate paths if you have two or more areas of your network which are sep-
arated by undiscovered devices. Your NNMi administrator must use the PathConnections.xml file to
specify areas of your network that are separated by undiscovered devices. See "Help for Administrators"
for more information.

Path View uses a variety of sources for information to calculate an accurate path. These sources of infor-
mation do, however, have limitations:

● SNMP ipRoute tables. If the Source or Destination node represents a device other than a router and
the device does not support SNMP or does not return valid ipRoute table information, NNMi depends
on traceroute to follow the path to find the nodes's access router.

Note: NNMi Advanced. NNMi can use RAMS data to determine router paths. When RAMS data is
used to determine the router paths, NNMi ignores the PathConnections.xml file. See
"Enhanced Path View (NNMi Advanced) " (on page 116) for more information.

● Open Shortest Path First protocol or Cisco Global Load Balancing protocol. Path View shows the
access router selected by one of these routing protocols. If two or more access routers communicate
with a device, only one access router is shown (usually the one with the shortest path).

● Cisco Express Forwarding protocol. This protocol bypasses some of the data that Path View needs. If
any routers in the path are using this protocol, Path View might display an incorrect router path.

Investigate Errors and Performance Issues

The color of the background shape of each map symbol conveys the most recent health status. Select an
object on the Path View map that has a status color other than green (see"Watch Status Colors" (on page
126) for more information about interpreting non-normal status colors). You can access the following
types of information about each node:

● "Access Node Details" (on page 127)

● "Access a Problem Device" (on page 127)

● "Access All Related Incidents" (on page 128)

See "Interpret Root Cause Incidents" (on page 168) for more information about interpreting the inci-
dent information displayed.

NNM iSPI for Performance. Click here for more information about additional tools for accessing per-
formance data.

To access performance data from a Path View map:

Select Actions→ Reporting - Path Health.

If the Path View map contains multiple possible paths from the Source to Destination Node, NNMi alerts
and guides you to select a single, unambiguous path for analysis before it can present a Path Health
Report. You can bypass this interaction by pre-selecting enough map objects (for example, connections)
to resolve any ambiguities before selecting Actions→ Reporting - Path Health.

Enhanced Path View (NNMi Advanced)

NNMi Advanced uses any of the following when calculating a Path View:

● Hot Standby Router Protocol (HSRP) nodes

● Virtual Router Redundancy Protocol (VRRP) nodes
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● HP Router Analytics Management System (RAMS) data

Note: When using RAMS data in Path View, NNMi ignores the PathConnections.xml file. See "Help for
Administrators" for more information.

When using NNMi Advanced, more than one path might appear if HP Router Analytics Management Sys-
tem (RAMS) determines more than one equal cost path and, therefore, cannot determine which path is in
use. Also see  RAMS Data and Path View below.

HSRP and VRRP and Path View

If NNMi Advanced is licensed and installed, by default, NNMi monitors state and priority information for
any discovered HSRP and VRRP objects in the network. NNMi Advanced can then include these virtual
HSRP and VRRP devices when calculating the Path View. The routers included are the Active or Master
router in the HSRP or VRRP Group.

RAMS Data and Path View

If your NNMi Administrator configured one or more RAMS, NNMi Advanced calculates the Path View
using RAMS data. (RAMS is an IP Route Analytics tool that listens to routing protocols and builds a real-
time routing topology map.)

RAMS enhances NNMi's ability to trace the route path between the source and destination node in the fol-
lowing ways:

● NNMi Advanced does not use SNMP to calculate the router path. This means that NNMi Advanced
does not need to wait for SNMP responses and can calculate the Path View more quickly.

● NNMi Advanced displays equal cost paths when calculating the router path.
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Monitoring Devices for Problems

NNMi offers several out-of-the-box views to assist you in monitoring your network. When using views, you
can choose to do either of the following:

● Monitor views that contain your critical nodes and interfaces.

● Watch an incident view for incidents with an abnormal status, such asWarning,Minor,Major, or Crit-
ical.

● Watch a map view for any icons that change color to yellow or red.

No matter which way you prefer, you can navigate from a map to a table view or from a table view to a
map.

Related Topics:

"Filter Views by Node or Interface Group" (on page 15)

"Monitor with Table Views" (on page 118)

"Monitor with Map Views" (on page 126)

Monitor with Table Views

NNMi provides the following out-of-the-box node and interface views to assist you in monitoring the net-
work for problems. These views help you quickly identify the nodes and interfaces that need your more
immediate attention:

"Critical Interfaces View" (on page 118)

"Critical Nodes View" (on page 119)

"Non-Normal Interfaces View" (on page 120)

"Non-Normal Nodes View" (on page 120)

"Not Responding Address View" (on page 122)

Critical Interfaces View

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Critical Interfaces view is provided so that you can view all of your interfaces whose status is Critical.

For each interface displayed in the view, you can identify the interface's status, administrative (AS) and
operational (OS) state, associated node Name value (Hosted On Node), the interface name, interface
type, interface speed, its description, the interface alias, the date the interface status was last modified, the
name of the Layer 2 connection associated with the interface, and any notes related to the interface.

By default, this view is sorted by the date the interface status was last modified (Status Last Modified).

See "Interfaces View (Inventory)" (on page 16) for more information about ways to use an interface view.

Related Topics

Use Table Views
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Critical Nodes View

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Critical Nodes view in the Monitoring workspace is useful for identifying all of the nodes whose status
is critical. Sorting the view by system location (the current value of the sysLocation MIB variable) might
help you identify whether the problem can be isolated to a particular area of your network. You can also
use this view to obtain the contact information for a problem node in case you need more background
information to troubleshoot the problem.

For each node displayed, you can identify its status, device category, name, hostname, management
address, system location, device profile, the date and time its status was last changed, and any notes
included for the node.

The device profile information determines how devices of this type are managed and the icon and back-
ground shape displayed on maps.

By default, this view is sorted by the date the node status was last modified (Status Last Modified).

Node views are useful for quickly identifying items described in the following table.

Use Description

View all device types being
managed

Sort the view by the Device Profile attribute.

Identify whether the problem
can be isolated to a particular
area of your network

Sort the view by System Location. This is the current value of the sys-
Location MIB variable.

View address and subnet infor-
mation associated with a
selected node to better deter-
mine the scope of the problem

From the Nodes view, open the Node form. Then access the Address
tab. See "Node Form" (on page 27) and "IP Subnet Form" (on page
112) for more information.

Access a map view of a
selected node and its sur-
rounding topology

Select the node of interest and use the Actions menu from the main
toolbar. See "Viewing Maps (Network Connectivity)" (on page 97) for
more information.

View the statuses of interfaces
associated with a node

If a node is not completely down, you might want to see which inter-
faces are down for the selected node. To do so, open the Node form
and select the Interfaces tab. See "Interface Form" (on page 58) for
more information about interface attributes.

View the number of devices
that are served by this node.

Select the node you want and access the Layer 2 or Layer 3 Neighbor
View using the Actions menu.

Uses for the Nodes Views

Critical Component View

Tip: See "Node Form" (on page 27) for more details about the attributes that appear in this view's column
headings.

The Critical Component view in the Monitoring workspace is useful for identifying all of the nodes whose
status is Critical due to a problem with a node component. Examples of node components include tem-
perature, fan, and memory.

For each component displayed, you can see its status, name, type, and the node on which it resides.
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Non-Normal Interfaces View

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Non-Normal Interfaces view in the Monitoring workspace is useful for identifying all of the network
interfaces that might need operator attention. Possible statuses for these interfaces include:

● Warning

● Major

● Minor

● Critical

Note: Interfaces displayed in this table all have the Administrative State equal to Up.

For each interface displayed in the view, you can identify its status, operational state, associated node
Name value (Hosted On Node), the interface name, type, speed, a description of the interface, the ifAlias
value, the date and time the status of the interface was last modified, the name of the Layer 2 connection
associated with the interface, and any notes included for the interface.

By default, this view is sorted by the date the interface status was last modified (Status Last Modified).

Interface views are useful for quickly identifying items described in the following table.

Use Description

View all network interfaces
per node

Sort the view by Hosted On. This can help you organize your interfaces
per node, so that you can identify the nodes that might need attention.

Determine the health of each
of the managed interfaces

Sort the view by the Status attribute.

To view only those interfaces whose status is Critical, use the Critical
Interfaces view provided by NNMi. See "Critical Interfaces View" (on
page 118) for more information.

Determine the types of inter-
faces that are being man-
aged.

Sort on the IfType (interface type) attribute.

Access a map view of the net-
work interface and its sur-
rounding topology.

Select the interface of interest and use the Actions menu to select
either the Layer 2 or Layer 3 Neighbor View. See Use Table Views for
more information.

Non-Normal Nodes View

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Non-Normal Nodes view in the Monitoring workspace is useful for identifying all of the nodes that
might need your attention. Possible statuses for these nodes include:

Warning

Minor

Major

Critical
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For each node displayed, you can identify its status, device category (for example, Switch), hostname,
management address, system location (the current value of the sysLocation MIB variable), device profile,
the date and time its status was last changed, and any notes included for the node.

The device profile information determines how devices of this type are managed and the icon and back-
ground shape displayed on maps.

By default, this view is sorted by the date the node status was last modified (Status Last Modified).

Node views are useful for quickly identifying items described in the following table.

Use Description

View all problem nodes Sort the view by Status so that you can be quickly alerted to
existing and potential problems.

You can also access the Critical Nodes view provided by
NNMi. See "Critical Nodes View" (on page 119) for more
information.

Identify whether the problem can be iso-
lated to a particular area of your network

Sort the view by System Location. This is the current value
of the sysLocation MIB variable.

View all device types being managed Sort the view by the Device Profile attribute.

View address and subnet information
associated with a selected node to better
determine the scope of the problem

From the Nodes view, open the Node form. Then access
the Address tab. See "Node Form" (on page 27) and "IP Sub-
net Form" (on page 112) for more information.

Access a map view of a selected node
and its surrounding topology

Select the node of interest and use the Actions menu from
the main toolbar. See Use Table Views for more infor-
mation.

View the statuses of interfaces associated
with a node

If a node is not completely down, you might want to see
which interfaces are down for the selected node. To do so,
open the Node form and select the Interfaces tab.

The number of devices that are served by

this node.

Select the node you want and access the Layer 2 or Layer 3

Neighbor View using the Actions menu.

Non-Normal Router Redundancy Group View (NNMi Advanced)

Tip: See the context-sensitive link for the "Router Redundancy Group Form (NNMi Advanced)" (on page
78) for more details about the Router Redundancy Group attributes that appear in this view's column head-
ings.

Your network administrator might have set up groups of redundant routers to help ensure that information
packets reach their intended destination. When monitoring your network, use the Non-Normal Router
Redundancy Group view to see those router groups whose status is other than Normal. This means there
is a problem with one or more interfaces or IP addresses on the routers in the router groups.

For each redundant routers group displayed in the view, you can identify the Router Redundancy Group
status, Router Redundancy Group name, the Router Redundancy Group protocol (for example, HSRP),
and the date the Router Redundancy Group status was last modified.

To see the incidents related to a Router RedundancyGroup:

1. Click the  Open icon that precedes the Router Redundancy Group of interest to open the form.

2. Select the Incidents tab.
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To view the members that belong to this group:

Click the  Open icon that precedes the Router Redundancy Group of interest to open the form.

On the Router Router RedundancyMembers tab, you should see a table view of the nodes and inter-
faces that belong to the selected Router Redundancy Group.

Related Topics

"Router Redundancy Group View (NNMi Advanced)" (on page 22)

"Router Redundancy Group Form (NNMi Advanced)" (on page 78)

"Router Redundancy Group View (NNMi Advanced)" (on page 22)

Not Responding Address View

Tip: See "IP Address Form" (on page 72) for more details about the node attributes that appear in this
view's column headings.

The Not Responding Address view in the Monitoring workspace is useful for identifying all of the
addresses whose state is Not Responding. A Not Responding state indicates that the address is not
responding to ICMP ping.

Note: Because all addresses in this view have a state of Not Responding, the State column is not dis-
played in this view.

For each address displayed in the view, you can identify the status, address, associated node Name value
(Hosted On Node), interface, the subnet prefix (In Subnet) and prefix length (PL), and any notes included
for the IP address.

Nodes by Status View

Tip: See "Node Form" (on page 27) for more details about the node attributes that appear in this view's col-
umn headings.

The Nodes by Status view in the Monitoring workspace lets you filter your view by the Status value. Exam-
ples of Status values include Normal,Warning,Minor,Major, and Critical.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

If your NNMi administrator set up Node Groups or Interface Groups to identify important elements of your
environment, you can filter this view to show only the nodes that need your immediate attention. For exam-
ple, by using the status and node group filters, you can display all nodes that have a Status value of Crit-
ical and are related to a certain group of nodes.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each node displayed, you can view its status, device category, name, hostname, management
address, system location (the current value of the sysLocation MIB variable), device profile, the date the
node's status was last modified, and any notes that exist for this node.

By default, this view is sorted by the date the node status was last modified (Status Last Modified).
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Interfaces by Status View

Tip: See "Interface Form" (on page 58) for more details about the node attributes that appear in this view's
column headings.

The Interface by Status view lets you filter your view by the Status value. Examples of Status values
include Normal,Warning,Minor,Major, and Critical.

You can use this view to help identify the status of the interfaces that you are monitoring. If your network
administrator has set up node or interface groups, by using the status and Node Group filters, you can dis-
play the status for only your important interfaces.

For each interface displayed, you can view the status, administrative state, the operational state, asso-
ciated node Name value for the computer on which the interface resides (Hosted On Node), the interface
name, type, speed, input speed, output speed, the date the status was last modified, an interface descrip-
tion, the ifAlias value, and any related notes.

By default, this view is sorted by the date the interface status was last modified (Status Last Modified).

Interfaces by Administrative State View

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

The Interface by Administrative State view lets you filter your view by the administrative state value.
Examples of Administrative State include Up, Down, and Testing.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

You can use this view to help identify the administrative state of your interfaces. If your network admin-
istrator has set up node or interface groups for those nodes or interfaces important to you, by using the
administrative state and Node Group filters, you can check the state set by your administrator for each of
the interfaces that is important to you. This might be useful for proactively monitoring your network and
checking for those interfaces whose state indicates there might be a potential problem.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each interface displayed, you can view its status, the operational state, associated node Name value
for the computer on which the interface resides (Hosted On Node), interface name, type, speed, input
speed, output speed, the date the status was last modified, a description of the interface, the ifAlias value,
and any notes that exist about the interface.

By default, this view is sorted by the date the interface status was last modified (Status Last Modified).

Interfaces by Operational State View

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.
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The Interface byOperational State view lets you filter your view by the operational state value. Examples
of Operational State include Up, Down, and Testing.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

You can use this view to help identify the operational state of your interfaces. If your network administrator
has set up node or interface groups for those nodes or interfaces important to you, by using the oper-
ational state and Node Group filters, you can check the operational state for each of the interfaces that is
important to you. This might be useful for proactively monitoring your network and checking for those inter-
faces whose state indicates there might be a potential problem.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each interface displayed, you can view its status, the administrative state, associated node Name
value of the computer on which the interface resides (Hosted On Node), the interface name, type, speed,
input speed, output speed, the date the status was last modified, a description of the interface, the ifAlias
value, and any notes that exist about the interface.

By default, this view is sorted by the date the interface status was last modified (Status Last Modified).

IP Addresses by State View

Tip: See "IP Address Form" (on page 72) for more details about the IP address attributes that appear in
this view's column headings.

The IP Addresses by State view in the Monitoring workspace lets you filter your view by the State value.
Examples of State include: Responding, Not Responding, and Not Polled.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

You can use this view to help identify the state of your IP addresses. If your network administrator has set
up node or interface groups for those nodes or interfaces important to you, by using the state and node or
interface group filters, you can check the state for only the important addresses.

Note: If you filter your view using additional filters, such as Node Groups, NNMi uses the AND operator to
combine the filters you have selected. See Filter a Table View for more information.

For each address displayed in the view, you can see its status, address, the name of the pertinent inter-
face, associated node Name value (Hosted On Node), the subnet in which the address is contained, the
subnet prefix length (PL), the date the status of the address was most recently modified, and any notes
included about the IP address.

Component by Status View

Tip: See "Node Form" (on page 27) for more details about the attributes that appear in this view's column
headings.
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Use the Component by Status view in the Monitoring workspace to help identify the status of node com-
ponents. Examples of node components include temperature, fan, and memory.

This view lets you filter your view by the Status value. Examples of Status include: Critical,Warning,
Major, Minor, and No Status.

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

If your network administrator has set up node or interface groups for those nodes or interfaces important
to you, by using the status and node or interface group filters, you can check the status for the components
for only the important nodes.

Note: If you filter your view using additional filters, such as Node Groups, NNMi uses the AND operator to
combine the filters you have selected. See Filter a Table View for more information.

For each component displayed, you can see its status, name, type, and the node on which it resides.

Interface Performance View (NNM iSPI for Performance)

NNM iSPI for Performance. Data appears in this view only if the NNM  iSPI for Performance is installed
and your NNMi administrator enables performance monitoring.

The interface performance view helps you identify the over and under utilized interfaces for the nodes in
your managed network. Sort this view my Hosted On Node to help you identify potential problem nodes
that are over utilized.

If your network administrator has set up node or interface groups for those nodes or interfaces important
to you, you can check the interface status for each interface that is important to you. This might be useful
for proactively monitoring your network and checking for those interfaces whose input or output utilization,
error, or discard rate indicate there might be a potential problem.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each interface displayed, you can view its input and output utilization rates, input and output error
rates, input and output discard rates, associated node Name value of the computer on which the interface
resides (Hosted On Node), the interface name, speed, input speed, output speed, and any notes that exist
about the interface.

Tip: See "Interface Form" (on page 58) for more details about the interface attributes that appear in this
view's column headings.

Node Groups View (Monitoring)

Tip: See the context-sensitive link for the Node Groups form for more details about the Node Group attrib-
utes that appear in this view's column headings.

When monitoring your network, you might be interested in only viewing information for a particular set of
nodes. Your network administrator is able to group sets of nodes into node groups. An example node
group could be all important Cisco routers, or all routers in a particular building. See About Node and Inter-
face Groups for more information about how your administrator sets up node groups. See Filter by Node
or Interface Group for more information about filtering views using node and interface groups.
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To find the definition for a particular Node Group filter, navigate to the Inventory workspace, and select the
Node Groups view.

For each node group displayed in the view, you can identify the node group status, name, whether the
node group appears in the filter list for node and interface views, whether the node group is available as a
filter in NNM  iSPI for Performance, and any notes about the node group.

Monitor with Map Views

NNMi provides three kinds of map views that show a graphical representation of a selected device and
the devices connected to it (Layer 2 Neighbor View, Layer 3 Neighbor View, and Path View).

Map views are useful for the following tasks:

● Identify important connector devices, such as a switch that might be a single connection to a main
office or campus.

● Identify how many devices are served by a node or interface.

● Identify routing issues.

● Identify network issues between two nodes.

Each node on the map is represented by a map symbol. Each map symbol has a background shape and
a foreground image. The background shape conveys two pieces of information:

● The type of device indicated by shape. See About Map Symbols.

● The most recent health status represented by the background color. See About Status Colors.

The foreground image assists in identifying the device model. NNMi uses first the Family, then Vendor,
and then the Category device profile information to determine the foreground image to be displayed. If
there is no image defined for any of these attributes, NNMi displays *no* icon in the map node.

Note: Your NNMi administrator is able to delete nodes and other objects from the NNMi database. If you
are viewing a node that has recently been deleted by another user, the node appears in your view

until your view is refreshed. To refresh a map view, click from the map view toolbar.

To monitor your network using a network map:

● "Watch Status Colors" (on page 126)

● "Determine Problem Scope" (on page 127)

● "Access Node Details" (on page 127)

Related Topics:

Use Map Views

"Display the Layer 2 Neighbor View" (on page 103)

"Display the Layer 3 Neighbor View" (on page 110)

"Path Between Two Nodes that Have IPv4 Addresses" (on page 113)

Watch Status Colors

When monitoring the network using a map view, watch for nodes whose status color is non-normal. The
background shapes of the map symbols change color based on the current health status of the rep-
resented device.

The following table describes the meaning for each status color that might appear on a map.
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Color Meaning Description

Unknown Indicates one of the following:

● The node was just added to the NNMi database, and health status is not yet cal-
culated.

● The node is unreachable and cannot be polled.

Normal Indicates there are no known problems related to the associated object.

Warning Indicates there may or may not be a problem related to the associated object.

Minor Indicates NNMi has detected problems related to the associated object that require
further investigation.

Major Indicates NNMi detected problems that could precede a critical situation.

Critical Indicates NNMi detected problems that require immediate attention.

Disabled Indicates the object is administratively "disabled". (The current value of MIB II ifAd-
minStatus is "disabled".)

No Status Indicates that NNMi monitoring configuration specifically excludes this device. The
Status is either not calculated or the device is Not Managed/Out Of Service.

Status Colors

Determine Problem Scope

Maps are a useful tool for determining the scope of a problem. Scan the map to determine the scope of
the problem. For example, look for large clusters of non-normal color icons to determine if there is a large
-scale outage.

If your naming scheme is based on node location, you might also be able to determine if the problem is
isolated to a particular site or store.

Access a Problem Device

Using NNMi's Actions menu you can access the following commonly used tools to investigate device
access and configuration information:

● Verify that the node can be reached by using ping, see "Test Node Access (Ping)" (on page 191).

● Launch telnet to access the device and determine more information, see "Establish Contact with a
Node (telnet)" (on page 193).

● Use traceroute to view traffic paths, see "Find the Route (traceroute)" (on page 192).

Note: Access to these commands depends on the NNMi role assigned to your user account. If you are
unable to access an action, contact your NNMi administrator.

Access Node Details

Select any node symbol on the map, and display all of the information related to that specified node. The
Node form is useful for troubleshooting purposes:

● List of the conclusions that led to the current status, and information about status calculations for the
node over time.
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● Status of each interface contained in the node. For example, if the node is not completely down, you
might want to see which interfaces are down.

● Status of each address associated with this node.

● System contact information.

● All of the incidents associated with the node.

NNMi also provides a Quick View that displays a small subset of information about a selected object.

To view all details associated with a map object:

1. In a map view, select the object.

2. Click the  Open icon in the menu bar.

3. The form displays, containing details of all information related to the object.

4. View or edit the details of the selected object.

To access the Quick View for a map object:

1. Using your mouse, hover over the object of interest.

The Quick View window displays, containing a read-only subset of details about the object.

2. To close the Quick View, move your mouse away from the object.

Related Topics:

"Node Form" (on page 27)

"Interface Form" (on page 58)

"IP Address Form" (on page 72)

Access All Related Incidents

If you are using a map view to monitor your network, there are times when you might want to switch to an
incident view for more information. Information available from an incident view includes the first time a
notification was received, the description of the problem (for example, Node Down or Address Not
Responding), and the incident category. The incident category helps to identify the type of problem, such
as fault, performance, or security.

To display all incidents related to an object on a map:

1. Click to select the node or interface of interest.

2. Click the  Open icon to open the form.

3. Select the Incidents tab.

4. The incidents table includes all incidents associated with the node or interface. Click the  Open
icon in the row representing the incident that you want to examine. See "Incident Form" (on page 132)
.

Related Topics:

Using Views to Display Data

Working with Objects
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Use Table Views
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Monitoring Incidents for Problems

Tip: See "Incident Form" (on page 132) for more details about the Incident attributes that appear in an inci-
dent's view column headings.

NNMi actively notifies you when an important event occurs. The event is reflected by a change of back-
ground color of a node in a network map and is reported through incident views.

Many services (background processes) within NNMi gather information and generate NNMi incidents. In
addition, an SNMP agent might send information to NNMi. For example, an SNMP agent detects that a
managed critical server is overheating and about to fail. The SNMP agent forwards a trap to NNMi.

Incidents might also be reporting on information that was requested by NNMi. For example, NNMi might
generate an "Address Not Responding" incident after using ICMP to check whether communication chan-
nels are open to a device (using ping).

For most incident views displayed, you can identify its overall severity (Normal,Warning,Minor,Major,
Critical, and Unknown), lifecycle state, source node, source object, and its message.

Note: Some incidents may have a value of <none> for the source object or source node. This happens
when the source node or object cannot be resolved. For example, an incident that is being for-
warded from an NNM  6.x or 7.x management station has a source node value of <none>. An
SNMP trap whose source is not monitored can be displayed as <none>.

The following table describes the severity icons used by NNMi.

Icon Meaning Icon Meaning Icon Meaning Icon Meaning

Normal Minor Critical Disabled

Warning Major Unknown No Status

Incident Severity Icons

Note: NNMi provides management mode attributes that determine whether a node, interface, or address
is discovered and monitored. Your administrator is able to set some of these management mode
attribute values. Any object whose management mode is set so that it is no longer discovered and
monitored might still have incidents associated with it that existed before the object was no longer
managed. To check whether a node associated with an incident is being managed, open the form

for the incident and then open the form for the source node associated with the incident. See Work-
ing with Objects for more information.

Incident views are useful for quickly identifying items described in the following table.

Use Description

Identify
potential or
current
problems

Within a view, each incident has a corresponding icon that indicates its severity so that you
are immediately notified of potential or current problems.

You can filter incidents so that you only view incidents whose severity is Critical or you can
choose to filter incidents to view all incidents whose severity is greater than Normal.

Identify
problem
nodes

You can sort incidents by node to help you quickly identify the problem nodes.

Incident View Uses
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Determine
the cause
of the prob-
lem

You can sort an incident view by description so that you are able to see all incidents report-
ing a node or interface that is disabled or otherwise unavailable.

You can also use the child incidents attribute to view all of the incidents that are a result of
the root cause problem reported.

Determine
historical
information

You can sort your incidents by notification date to determine whether a group of nodes
went down within a specified time frame.

You can also filter your list of incidents according to notification date to view only those
incidents received within the last hour.

To track historical information for a specific node, sort your incidents by First Occurrence.
Then, filter your view by node Name. This lets you view a chronological list of the kinds of
errors (indicated by Origin) that have occurred for the current node.

You can then open the Incident form to use the child incidents attribute to view all of the
incidents that are a result of the root cause problem reported.

Identify
only the
incidents
important
to you

You can filter an incident view so that you see only those incidents of interest. For exam-
ple, you might filter incidents so that you only view incidents whose status is Critical or
only those incidents assigned to you. You can also view only those incident associated
with a Node Group. Your NNMi administrator creates node groups. For example, your
NNMi administrator might choose to group all of your important Cisco routers into a node
group. See Node/ Interface Group Filters for more information.

Your NNMi administrator can define the format of incident messages so they are most useful to you and
your team.

Your team can use the Notes attribute of the incident views to notify everyone else about which issues are
being covered.

Tasks Performed from an Incident View

You can perform the following tasks from an incident view:

"Organize Your Incidents" (on page 131)

"Own an Incident" (on page 142)

"Assign an Incident" (on page 143)

"Unassign an Incident" (on page 143)

"Keep Your Incidents Up to Date" (on page 144)

"Track an Incident's Progress" (on page 145)

"Display a Map from an Incident" (on page 146)

Related Topics:

"Incident Views Provided by NNMi" (on page 147)

Organize Your Incidents

You can organize your incidents in one of three ways:

1. Sort them according to the column of interest. For example, you might want to sort your incidents by
status.
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2. Filter them according to the values for a particular column or attribute. For example, filtering by status
lets you filter out the status values that are not of interest to you. Filtering by the Assigned To attribute
lets you view only the incidents assigned to you.

3. Filter them according to a Node Group. Your network administrator is able to group sets of nodes into
Node Groups. An example Node Group could be all important Cisco routers, or all routers in a par-
ticular building. See Node/Interface Group Filters for more information about filtering a view by Node
Group.

Note: See the help topic for each incident view for more details about how you might want to sort or filter a
specific incident view.

For information about sorting and filtering, see Use Table Views.

Incident Form

The Incident form provides details for troubleshooting purposes. From this form you can access more
details about the node involved, and the Source Object attribute provides more information about the inter-
face, IP Address, connection, or SNMP Agent that is contributing to the problem.

If your role allows, you can use this form to update the priority and state of the incident, assign a team
member to investigate the problem, or add notes to communicate solutions or workaround information.

For information about each tab:

Attribute Description

Message A description of the problem that you want NNMi to display.

Severity Seriousness that NNMi calculates for the incident. Possible values are:

  Normal

 Warning

  Minor

  Major

  Critical

See About Status Colors for more information about severity values.

Note: The icons are displayed only in table views.

Basic Attributes
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Attribute Description

Priority Used to communicate the urgency of resolving the selected incident. You control this value.
NNMi sets this value to null by default. The lower the number the higher the priority. Possible
values are:

  None

  Low

  Medium

  High

  Top

Note: The icons are displayed only in table views.

Lifecycle
State

Identifies where the incident is in the incident lifecycle. You control this value.

Registered – Indicates that an incident arrived in the queue and is stored in the data-
base.

In Progress – State selected to indicate the incident is being addressed.

Completed – State selected to indicate completion of the incident investigation, and
implementation of a solution.

Closed – Indicates that NNMi confirmed that the problem reported by this Incident is no
longer a problem. For example, when you remove an interface from a device, all incidents
related to the interface are automatically Closed.

See "About the Incident Lifecycle" (on page 144) for more information about Lifecycle State.

Note: The icons are displayed only in table views.

Source
Node

Name assigned to the node associated with the incident. Click the  Lookup icon and

select  Quick View or  Open to display more information about the node. See "Node
Form" (on page 27) for more information.

Note: If NNMi is unable to resolve the node, the source node value is <none>. For example,

an incident that NNMi receives from a 6.x or 7.x management station, does not have a
source node value.

Source
Object

Name used to indicate the configuration item that is malfunctioning on the source node.

Click the  Lookup icon and select  Quick View or  Open to display more information
about the interface, IP address, connection, or SNMP agent.

Note: All incidents forwarded to NNMi by a 6.x or 7.x NNM management station have a
Source Object value of none.

Assigned
To

Name of the user to which this incident is assigned. This value must be a valid user account
name (determined by the NNMi administrator). See "Manage Incident Assignments" (on
page 142) for more information.
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Attribute Description

Notes Provided for communication among your team (for example, explanations or workarounds).
Information might include reasons why the status was changed, what has been done to trou-
bleshoot the problem, or who worked on resolving the incident.

Type a maximum of 255 characters. Alpha-numeric, punctuation, spaces, and underline
characters are allowed.

Note: You can sort your incident table views based on this value. Therefore, you might want
to include keywords for this attribute value.

Incident Form: General Tab

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Name Name of the rule used to configure the incident. This name is initially created by NNMi.

Category Generated by NNMi to indicate the problem category. Possible values include:

Accounting -  Used to indicate problems related to usage statistics and allocation of
costs associated with the billing of time and services provided by devices. This cat-
egory is not used by NNMi with default configurations, but it is available for incidents
you define.

Application Status - Indicates there is a problem with the health of the NNMi software.
Examples of these kinds of events include license expiration or that a certain NNMi
process lost connection to the Process Status Manager.

Configuration Indicates there is a problem with the configuration of a managed
device; for example there is a physical address mismatch

Fault – Indicates a problem with the network, for example Node Down

Performance – Indicates a threshold has been exceeded; for example a utility has
exceeded 90 percent

Security –  Indicates there is a problem related to authentication; for example an
SNMP authentication failure

Status - Often indicates some status change has occurred on a device. For example,
when a Cisco device is powered up or powered down.

Note: The icons are displayed only in table views.

General Attributes
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Attribute Description

Origin
Occurrence
Time

The time at which an event occurred that caused the incident to be created.; for example,
the time held in the trap.
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Attribute Description

Origin Identifies how the incident was generated. Possible values are:

Management Software – Indicates the incident was generated by NNMi processes

Manually Created – Indicates the incident was created from the user interface.

  Remotely Generated – Indicates the incident was forwarded from an NNM  6.x or 7.x
management station

  SNMP Trap – Indicates the incident was forwarded from an SNMP Agent

Syslog – Indicates the information was gathered from a syslog Agent. This Origin is
not used by NNMi.

Note: The icons are displayed only in table views.

Correlation
Nature

This incident's contribution to a root-cause calculation, if any. Possible values are:

Root Cause – Indicates the incident is a root cause of the reported problem. For exam-
ple, node down is a root cause problem.

  Secondary Root Cause – Indicates the incident is related to root cause, but is not the
primary problem. Secondary root cause incidents often begin as primary root cause
incidents. For example, when an interface goes down, it becomes a primary root cause
incident. If a connection associated with the interface goes down, the connection down
becomes the root cause, and the interface down becomes a Secondary Root Cause.

  Symptom – Indicates any incidents that were generated from a trap notification
related to the root cause incident. For example, a Link Down incident generated from a
Link Down trap notification might appear as a Symptom to an Interface Down incident
in the root cause incidents view.

Stream Correlation – Stream correlations are created as NNMi analyzes events and
traps to determine the root cause incident for a problem. Examples of stream cor-
relations include Dedup (duplication of events) Rate (occurrence of events by time),

and Pairwise (occurrence of events using incident pairs) correlations.

Service Impact - Indicates a relationship between incidents in which a network service
is effected by other incidents. For example, an Interface Down incident can effect a
Router Redundancy Group that is part of an HSRP service. This Correlation Nature is
available for use by NNM iSPIs (HP Smart Plug-ins). See "Help for Administrators" for
more information about HP Smart Plug-ins.

Note: The icons are displayed only in table views.
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Attribute Description

Duplicate
Count

Lists the number of duplicate incidents that NNMi encountered for the selected incident.
This number is incremented only in the associated deduplication incident that is generated
by NNMi. Deduplication incidents are generated by NNMi to inform the operator of inci-
dents needing attention because they are reoccurring according to the deduplication crite-
ria specified in the incident's deduplication configuration.

For example, incidents generated from SNMP traps will not have their deduplication count
incremented. If the deduplication criteria was configured for the SNMP trap, NNMi gen-
erates a deduplication incident specifying that the SNMP trap is reoccurring according to
the deduplication criteria specified in the incident's associated deduplication configuration.
This incident is the one that increments and displays the Duplicate Count value.

Note the following:

● By default, NNMi updates the Duplicate Count every 30 seconds. This interval cannot
be changed.

● NNMi continues to update the duplicate count regardless of an incident's lifecycle
state. For example, if an incident's Lifecycle State is set to Closed, the duplicate
count continues to be incremented. See "About the Incident Lifecycle" (on page 144)
for more information. This behavior helps you identify situations in which the incident
is not yet fixed. Take note if the Duplicate Count is incremented after a lengthy time
period has elapsed; this might indicate there is a new problem with the node, inter-
face, or address.

● Duplicates are configured by the NNMi administrator using the Incident Con-
figuration form available from the Configuration workspace.

RCA Active Used by NNMi to identify whether NNMi considers the incident to be active or inactive. If
set to True, the incident is considered to be active. If set to False, the incident is con-
sidered to be inactive.

NNMi considers an incident to be active when the root cause analysis (RCA) engine is
actively evaluating the problem reported by this incident.

NNMi considers an incident to be inactive when NNMi confirmed that the problem
reported by this incident is no longer a problem. For example, the device is now func-

tioning properly.

NNMi initially sets an incident's RCAActive attribute to True and the Lifecycle State to
Registered. When NNMi sets the RCAActive attribute to False, it also sets the incident's
Lifecycle State to Closed.

Examples of when an incident's RCAActive attribute is set to False include:

● When an interface goes up, NNMi closes the InterfaceDown incident.

● When a node goes up, NNMi closes the NodeDown incident.

Correlation
Notes

Stores notes about the correlation status of the incident. NNMi provides information in the
Correlation Notes field when it sets an incident's Lifecycle State to Closed. This infor-
mation includes the reason the incident was closed; for example, an Interface Up might
cancel an Interface Down incident and subsequently close the Interface Down incident.
For this example, Interface Up would be included in the Correlation Notes field as a rea-
son for why the incident was closed. As another example, if a LinkUp was configured to
cancel a LinkDown incident,  the message generated by NNMi would be: Incident
autoclosed by Event System Pairwise Correlation: CiscoLinkDown, Cis-

coLinkUp.
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Attribute Description

First Occur-
rence Time

Used when suppressing duplicate incidents. Indicates the first notification for a set of dupli-
cate incidents.

Last Occur-
rence Time

Used when suppressing duplicate incidents. Indicates the timestamp of the latest noti-
fication for a set of duplicate incidents.

If there are no duplicate incidents, this date is the same as the First Occurrence Time.

Origin
Occurrence
Time

The time at which an event occurred that caused the incident to be created.; for example,
the time held in the trap.

Incident Form: Correlated Parents Tab

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Correlated
Parents

If the current incident is a child incident, any correlated parent incidents of the child appears
in this table view. For example, parent incidents are created when a root cause problem is
detected. A Node Down root cause incident is a parent of an Interface Down incident. There-
fore, on an Interface Down Incident form, a Node Down incident might appear under the
Correlated Parents tab.

Click the Open icon to view more information about a specific incident.

Correlated Parents Table

Incident Form: Correlated Children Tab

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

For information about each tab:

Attribute Description

Correlated
Children

If the current incident is a parent incident, any correlated child incident of the parent
appears in this table view. For example, an Interface Down incident would be correlated as
a child under a Node Down root cause incident. Therefore, on a Node Down incident form,
an Interface Down incident would appear on the Correlated Children tab.

Click the Open icon to view more information about a specific incident.

Correlated Children Table

Incident Form: Custom Attributes Tab

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

For information about each tab:
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Attribute Description

Custom
Incident
Attributes

Used by NNMi to add additional information to the incident that NNMi makes available for
viewing. Each CIA includes a name, type, and value group that can be populated differently
for different types of incidents. Varbind values that accompany SNMP traps are a common
use for this attribute.

Click the Open icon to open the "Custom Incident Attribute Form" (on page 139) and view
more information about a specific attribute.

Custom Attributes Table

Custom Incident Attribute Form

The Custom Incident Attributes (CIAs) form provides extended information that NNMi gathered about the
incident. For example, if the incident is reporting an SNMP trap, the Varbind values are stored as CIAs.
Each CIA includes a name, type, and value group that can be populated differently for different types of
incidents.

To view custom incident attribute information:

1. Navigate to the Incident form.

a. From the workspace navigation panel, select the Incidents workspace.

b. Select the incident view that contains the incident of interest; for example, Root Cause Inci-
dents.

c. To open the Incident form, click the  Open icon that precedes the incident whose information
you want to view.

2. In the Incident form, select the Custom Attributes tab.

3. Click the  Open icon that precedes the custom incident attribute row of interest.

See the table below for an explanation of the Name, Type, and Value attributes displayed.

Note: All varbind values are stored as CIAs in NNMi.

Attribute Description

Name Name used to identify the CIA.

For SNMP traps and events forwarded from NNM 6.x or 7.x management stations, the name
is the object identifier (oid) of the forwarded trap or event.

Note: If different varbinds have the same oid, NNMi appends a number to the original oid; for
example: 1.2.3.4.5.6.2.7.1_1 and 1.2.3.4.5.6.2.7.1_2

Type Describes the type of data that is stored for the CIA. Examples of types include:

Double - Used to describe real numbers; for example 12.3

Integer - Used for integer numeric values; for example 1, 2, or 3

String - Used for character values

Boolean - Used to store true or false values

Note: All SNMP trap and NNM 6.x or 7.x management station events types begin with asn. If
the CIA represents a varbind value, you may view additional types, such as Counter.

Custom Incident Attributes
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Attribute Description

Value For SNMP traps and events forwarded from an NNM 6.x or 7.x management station, the CIA
value is the varbind value in the forwarded event or trap. For management events that are
generated from NNMi, this value is the CIA value in the incident that was provided by NNMi.

Incident Form: Diagnostics Tab (NNM iSPI NET)

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

When you access the Incident Form: Diagnostics Tab, you can view the history of all the NNM iSPI NET
Diagnostic reports that have been run for the incident's Source Node. Diagnostics are sets of automated
commands specific to one or more device types, including Cisco routers and switches, Cisco
switch/routers, and Nortel switches.

To generate a new instance of these Diagnostics reports, click Actions→ Run Diagnostics.

For information about each tab:

Attribute Description

Start Time Date and time NNM iSPI NET created this instance of the Diagnostics report. NNM iSPI NET
uses the locale of the client and the date and time from the NNMi management server.

Definition The name of the NNM iSPI NET Diagnostics report definition.

Status The current status of this NNM iSPI NET Diagnostics report, such as Running or Complete.

Report Click this link to open the actual report.

Note: You might be prompted to provide a user name and password to access the Oper-
ations Orchestration software. See the iSPI NET Planning and Installation Guide for
more information.

Lifecycle

State

The Diagnostic runs if the incident is currently set to this Lifecycle State.

Last

Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report. NNM iSPI

NET uses the locale of the client and the date and time from the NNMi management server.

Diagnostics Table

Incident Diagnostic Results Form (Flow Run Result) (NNM iSPI NET)

NNM iSPI NET automatically prepares diagnostic reports when certain incidents are generated and when
using Actions→ Run Diagnostics. This form shows details about the currently selected diagnostic report
instance.

Note: Because the values on this form are generated by NNM iSPI NET, these attribute values cannot be
modified.

See "Incident Form: Diagnostics Tab (NNM iSPI NET)" (on page 140) for more information:
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Attribute Description

Start
Time

The time that NNM iSPI NET created the selected diagnostic report instance.

Definition The name of the flow as defined in NNM iSPI NET.

Status The current status of this NNM iSPI NET Diagnostics report. Possible values include:

New - The Diagnostic is in the queue, but is not yet running

In Progress -The Diagnostic has been submitted and is not finished running

Completed - The Diagnostic has finished running

Not Submitted - An error condition prevented the Diagnostic from being submitted

Timed Out - NNMi was unable to submit or run the Diagnostic due to a time out error. The
time out limit for submitting a Diagnostic is one hour. The time out limit for running a
Diagnostic is four hours.

Example error conditions include the following:

● The number of Diagnostics in the queue might prevent NNMI from submitting the Diag-
nostic.

● A configuration error, such as an incorrect user name or password, might prevent NNMi
from accessing the required Operations Orchestration server.

Contact your NNMi administrator for Diagnostic log file information.

Report NNM iSPI NET uses this text string to display the selected instance of the diagnostics report
in a browser window.

Lifecycle
State

The Diagnostic runs if the incident is currently set to this Lifecycle State.

Possible values include:

● Registered

● In Progress

● Completed

● Closed

See About the Incident Lifecycle for more information about Lifecycle State.

When the Incident is set to this Lifecycle State, the selected Diagnostics (Flow Definitions) is
automatically run on each applicable Source Node in the specified Node Group.

Last
Update
Time

Date and time NNM iSPI NET last updated this instance of the Diagnostics report. NNM iSPI
NET uses the locale of the client and the date and time from the NNMi management server.

 Diagnostic Results Details

Incident Form: Registration Tab

The "Incident Form" (on page 132) provides details for troubleshooting purposes.

For information about each tab:
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Attribute Description

Created Date and time the selected object instance was created. NNM uses the locale of the client
and the date and time from the NNMi management server.

Last
Modified

Date the selected object instance was last modified. NNM uses the locale of the client and
the date and time from the NNMi management server.

Registration

Manage Incident Assignments

One of the first things to do with an incident is to assign it to yourself or to another operator. The following
table displays the ways you can assign or un-assign an incident and the NNMi user role that is required for
each.

Task How

Required Mini-

mum NNMi User
Role

Own an incident Select an incident and use Actions→ Own Incident. See "Own
an Incident" (on page 142) for more information.

Level 1 Operator

Assign an inci-
dent to someone
else

Use the Incidents form and select a user in the Assigned To
field. See "Assign an Incident" (on page 143) for more infor-
mation.

Level 2 Operator

Un-assign an inci-
dent

Select an incident and use Actions→ Unassign Incident. See
"Unassign an Incident" (on page 143) for more information.

Level 1 Operator

Tasks Related to Assigning Incidents

Own an Incident

NNMi lets you own an incident. When you specify that you want to own an incident, the incident is

assigned to you.

To own an incident:

1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incidents workspace.

b. Select the incident view of interest; for example Unassigned Open Key Incidents.

2. Click the   selection box that precedes the incident you want to own.

3. Select Actions→ Own Incident.

Your user account name then appears in the Assigned To column of the incident view.

Note: If you are using the Unassigned Open Key Incidents view, the incident is deleted from the view
because it is no longer unassigned. Open the MyOpen Incidents view to verify that the incident
was successfully assigned to you.

As an operator you are able to view incidents assigned to yourself and to others. If you want to view only
those views assigned to or owned by you, use the MyOpen Incidents view. See "My Open Incidents View"
(on page 148) for more information.
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Assign an Incident

If you are an NNMi user with a Level 2 Operator role, you can assign an incident to yourself or to another
operator. If it is already assigned to another operator, you can unassign it or assign it to another operator.

To assign an incident:

1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incidents workspace.

b. Select the incident view of interest; for example Unassigned Open Key Incidents.

2. Click the Open icon that precedes the incident you want to own.

3. In the Assigned To lookup field, do one of the following:

■ Type in the valid account user name to which you want to assign the incident.

Note: Using the auto completion feature, NNMi should complete entering the account user name
for you after you enter a few characters.

■ Click the  Lookup icon and select  Quick Find to display a list of valid user account
names. Then, select the account name you want to use.

4. From the main menu, click Save to save your changes or  Save and Close to save your
changes and exit the form..

The user account name you entered or selected then appears in the Assigned To column of the current
incident view for the selected incident.

Note: If you are using the Unassigned Open Key Incidents view, the incident is deleted from the view
because it is no longer unassigned.

Unassign an Incident

If you are an NNMi user with a user role of Level 1 Operator, you are able to unassign an incident for your-
self or for another user. You can unassign an incident in one of two ways:

● Using Actions→ Unassign Incident.

● Using the Assigned To lookup field

To unassign an incident using the Actions menu:

1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incidents workspace.

b. Select the incident view of interest; for example Unassigned Open Key Incidents.

2. Click the  selection box that precedes the incident you want to own.

3. Select Actions→ Unassign Incident.

To unassign an incident using the Assigned To lookup field:

1. Navigate to the incident view of interest.

a. From the workspace navigation panel, select the Incidents workspace.

b. Select the incident view of interest; for example MyOpen Incidents.

2. Click the Open icon that precedes the incident you want to unassign.

3. Navigate to the Assigned To attribute. Click the  Lookup icon and select Quick Find.

4. Click the  Make Empty icon.
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5. From the main menu, click Save to save your changes or Save and Close to save your
changes and exit the form.

The user account name should no longer appear in the Assigned To column of the incident view.

Note: The incident should appear in the Unassigned Open Key Incidents view.

Keep Your Incidents Up to Date

NNMi provides the Notes attribute to help you keep your incident information up-to-date. Use the Notes
field to explain steps that were taken to date to troubleshoot the problem, workarounds, solutions, and own-
ership information.

To update an incident:

1. If you do not have an incident open, from the Workspace navigation panel, select the incident view
you want to open; for example Open Key Incidents.

2. From the incident view, open the incident you want to update.

3. Type the annotations that you want to be displayed within the Notes field. Type a maximum of 255
characters. Alpha-numeric, punctuation, spaces, and underline characters are allowed.

4. If you need more space to type in your information, click the Notes label, and type the information
into the window that appears.

Note: NNMi might add information to the Correlation Notes field to explain why an incident Lifecycle
State was changed to Closed.

5. From the main menu, click Save to save your changes or Save and Close to save your
changes and exit the form.

You also want to keep your incident lifecycle information up-to-date. See "Track an Incident's Progress"
(on page 145) for more information.

About the Incident Lifecycle

NNMi provides the Lifecycle State attribute to help you track an incident's progress. See "Track an Inci-
dent's Progress" (on page 145) for more information about possible lifecycle states.

In some cases, NNMi updates an incident's Lifecycle State for you. For example, NNMi initially sets an inci-
dent's Lifecycle State to Registered. It also sets an incident's Lifecycle State to Closed. NNMi considers
an incident to be Closed when NNMi has confirmed that the problem reported by this incident is no longer
a problem. For example, the device is now functioning properly. Examples of when NNMi sets an incident
Lifecycle State to Closed include:

● When an interface goes up, NNMi closes the Interface Down incident.

● When a node goes up, NNMi closes the Node Down incident.

When it sets an incident's Lifecycle State to Closed, NNMi adds information to the Correlation Notes field
to explain why the incident was closed. In such cases, NNMi inserts the information in front of any existing
information provided. For example, Interface Up would be included in the Correlation Notes field as a rea-
son for why an Interface Down incident was closed.

Another way to help you identify those incidents closed by NNMi is by looking at the RCA Active attribute
value. When NNMi considers an incident to be Closed, it sets the RCA Active attribute value to False. This
means NNMi's root cause analysis (RCA) engine is no longer actively evaluating the problem reported by
this incident.

Page 144 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Monitoring Incidents for Problems

Note: NNMi continues to update the duplicate count regardless of an incident's Lifecycle State. For exam-
ple, if an incident's Lifecycle State is set to Closed, the Duplicate Count continues to be incre-
mented. This behavior helps you identify situations in which the incident is not yet fixed. Take note
if the Duplicate Count is incremented after a lengthy time period has elapsed; this might indicate
there is a new problem with the node, interface, or address.

After closing a primary root cause incident, any incidents that are correlated and marked as secondary
root cause become primary root cause.

Track an Incident's Progress

NNMi provides the Lifecycle State attribute to help you track an incident's progress. The table below
describes each lifecycle category and possible values. Your network administrator might have additional
or different guidelines for their use.

Lifecycle
State Description

Registered Indicates that an incident has arrived in the queue and has been stored in the database.

In Prog-
ress

State selected by a user to indicate the incident is being addressed.

Completed State selected by the user to indicate the incident investigation is complete and a solution
has been implemented.

Closed Indicates that NNMi confirmed that the problem reported by this incident is no longer a
problem. For example, when you remove an interface from a device all incidents related to
the interface are automatically Closed.

Incident Lifecycle States

You should know your guidelines for lifecycle states so that you can keep your incidents updated accord-
ingly.

To update your lifecycle state, use the Actions menu or a form.

To update your lifecycle state using the Actions menu from a view:

1. If you do not have an incident open, from the workspace navigation panel, select the incident view
you want to open.

2. From the incident view, click the   selection box that precedes the incident whose lifecycle state you
want to change.

3. From the main menu toolbar, select Actions and then the lifecycle state you want, for example, In
Progress.

To update your lifecycle state from a form:

1. If you do not have an incident open, from the workspace navigation panel, select the incident view
you want to open.

2. From the incident view, open the incident you want to update.
Under the Basics pane, select the lifecycle state you want from the drop-down menu.

From the main menu, click Save to save your changes or Save and Close to save your changes
and exit the form.

From the form menu, select Actions and then the lifecycle state you want. For example, select Com-
pleted.

The action takes effect immediately. This means you do not have to select Save.

Page 145 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Monitoring Incidents for Problems

After performing an action on a form that modifies the object being viewed, you must refresh the form
before you can save any additional changes.

Display a Map from an Incident

If you are using incident views to monitor your network, there are times when you might want to switch to a
map view to determine more information. For example, you might want to view the connectivity for a
selected node.

To display a map from an incident:

1. Select the incident of interest by checking the   selection box that precedes the object information.

2. Select Actions→ Node Group Map in the main toolbar.

3.Note the following: 

■ This action displays the lowest level Node Group map to which the Source Node belongs. For
example, if the node belongs to a Child Node Group, the Child Node Group displays.

■ If the Source Node is a member of more than one Node Group at the lowest level, NNMi prompts
you to select the Node Group map you want to display.

■ If you select Node Group Map and the Source Node is not a member of a Node Group, NNMi
informs you that no Node Group map is available.

The map launches based on the source node of the selected incident.

Note: If the incident is associated with an Island Node Group, NNMi displays the associated
Island Node Group map. See "Island Node Group Map" (on page 146) for more infor-
mation.

Note: The current values of the management mode attributes determine whether NNMi discovers and
monitors a node, interface, or address. Your NNMiadministrator sets some of these management
mode attribute values. Map symbols with the color set to No Status are not currently being mon-
itored.

Related Topics:

Use Map Views

"Display the Layer 2 Neighbor View" (on page 103)

"Display the Layer 3 Neighbor View" (on page 110)

"Path Between Two Nodes that Have IPv4 Addresses" (on page 113)

"Node Group Overview Map" (on page 100)

"Routers Map" (on page 102)

"Switches Map" (on page 102)

"Networking Infrastructure Devices Map" (on page 101)

Island Node Group Map

An Island Node Group is a group of connected nodes that NNMi discovers and that are not connected to
the rest of the topology. An example of an environment with multiple Island Node Groups is a financial
institution or retail store with many branches or stores. Each branch or store might be connected to other
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branches or stores with a WAN (Wide Area Network) connection. Each branch or store appears as an iso-
lated island of nodes in the NNMi topology.

The Island Node Group map contains the Island Node Group that is the Source Object for the selected inci-
dent.

Note: Incidents whose Source Object is an Island Node Group include Remote site in the incident mes-
sage.

To display an Island Node Groups Map from an incident:

1. Select an incident view from the Incident Management or Incident Browsing workspace.

2. Check the selection box ( ) that precedes the Island Node Group incident whose map you want to
display.

3. Select Actions→ Node Group Map.

Related Topics

Node Group Map Objects

Incident Views Provided by NNMi

You and your team can easily monitor the posted incidents and take appropriate action to preserve the
health of your network. To assist you, NNMi provides the following out-of-the-box views for listing incident
information:

● "My Open Incidents View" (on page 148)

● "Open Key Incidents View" (on page 149)

● "Unassigned Open Key Incidents View" (on page 151)

● "Open Key Incidents by Severity View" (on page 151)

● "Open Key Incidents by Priority View" (on page 152)

● "Open Key Incidents by Category View" (on page 154)

● "Open Key Incidents by Family View" (on page 155)

● "Closed Key Incidents View" (on page 156)

● "Key Incidents by Lifecycle State View" (on page 157)

● "Root Cause Incidents View" (on page 159)

● "Stream Correlation Incidents View" (on page 160)

● "Custom Incidents View" (on page 161)

● "NNM 6.x/7.x Events View " (on page 162)

● "NNM  6.x/7.x Events by Category View" (on page 162)

● "SNMP Traps View" (on page 162)

● "SNMP Traps by Family View" (on page 163)

The most useful view for proactively monitoring your network for problems are the Key Incident views.
These views include root cause incidents generated for the devices being managed by NNMi, along with
their associated symptoms.

NNMi's Causal Engine uses ICMP and SNMP to constantly monitor your network. The Causal Engine uses
the data collected from all the devices on your network to determine the root cause of known and potential
problems.
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Note: The Custom Incidents view lets you use sorting and filtering to customize additional views while
maintaining the out-of-the-box views provided by NNMi. This view includes most of the attributes
available for the incident so that you can decide which are most important for you to display. See
Use Table Views for more information about sorting, filtering, and hiding attributes within a view.

For each incident generated, you can view the Correlated Parents and Correlated Children tab infor-
mation to assist you in understanding how the problem was detected.

NNMi also enables you to access the following 6.x/7.x features by selecting only incidents generated from
6.x/7.x events: (See for more information.) You cannot access these features for any non-6.x/7.x incidents.

● Actions → NNM  6.x/7.x Neighbor View

● Actions → NNM  6.x/7.x Details

● Actions → NNM  6.x/7.x ovw

Other useful tasks from the incident view, include the following:

● "Display a Map from an Incident" (on page 146)

● "Node Form" (on page 27)

Related Topics:

Accessing Groups of Views (Workspaces)

About the NNMi Console

My Open Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The MyOpen Incidents view displays all of the open incidents that have been assigned to you. This view
is useful for identifying the incidents for which you are responsible. It displays all incidents assigned to
you whose lifecycle state is Registered, In Progress, or Completed. As with all incident views, you can
filter this view by time period. The default time period is Last Week so that you can view all of the open
incidents assigned to you that have occurred within the last week.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Completed), the date and time the incident last occurred, the name of its source node, its source
object, its category (for example, Fault or Security), its family (for example, Interface or Connection), its
origin (for example, Management Software or SNMP Trap), its Correlation Nature (for example, Symptom
or Root Cause), the message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Key Incident Views

Tip: See "IP Address Form" (on page 72)"Incident Form" (on page 132) for more details about the incident
attributes that appear in a root cause incident view's column headings.

The Key Incident views are useful for identifying incidents that are most important to the network Operator
and that often require more immediate action. The Key Incidents views includes those incidents whose
Correlation Nature is any of the following: 
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Incident
Correlation
Nature Description

None Indicates there is no incident correlation for this incident. For example, a Correlation
Nature of None is used for license violations.

Root Cause Indicates the incident that reports the root cause of a problem.

Service
Impact

Indicates a relationship between incidents in which a network service is effected by other
incidents. By default, NNMi generates Service Impact incidents for Router Redundancy
Groups. For example, an Interface Down incident can effect a Router Redundancy Group
that is part of an HSRP service. The Service Impact incident helps to identify the service
that is affected.

This Correlation Nature is available for use by NNM iSPIs (HP Smart Plug-ins). See "Help
for Administrators" for more information about HP Smart Plug-ins.

Some Key Incident views are filtered according to lifecycle state values, which can be set by the user.  For

example, the Open Key Incidents view displays the Key Incidents whose lifecycle state value is Reg-
istered, In Progress, or Completed. The Closed Key Incidents view displays only the Key Incidents
whose lifecycle state value is Closed. NNMi also provides an Unassigned Open Key Incidents view that
is filtered using the Lifecycle State values of Registered, In Progress, and Completed as well as the
Assigned To attribute

NNMi provides the following Key Incident views:

● "Open Key Incidents View" (on page 149)

● "Unassigned Open Key Incidents View" (on page 151)

● "Open Key Incidents by Severity View" (on page 151)

● "Open Key Incidents by Priority View" (on page 152)

● "Open Key Incidents by Category View" (on page 154)

● "Open Key Incidents by Family View" (on page 155)

● "Closed Key Incidents View" (on page 156)

● "Key Incidents by Lifecycle State View" (on page 157)

Related Topics

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

Open Key Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Open Key Incidents view shows the incidents that are most important to network Operators and that
often require more immediate action. This view displays the Key Incidents whose lifecycle state value indi-
cates that the incident has not yet been closed. This view is useful for identifying the Key Incidents that
need to be resolved. As with all incident views, you can filter this view by time period. The default time
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period is Last Week so that you can view all of the Key Incidents that have remained open within the last
week.

This view includes those incidents whose Correlation Nature is any of the following:

Incident
Correlation
Nature Description

None Indicates there is no incident correlation for this incident. For example, a Correlation
Nature of None is used for license violations.

Root Cause Indicates the incident that reports the root cause of a problem.

Service
Impact

Indicates a relationship between incidents in which a network service is effected by other
incidents. By default, NNMi generates Service Impact incidents for Router Redundancy
Groups. For example, an Interface Down incident can effect a Router Redundancy Group
that is part of an HSRP service. The Service Impact incident helps to identify the service
that is affected.

This Correlation Nature is available for use by NNM iSPIs (HP Smart Plug-ins). See "Help
for Administrators" for more information about HP Smart Plug-ins.

Stream Cor-
relation

Indicates the correlations that NNMi's event pipeline establishes as it recognizes patterns
in the flow of events through the pipeline. Correlations are created as NNMi analyzes
events and traps to determine the root cause incident for a problem. Examples of stream
correlations include Dedup (duplication of events) and Rate (occurrence of events by
time) correlations.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, the name of the person to which the incident
is assigned, the name of its source node, its source object, its category (for example, Fault or Security), its
family (for example, Interface or Connection), its origin (for example,Management Software or SNMP
Trap), its Correlation Nature (for example,Root Cause), the message used to describe the incident, and
any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

You can also access additional views from this one using the Actions menu as described in Use Table
Views. One example of an action available from an open root cause incident view is the ability to access a
map view of the node(s) related to the incident.

Related Topics

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Severity View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)
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"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)

Unassigned Open Key Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Unassigned Open Key Incident view displays all of the open unassigned Key Incidents. This view is
useful for identifying the Key Incidents that are open and must still be assigned to someone. As with all
incident views, you can filter this view by time period. The default time period is Last Day so that you can
view all of the incidents that have remained unassigned with the last day.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress), the date and time the incident last occurred, the name of its source node, its source object, its cat-
egory (for example, Fault or Security), its family (for example, Interface or Connection), its origin (for
example,Management Software or SNMP Trap), its Correlation Nature (for example, Root Cause), the
message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Related Topics

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View" (on page 149)

"Open Key Incidents by Severity View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)

"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)

Open Key Incidents by Severity View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings

The Open Key Incidents by Severity view lets you filter your view by the Severity value. Possible Severity
values include:
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● Normal

● Warning

● Minor

● Major

● Critical

Note: By default, NNMi uses the first value in the Quick Filter filter list. If your view is empty, change the
filter value. Here is an example of a Quick Filter list:

If your NNMi administrator set up Node Groups or Interface Groups to identify important elements of your
environment, you can filter this view to show only the incidents that need your immediate attention. For
example, by using the severity and node group filters, you can display all incidents that have a Severity
value of Critical and are related to a certain group of nodes.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the open incidents of a specified severity that have occurred within the last week.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each incident displayed, you can view its priority, its lifecycle state (for example In Progress or Closed
), the date and time the incident last occurred, to whom the incident is assigned, the name of its source
node, its source object, its category (for example, Fault or Security), its family (for example, Interface or
Connection), its origin (for example,Management Software or SNMP Trap), its Correlation Nature (for
example, Root Cause), the message used to describe the incident, and any related notes.

Related Topics

"Key Incident Views" (on page 148)

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View" (on page 149)

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)

"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)
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Open Key Incidents by Priority View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Open Key Incidents by Priority view lets you filter your view by the Priority value. Possible Priority
values include:

● None

● Low

● Medium

● High

● Top

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

If your NNMi administrator set up Node Groups or Interface Groups to identify important elements of your
environment, you can filter this view to show only the incidents that need your immediate attention. For
example, by using the priority and Node Group filters, you can display all incidents that have a High or Top
priority and are related to a certain group of nodes.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the open incidents of a specified priority that have occurred within the last week.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each incident displayed, you can view its severity, its lifecycle state (for example In Progress or
Closed), the date and time the incident last occurred, to whom the incident is assigned, the name of its
source node, its source object, its category (for example, Fault or Security), its family (for example, Inter-
face or Connection), its origin (for example,Management Software or SNMP Trap), its Correlation
Nature (for example, Root Cause), the message used to describe the incident, and any related notes.

Related Topics

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View"

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Severity View" (on page 151)"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)

"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)
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Open Key Incidents by Category View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings

The Open Key Incidents by Category view lets you filter your view by the Category value. Possible Cat-
egory values include:

● Accounting

● Application Status

● Fault

● Performance

● Security

● Status

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

You can use this view to help you determine the types of incidents that are in the queue. For example, you
might want to look at only incidents related to faults or to performance to help guide you in making trou-
bleshooting decisions.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the open incidents by a specified category that have occurred within the last week.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its family (for example, Interface or Connection), its origin (for exam-
ple,Management Software or SNMP Trap), the message used to describe the incident, and any related
notes.

Related Topics

"Key Incident Views" (on page 148)

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View" (on page 149)

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Severity View" (on page 151)"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Family View" (on page 155)
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"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)

Open Key Incidents by Family View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings

The Open Key Incidents by Family view lets you filter your view by the Family value. Possible Family
values include:

● Address

● Aggregated Ports

● BGP

● Board

● Chassis

● Component Health

● Connection

● Correlation

● HSRP

● Interface

● License

● Node

● OSPF

● RAMS

● RMON

● RRP

● STP

● Syslog

● Trap Analysis

● VLAN

● VRRP

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

You can use this view to help you determine the types of incidents that are in the queue. For example, you
might want to look at only incidents related to addresses or interfaces to help guide you in making trou-
bleshooting decisions.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the open incidents of a specified Family that have occurred within the last week.
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Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its origin (for example,
Management Software or SNMP Trap), the message used to describe the incident, and any related
notes.

Related Topics

"Key Incident Views" (on page 148)

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View"

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Severity View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)

"Key Incidents by Lifecycle State View" (on page 157)

Closed Key Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Closed Key Incidents view displays the Key Incidents whose lifecycle state indicates that the incident
has been closed. This view is useful for identifying the Key Incidents that have been resolved. This view
might be particularly useful for reporting on how many incidents were closed within a given time period.

As with all incident views, you can filter this view by time period. The default time period is Last Day so
that you can view all of the incidents that have been closed within the last 24 hours. To select a more spe-
cific time range within a time period, you can filter the view using Last Occurrence Time values.

For each incident displayed, you can view its severity, the date and time the incident last occurred, to
whom the incident is assigned, the name of its source node, its source object, its category (for example,
Fault or Security), its family (for example, Interface or Connection), its origin (for example,Management
Software or SNMP Trap), the message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)
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"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Open Key Incidents View" (on page 149)

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents by Severity View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)

"Open Key Incidents by Family View" (on page 155)

"Key Incidents by Lifecycle State View" (on page 157)

Key Incidents by Lifecycle State View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings

The Key Incidents by Lifecycle State view lets you filter your view by the Lifecycle State value. Possible
Lifecycle State values include:

● Registered

● In Progress

● Completed

● Closed

Note: By default, NNMi uses the first value in the Quick Filter list. If your view is empty, change the filter
value. Here is an example of a Quick Filter list:

Filter this view by the Registered Lifecycle State to view all new incidents. If your NNMi administrator set
up Node Groups or Interface Groups to identify important elements of your environment, you can filter this
view using the lifecycle state and Node Group filters. For example, you can display all of the incidents that
are In Progress and are related to a certain group of nodes.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the incidents of a specified lifecycle stat that have occurred within the last week.

Note: If you filter your view using multiple filters, NNMi uses the AND operator to combine the filters you
have selected. See Filter a Table View for more information.

For each incident displayed, you can view its severity, its priority, the date and time the incident last
occurred, to whom the incident is assigned, the name of its source node, its source object, its category (for
example, Fault or Security), its family (for example, Address or Connection), its origin (for example,Man-
agement Software or SNMP trap), the message used to describe the incident, and any related notes.

Related Topics

"Key Incident Views" (on page 148)

Use Table Views
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"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Key Incident Views" (on page 148)

"Unassigned Open Key Incidents View" (on page 151)

"Open Key Incidents View" (on page 149)

"Open Key Incidents by Severity View" (on page 151)

"Open Key Incidents by Priority View" (on page 152)

"Open Key Incidents by Category View" (on page 154)

"Open Key Incidents by Family View" (on page 155)

"Closed Key Incidents View" (on page 156)"Key Incidents by Lifecycle State View" (on page 157)

Root Cause Incidents

Tip: See "IP Address Form" (on page 72)"Incident Form" (on page 132) for more details about the incident
attributes that appear in a root cause incident view's column headings.

Root Cause Incidents identify the root cause determined by NNMi's Causal Engine, along with their asso-
ciated symptoms.

The Causal Engine uses ICMP and SNMP to constantly monitor your network. NNMi's Causal Engine uses
the data collected from all the devices on your network to determine the root cause of known and potential
problems. NNMi notifies you if it encounters any of the following situations:

● "Node Down" (on page 178)

● "Node Down" (on page 178)

● "Interface Down" (on page 175)

● "Address Not Responding" (on page 170)

NNMi provides the following Root Cause Incidents views:

● "Root Cause Incidents View" (on page 159)

● "Open Root Cause Incidents View" (on page 159)

When using root cause incident views, note the following:

● Your administrator may choose to configure particular incidents so that they appear as root cause inci-
dents in your root cause views. To distinguish these incidents from those that NNMi itself identifies as
root cause, the Correlation Nature value for incidents configured to be root cause by the NNMi
administrator is User Root Cause.

● Any root cause view includes incidents that have a Root Cause value for Correlation Nature.

● Your administrator also determines whether to configure deduplication for particular incidents.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 131)
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"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

Root Cause Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Root Cause Incident view displays all of the root cause incidents. This view is useful for identifying the
number of root cause incidents in the queue. You might then choose to narrow your focus by filtering this
information according to one or more attribute values, such as all root cause incidents whose status is Crit-
ical, or all root cause incidents whose description is Node Down.

As with all incident views, you can filter this view by time period. The default time period is Last Day so
that you can view all of the root cause incidents that have occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its family (for example,
Interface or Connection), its origin (for example,Management Software or SNMP Trap), the message
used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Open Root Cause Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings. 

The Open Root Cause Incidents view displays the root cause incidents whose lifecycle state value indi-
cates that the incident has not yet been closed. This view is useful for identifying the Root Cause Incidents
that need to be resolved. As with all incident views, you can filter this view by time period. The default time
period is Last Week so that you can view all of the Root CauseIncidents that have remained open within
the last week.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its family (for example,
Interface or Connection), its origin (for example,Management Software or SNMP Trap), the message
used to describe the incident, and any related notes.

You can also access additional views from this one using the Actions menu as described in Use Table
Views. One example of an action available from an open root cause incident view is the ability to access a
map view of the node(s) related to the incident.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 131)

"Monitoring Incidents for Problems" (on page 130)

"Display a Map from an Incident" (on page 146)

"Unassigned Open Key Incidents View" (on page 151)

"Closed Key Incidents View" (on page 156)

"Root Cause Incidents View" (on page 159)
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Service Impact Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Service Impact Incidents view displays all of the incidents whose Correlation Nature is Service
Impact. Service Impact incidents indicate a relationship between incidents in which a network service is
effected by other incidents. By default, NNMi generates Service Impact incidents for Router Redundancy
Groups. For example, an Interface Down incident can effect a Router Redundancy Group that is part of an
HSRP service. This view is useful for identify a service that is affected. 

Note: The Service Impact Correlation Nature is available for use by NNM iSPIs (HP Smart Plug-ins). See
"Help for Administrators" for more information about HP Smart Plug-ins.

As with all incident views, you can filter this view by time period. The default time period is Last Day so
that you can view all of the Service Impact incidents that have occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its family (for example,
Interface or Connection), the message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Stream Correlation Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings. 

The Stream Correlation Incidents view contains correlations that NNMi's event pipeline establishes as it
recognizes patterns in the flow of events through the pipeline. Contact your NNMi administrator for more
information about NNMi's event pipeline. Correlations are created as NNMi analyzes events and traps to
determine the root cause incident for a problem. Examples of stream correlations include Dedup (dupli-
cation of events) and  Rate (occurrence of events by time) correlations.

This view is useful for proactively identifying potential problems before they become critical or serious
root cause incidents. Keeping these correlations in a separate view also reduces the number of root cause
incidents in the queue.

As with all incident views, you can filter this view by time period. The default time period is Last Week so
that you can view all of the correlations that have occurred within the last week.

For each correlation displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the correlation last occurred, to whom the correlation incident is
assigned, the name of its source node, its source object, its category (for example, Fault or Security), its
family (for example, Interface or Connection), the message used to describe the correlation incident, and
any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.
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Incidents by Family View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Incidents by Family view displays all of the incidents filtered by a specified Family; for example Inter-
face or Connection. This view is useful for identifying the incidents of a particular type. As with all incident
views, you can filter this view by time period. The default time period is Last Day so that you can view all
of the incidents of a specified Family that have occurred within the last 24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its origin (for example,
Management Software or SNMP Trap), its Correlation Nature (for example, Symptom or Root Cause),
the message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

Custom Incidents View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The Custom Incidents view lets you choose the columns of incident information, to better meet your
needs. For example, you might want to filter the view to display only the incidents related to a particular set
of devices. You might also want to filter the view to display only the incidents assigned to you.

This view includes most of the attributes available for the incident so that you can decide which are most
important for you to display. See Use Table Views for more information about sorting, filtering, and hiding
attributes within a view. As with all incident views, you can filter this view by time period. The default time
period is Last Day so that you can view all of the incidents of interest that have occurred within the last 24
hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, to whom the incident is assigned, the name
of its source node, its source object, its category (for example, Fault or Security), its family (for example,
Interface or Connection), its origin (for example,Management Software or SNMP Trap), its Correlation
Nature (for example, Symptom or Root Cause), the message used to describe the incident, and any
related notes. You can also view the duplicate count to indicate any duplicate occurrences of this incident,
the name of the custom incident, an indicator of whether the NNMi root cause analysis (RCA) engine con-
siders this incident to be active, any Correlation Notes that exist for the incident, the date and time the first
instance of this incident occurred (if suppressing incidents), the date and time the original event that trig-
gered the incident occurred, the date and time the incident was created, and the date and time the incident
was last modified.

See Filter a Table View for more information about how to filter information displayed in a table.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.

See "Incident Form" (on page 132) for more information about incident attributes.

Related Topics:

Use Table Views

"Organize Your Incidents" (on page 131)

"Display a Map from an Incident" (on page 146)
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NNM 6.x/7.x Events View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The NNM  6.x/7.x Events view displays the incidents forwarded from Network Node Manager 6.x and 7.x
management stations in your network environment.

You can use this view to monitor the health of devices being managed by previous versions of NNM,
including NNM 6.x and NNM 7.x. You can also use this view to access the following 6.x/7.x features:

● Actions→ NNM 6.x/7.x Neighbor View

● Actions→ NNM 6.x/7.x Details

● Actions→ NNM 6.x/7.x ovw

See "Access NNM 6.x and 7.x Features" (on page 13) for more information.

Note: You can only access 6.x/7.x features by selecting incidents generated from 6.x/7.x events.

For each incident displayed, you can view its severity, its lifecycle state (for example In Progress or
Closed), the date and time the incident last occurred, the name of its source node, its category (for exam-
ple, Fault or Security), its family (for example, Interface or Connection), its Correlation Nature (for exam-
ple, Symptom or Root Cause), the message used to describe the incident, and any related notes.

As with all incident views, you can filter this view by time period. The default time period is Last Day so
that you can view all of the incidents of interest that have occurred within the last 24 hours.

NNM  6.x/7.x Events by Category View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The NNM  6.x/7.x Events by Category view displays the incidents forwarded from Network Node Manager
6.x and 7.x management stations in your network environment. This view enables you to filter the view by
the Incident Category; for example Fault. As with all incident views, you can also filter this view by time
period. The default time period is Last Week so that you can view all of the NNM 6.x or 7.x incidents that
have occurred within the last week..

You can use this view to monitor the health of devices being managed by previous versions of NNM,
including NNM  6.x and NNM 7.x.

For each incident displayed, you can view its severity, its lifecycle state (for example In Progress or
Closed), the date and time the incident last occurred, the name of its source node, its family (for example,
Interface or Connection), its Correlation Nature (for example, Symptom or Root Cause), the message
used to describe the incident, and any related notes.

SNMP Traps View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The SNMP Traps view is useful for identifying all of the traps that were received from devices in your net-
work environment. Your NNMi administrator must configure specific traps before they are displayed within
NNMi incident views. As with all incident views, you can filter this view by time period. The default time
period is Last Hour so that you can view all of the incidents of interest that have occurred within the last 24
hours.
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For each incident displayed, you can view its severity, its lifecycle state (for example In Progress or
Closed), the date and time the incident last occurred, the name of its source node, its source object, its cat-
egory (for example, Fault or Security), its family (for example, Interface or Connection), its Correlation
Nature (for example, Symptom or Root Cause), the message used to describe the incident, and any
related notes.

SNMP Traps by Family View

Tip: See "Incident Form" (on page 132) for more details about the incident attributes that appear in this
view's column headings.

The SNMP Traps by Family view displays all of incidents whose source is an SNMP trap filtered by a spec-
ified Family; for example Interface or Connection. This view is useful for identifying the incidents of a par-
ticular type. As with all incident views, you can filter this view by time period. The default time period is
Last Day so that you can view all of the incidents of a specified Family that have occurred within the last
24 hours.

For each incident displayed, you can view its severity, its priority, its lifecycle state (for example In Prog-
ress or Closed), the date and time the incident last occurred, the name of its source node, its source
object, its category (for example, Fault or Security), its Correlation Nature (for example, Symptom or Root
Cause), the message used to describe the incident, and any related notes.

See "Monitoring Incidents for Problems" (on page 130) for more information about ways to use incident
views.
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Analyze Trap Information

By default, NNMi measures the rate of incoming traps, including the following:

● The rate of incoming SNMP traps from each device

● The rate of each incoming trap for each trap object identifier (OID)

NNMi monitors this trap information to determine whether any incoming traps exceed the threshold. If a
threshold is exceeded, NNMi blocks the traps until the number of traps falls below the minimum threshold.

Note: The NNMi administrator can configure the threshold value using the nnmtrapconfig.ovpl script.

NNM iSPI NET. You can obtain reports about this trap information according to the following criteria:

● Within a specific time period

● For a specific node

● According to a specific trap identifier (trap OID)

For more information about this NNM iSPI NET tool, click here.

When analyzing traps, NNMi looks at both the most common traps as well as the most common source
nodes from which the traps are received. This SNMP trap analytics data is logged to the trap-
analytics.0.0.log file. Information in the log file is organized according to the following criteria:

● Trap rate in number of traps per second

● The top 10 addresses that are generating traps

● The top 10 traps that are being generated

To make this data more easily available, use the nnmtrapdump.ovpl command. This NNM iSPI NET tool
enables you to extract the data in which you are most interested from the trapanalytics.0.0.log file.

See the nnmtrapdump.ovpl Reference Page for more information (Help→ Documentation Library→ Ref-
erence Pages, in the User Commands category).

Page 164 of 216



Network Node Manager (NNMi 8.10) Online Help: Using the Console
Investigate and Diagnose Problems

Investigate and Diagnose Problems

NNMi offers several ways for you to investigate and diagnose network problems.

● Use the Actions menu to gather the latest information about multiple aspects of a node (rather than
waiting for the next regularly scheduled collection time).

■ "Verify Device Configuration Details " (on page 165)

■ "View the Monitoring Configuration Details" (on page 166)

■ "Verify Current Status of a Device" (on page 168)

● The Causal Engine keeps track of changes in your network, and alerts you to the root cause of prob-
lems and potential problems. See "Interpret Root Cause Incidents" (on page 168) for more infor-
mation.

● The Actions menu also provides an easy way to launch troubleshooting commands to diagnose node
connectivity and access problems:

■ "Display End Nodes Attached to a Switch (NNM iSPI NET)" (on page 190)

■ "Test Node Access (Ping)" (on page 191)

■ "Find the Route (traceroute)" (on page 192)

■ "Establish Contact with a Node (telnet)" (on page 193)

■ "Check Status Details for a Node Group" (on page 194)

■ "Access NNM 6.x and 7.x Features" (on page 13)

● Use the Tools menu to find a problem node. You can also use the Tools menu to verify that NNMi,
itself, is running properly. This includes checking the status of NNMi processes and services:

■ "Find a Node" (on page 189)

■ "Find the Attached Switch Port (NNM iSPI NET)" (on page 190)

■ "Checking the Status of NNMi" (on page 196)

Verify Device Configuration Details

Before you begin diagnosing a problem, you might want to gather current information about a node to
update information in views and NNMi maps.

Note: NNMi automatically gathers this information according to the Rediscovery Interval setting that was
set by your administrator. The minimum allowed Rediscovery Interval setting is 1 hour. The default
value set by NNMi is 24 hours.

To update your discovery information for a node:

1. Navigate to the view or form of interest and select the node whose discovery information you want to
update.

To navigate to a table view and select a node

a. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

b. Click the view that contains the node whose communication settings you want to check; for
example Nodes.

c. From the table view, click the  selection box that precedes the node whose configuration you
want to check.
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To navigate to a map view and select a node:

a. Navigate to the table view.

b. From a table view, click the  selection box that precedes the node of interest.

c. Select Actions.

d. From the drop-down menu, select the map view of interest.

e. From the map view, click the node whose configuration you want to check.

To select a node from a form:

a. From a table view, click the  Open icon that precedes the node of interest.

b. From a map view, click the node of interest on the map and click the  Open icon.

2. Select Actions→ Configuration Poll.

As the node is polled, NNMi displays the status messages for the Layer 3 discovery information. A Layer 2
connectivity analysis is also started. Information collected includes the node's IP address, subnet, contact
name, location, and description.

View the Monitoring Configuration Details

Use the Actions→ Monitoring Settings menu item to display the current monitoring configuration settings
for a particular node, interface, address, Router Redundancy Member, Tracked Object, or Node Com-
ponent.

NNMi can be configured to monitor several aspects of each device, and provide a wealth of information to
help you do your job. After fault polling is enabled, several NNMi processes work together to detect prob-
lems and quickly calculate the device status and the root cause of any problems for you.

NNM iSPI for Performance. The NNM iSPI for Performance can monitor performance statistics and thresh-
olds for each interface.

Attribute Description

Node Group The name of any Node Groups to which this device belongs. See About Node and Inter-
face Groups for more information.

Fault Polling
(SNMP and
ICMP)

If enabled, State Poller monitors all managed interfaces, IP addresses, and SNMP
agents by issuing ICMP pings and SNMP read-only queries for MIB II ifAdminStatus and
ifOperStatus. (ifAdminStatus is set by the device administrator. ifOperStatus indicates the
overall health of the device and is supplied by the SNMP Agent.) 

If disabled:

● Devices that were already discovered remain with the last calculated state/status.

● Newly discovered devices are set to "No Status" with map-symbol background
shape color set to beige.

Fault Polling
Interval

The time that State Poller waits between issuing queries to gather information.

Monitoring Possibilities
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Attribute Description

Performance
Polling

NNM iSPI for Performance.

If enabled, the NNM iSPI for Performance is installed. The NNM  iSPI for Performance is
accessed from the Action menu within map views and table views.

If disabled, network performance data is not currently available.

Performance
Polling Inter-
val

NNM iSPI for Performance.

The time that NNM  iSPI for Performance waits between issuing queries to gather infor-
mation.

To view the monitoring configuration for a Node, Interface, or IP address:

1. Navigate to the view for that object (for example, Inventory→ Nodes).

2. Select the object of interest by selecting the check box that precedes the object information.

3. Select Actions→ Monitoring Settings.

Note: This menu item also is available on any object's form.

To view the monitoring configuration for a Router RedundancyMember:

1. Navigate to a Router Redundancy Group view (for example, Inventory→ Router Redundancy
Groups).

2. Click the Open icon that precedes the Router Redundancy Group of interest.

3. From the Router Redundancy Members tab, click the Open icon that precedes the Router Redun-
dancy Group Member of interest.

4. Select Actions→ Monitoring Settings.

To view the monitoring configuration for a Tracked Object:

1. Navigate to a Router Redundancy Group view (for example, Inventory→ Router Redundancy
Groups).

2. Click the Open icon that precedes the Router Redundancy Group of interest.

3. From the Router Redundancy Members tab, click the Open icon that precedes the Router Redun-
dancy Group Member of interest.

4. Select the Tracked Object of interest by selecting the check box that precedes the object infor-
mation.

5. Select Actions→ Monitoring Settings.

To view the monitoring configuration for a Node Component:

1. Navigate to a Node view (for example, Inventory→ Nodes).

2. Click the Open icon that precedes the Node of interest.

3. Select the Component Health tab.

4. Select the Node Component of interest by selecting the check box that precedes the object infor-
mation.

5. Select Actions→ Monitoring Settings.

Note: This menu item is also available on any Node Component form.
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Verify Current Status of a Device

NNMi calculates the status of devices each time additional information is gathered from various sources.
You can request a status poll at any time to gather current information and update the data in views and
NNMi maps.

To update status information about a node:

1. Navigate to the view of interest and select the node whose status information you want to update.

To navigate to a table view and select a node:

a. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

b. Click the view that contains the node whose status you want to update; for example Nodes.

c. From the table view, click the  selection box that precedes the node whose status you want to
update.

To navigate to a map view and select a node:

a. Navigate to the table view.

b. From a table view, click the  selection box that precedes the node of interest.

c. Select Actions.

d. From the drop-down menu, select the map view of interest.

e. From the map view, click the node whose status you want to update.

2. Select Actions→ Status Poll.

As the node is polled, NNMi displays a report about which information is being gathered. When the poll
completes, check the status icons in views and forms (see the Status tab information in "Node Form" (on
page 27)). You can also check the status colors of map icons for changes ("Watch Status Colors" (on page
126)).

Interpret Root Cause Incidents

The Causal Engine keeps track of changes in your network, and alerts you to the root cause of problems
and potential problems.The Causal Engine sets an object's status using an object's outstanding con-
clusions. Every outstanding conclusion has a status, such as Normal or Critical. The highest status for an
object's outstanding conclusions becomes the object's status. The order of status from lowest to highest is
listed below:

  No Status

  Normal

  Disabled

  Unknown

  Warning

  Minor

  Major
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Critical

Incident views explain the situation. Click here for examples of the type of information you can obtain
from incidents. The information in the Incident helps you solve the problem quickly and efficiently:

● A router, switch, server, or other monitored device is down (see "Node Down" (on page 178) )

● A node or connection might be down and need your attention (see "Node or Connection Down" (on
page 180))

● An interface is operationally down (see "Interface Down" (on page 175))

● An address is no longer responding (see "Address Not Responding" (on page 170)).

● The connection between two important devices is down (see "Connection Down" (on page 173) and
"Connection Partially Unresponsive" (on page 174))

Map views provide a quick way to view status. Click here for more information. As problems are detected
for specific devices, the Causal Engine changes the status color of that device's icon on the maps. See
"Watch Status Colors" (on page 126) for more information about status color.

The sequence of color changes indicates increasing levels of trouble. Red, the most severe, indicates that
a network element is not functioning. You generally want to intervene and solve problems before they
cause a complete node failure.

For more information about root cause scenarios, see the following:

● "Node Down" (on page 178)

● "Address Not Responding" (on page 170)

● "Address Disabled" (on page 169)

● "Interface Down" (on page 175)

● "Interface Disabled" (on page 176)

● "Interface Unmanageable" (on page 177)

● "Connection Down" (on page 173)

● "Connection Partially Unresponsive" (on page 174)

● "Node or Connection Down" (on page 180)

● "SNMP Agent Not Responding" (on page 182)

● "Non-SNMP Node Unresponsive" (on page 181)

Address Disabled

NNMi generates an Address Disabled conclusion when its interface becomes disabled. (An interface is
disabled when its Administrative State (MIB II ifAdminStatus) is set to Down. See "Interface Disabled" (on
page 176) for more information.)

Note: When the Administrative State is set to Down, the State of the address is set to Not Responding. If
the interface's Administrative State changes to Up, but the Operational State remains Down, the
address State remains set to Not Responding.

In the Conclusions list, trouble with an address is indicated by the following:

AddressesDisabled

An Address Disabled conclusion does not generate an incident, but appears in the information that is
accessible from the Conclusions tab in the IP Address form.
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Address Not Responding

NNMi periodically uses an ICMP ping command to check each address. If there is no response, NNMi's
Causal Engine determines that the address is not responding:

On the source Node form, NNMi updates information on the following tabs:

● Addresses

● Interfaces

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with an address is indicated by the following:

SomeUnresponsiveAddressesInNode(node status = Minor)

Note: If you view an AllUnresponsiveAddressesInNode conclusion, see "Node Down" (on page 178)
for more information.

On the maps, the icon for the Node is set to yellow (status = Minor), and any Interfaces that are using this
address are updated.

Note: If  the interface has more than one address, the address symbol might stay green (status = normal):

Aggregator Interface Degraded (NNMi Advanced)

NNMi generates an Aggregator Interface Degraded incident when the Status of at least one of the phys-
ical interfaces that is a member of an Aggregator Interface is set to Critical. See Layer 2 Neighbor View
Map Objects for more information about Aggregator Interfaces.

An Aggregator Interface Degraded incident has a Severity set to Minor.

On the Incident form, Information on the following tabs is updated:

● Correlated Parents

● Correlated Children

Note: When an Interface Up occurs for all of the physical interfaces whose Status is Critical, NNMi
updates Information in the Correlation Notes attribute and closes the incident.

On the Interface form for the Aggregator Interface, the Interface State attributes are updated. Infor-
mation on the following tabs is updated:

● Addresses (if the interface has one or more addresses)

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with each physical interface that is a member of the Aggregator Interface is
indicated by the following:

InterfaceDown (Interface status = Critical)
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See "Interface Down" (on page 175) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the icon for the Aggregator Interface is yellow:

Aggregator Interface Down (NNMi Advanced)

NNMi generates an Aggregator Interface Down when the Status of all physical interfaces that are
members of the Aggregator Interface are set to Critical.

An Aggregator Interface may become Critical when NNMi determines either of the following:

● The Aggregator Interface exists in the interface table and its MIB II ifOperStatus is Down.

● All of the physical interfaces that are members of the Aggregator Interface have a MIB II ifOperStatus
of Down.

See Layer 2 Neighbor View Map Objects for more information about Aggregator Interfaces.

An Aggregator Interface Down incident has Severity set to Critical

On the Incident form, Information on the following tabs is updated:

● Correlated Parents

● Correlated Children

Note: When an Interface Up occurs for any of the physical interfaces, NNMi updates Information in the
Correlation Notes attribute and closes the incident.

On the Interface form for the Aggregator Interface, the Interface State attributes are updated. Infor-
mation on the following tabs is updated:

● Addresses (if the interface has one or more addresses)

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with each physical interface that is a member of the Aggregator Interface is
indicated by the following:

InterfaceDown (Interface status = Critical)

See "Interface Down" (on page 175) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the icon for the Aggregator Interface is red:
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Aggregator Connection Degraded (NNMi Advanced)

NNMi generates an Aggregator Connection Degraded incident when the Status of at least one of the
Aggregator Interfaces that is a member of a Link Aggregation is set to Minor. See Layer 2 Neighbor View
Map Objects for more information about Aggregator Connections. Also see "Aggregator Interface
Degraded (NNMi Advanced)" (on page 170).

An Aggregator Connection Degraded incident has a Severity set to Minor.

On the Incidents form, Information on the following tabs is updated:

● Correlated Parents

● Correlated Children

Note: When an Interface Up occurs for all of the physical interfaces whose Status is Critical, NNMi
updates Information in the Correlation Notes attribute and closes the incident.

On the Layer 2 Connection form for the Aggregator Connection, the Interface State attributes are
updated. Information on the following tabs is updated:

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with each physical interface that is a member of the Link Aggregation is
indicated by the following:

InterfaceDown (Interface status = Critical)

See "Interface Down" (on page 175) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the thick line for the Aggregator Connection is yellow:

Aggregator Connection Down (NNMi Advanced)

 NNMi generates an Aggregator Connection Down incident when the Status of at least one of the Aggre-
gator Interfaces that is a member of the Link Aggregation is set to Critical. See Layer 2 Neighbor View
Map Objects for more information about Aggregator Interfaces and Aggregator Connections. Also see
"Aggregator Interface Down (NNMi Advanced)" (on page 171).

An Aggregator Connection Down incident has Severity set to Critical.

On the Incident form, Information on the following tabs is updated:

● Correlated Parents

● Correlated Children

Note: When an Interface Up occurs for any of the physical interfaces, NNMi updates Information in the
Correlation Notes attribute and closes the incident.

On the Layer 2 Connection form for the Aggregator Connection, the Interface State attributes are
updated. Information on the following tabs is updated:
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● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with each physical interface that is a member of the Link Aggregation is
indicated by the following:

InterfaceDown (Interface status = Critical)

See "Interface Down" (on page 175) for more information about Interface Down incidents.

On Layer 2 Neighbor View maps, the thick line indicating the Aggregator Connection is red:

Buffer has Insufficient Capacity or is Malfunctioning

A Buffer has Insufficient Capacity or is Malfunctioning incident indicates the buffer pool for the source
node is either exhausted or cannot meet the demand for use.

A Buffer has Insufficient Capacity or is Malfunctioning incident is generated with Severity set to Critical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps.

On the map, the Causal Engine sets the color of the Source Node to yellow.

Connection Down

NNMi periodically uses SNMP to check the interface on each end of a connection. NNMi's Causal Engine
uses this information to determine the status of the connection. If both ends of the connection are down,
the Causal Engine determines that the connection is down.

A Connection Down incident is generated with Severity set to Critical. The information on the following
tab is updated:

● Correlated Children

On the Connections form, information on the following tabs is updated:

● Interfaces

● Status

● Conclusions

In the Conclusions list, trouble with a connection is indicated by the following:

● ConnectionDown (connection status = Critical)
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On the maps, the Causal Engine sets the color of the line between the devices according to the following
criteria (the line indicates the connection):

●
Red: neither interface is responding.

●
Green: Both interfaces are responding.

●
Yellow: the interface on one end is not responding. The interface on the other end is responding.

●
Light Blue: due to other network problems, the status of one interface cannot be determined at

this time.

●
Dark Blue: due to other network problems, the status of both interfaces cannot be determined at

this time.

Connection Partially Unresponsive

NNMi periodically uses SNMP to check the interface on each end of a connection. NNMi's Causal Engine
uses this information to determine the status of the connection. If NNMi cannot determine the status of
one end of a connection and the other end of the connection is up, the Causal Engine determines that the
connection is partially unresponsive. In the case of multiple end points within a connection, at least one
end point must be up. The remaining end points must be a combination of up and unresponsive (mean-
ing NNMi cannot determine the status of the end point).

Reasons NNMi might not be able to determine the status of an interface is that a problem exists in an
ATM or FrameRelay cloud that is between one interface and the other.

A Connection Partially Unresponsive incident is generated with Severity set to Critical.

On the Connections form, information on the following tabs is updated:

● Interfaces

● Status

● Conclusions

In the Conclusions list, trouble with a connection is indicated by the following:

● ConnectionPartiallyUnresponsive (connection status =Warning)

If the source node is in the Important Nodes Group, the Node Down incident appears as a correlated child
under the Connection Partially Unresponsive incident. (Your administrator decides what nodes belong in
the Important Nodes group.)

On the maps, the Causal Engine sets the color of the line between the devices as follows (the line indi-
cates the connection):
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CPU Utilization is too High

 A CPU Utilization is too High incident indicates any of the following utilization averages is too high:

● 5 second

● 1 minute

● 5 minute

A CPU Utilization is too High incident is generated with Severity set to Critical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps.

On the map, the Causal Engine sets the color of the Source Node to yellow.

Fan is Malfunctioning

A Fan is Malfunctioning incident indicates the identified fan on the Source Node is not operating correctly.

A Fan is Malfunctioning incident is generated with Severity set to Critical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps.

On the map, the Causal Engine sets the color of the Source Node to yellow.

Interface Down

NNMi periodically uses SNMP to check each interface. If an SNMP agent reports that an interface is down
(MIB II ifOperStatus), NNMi's Causal Engine takes the following actions:

An Interface Down incident is generated with Severity set to Critical. Information on the following tabs is
updated:

● Correlated Parents

● Correlated Children

● Custom Attributes

Information in the Correlation Notes attribute is updated on an Interface Up.

Note: You might find relevant traps as Correlated Children on the Correlations tab.

On the Interface form, the Interface State attributes are updated. Information on the following tabs is
updated:

● Addresses (if the interface has one or more addresses)

● Status
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● Conclusions

● Incidents

In the Conclusions list, trouble with an interface is indicated by the following:

InterfaceDown (Interface status = Critical)

On the source Node's form, the information on the following tabs is updated:

● Addresses

● Interfaces

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with an interfaces is indicated by the following:

InterfacesDownInNode (node status = Minor)

On the maps, the icons for the node and its interfaces are updated:

Interface Disabled

NNMi periodically uses SNMP to check each interface. If an SNMP agent reports that an interface is
administratively down (MIB II ifAdminStatus), NNMi's Causal Engine takes the following actions:

Note: Interface Disabled incidents are not generated by default. Your NNMi administrator must configure
these incidents to  be generated.

An Interface Disabled incident is generated with Severity set to Critical. Information on the following tabs
is updated:

● Correlated Children

● Custom Attributes

Information in the Correlation Notes attribute is updated on an Interface Enabled.

Note: You might find relevant traps on the Correlations tab.

On the Interface form, the Interface State attributes are updated. Information on the following tabs is
updated:

● Addresses

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with an interface is indicated by the following:

InterfaceDisabled (Interface status = Disabled)

On the source Node's form, the information on the following tabs is updated:
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● Addresses

● Interfaces

● Status

● Conclusions

● Incidents

On the maps, the icons for any of the node's disabled interfaces are updated and displayed as grey (dis-
abled):

Interface Unmanageable

NNMi periodically uses SNMP to check each interface. If an SNMP agent is not responding, NNMi's
Causal Engine takes the following actions:

One InterfaceUnmanageablemessage is generated for each interface within the node.

On each Interface form, the Interface State attributes are updated. The information on the following tabs
is updated:

● Addresses

● Status

● Conclusions

In the Conclusions list, trouble with the interface is indicated by the following:

InterfaceUnmanageable (Interface status = Unknown)

On the source node's form, the SNMP Agent State attributes are updated. The information on the fol-
lowing tabs is updated:

● Addresses (if the interface has one or more IP addresses)

● Interface

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble with an interface is indicated by the following:

UnresponsiveAgentInNode (status = Minor)

Note: There is one InterfaceUnmanageablemessage for each interface within the node.

On the maps, the icons for the node and itsiInterfaces are updated:

If the interface is unmanageable because the SNMP agent is down:
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If the interface is unmanageable because of a node down situation:

Remote Site Containing Node <Source Node Name> is Unreachable

A Remote Site is Unreachable incident is generated when all of the nodes in an Island Node Group do not
respond to ICMP or SNMP queries.

An Island Node Group is a group of connected nodes that NNMi discovers and that are not connected to
the rest of the topology. An example of an environment with multiple Island Node Groups is a financial
institution or retail store with many branches or stores. Each branch or store might be connected to other
branches or stores with a WAN (Wide Area Network) connection. Each branch or store appears as an iso-
lated island of nodes in the NNMi topology.

NNMi automatically creates Island Node Groups whenever it detects changes in Layer 2 connections.

NNMi selects a representative node in each Island Node Group as the Source Node associated with the
Remote Site incident. The Source Object is the Island Node Group.

Memory has Insufficient Capacity or is Malfunctioning

A Memory has Insufficient Capacity or is Malfunctioning incident indicates the memory pool for the
Source Node is exhausted or cannot meet the demand for use.

A Memory has Insufficient Capacity or is Malfunctioning incident is generated with Severity set to Crit-
ical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps. 

On the map, the Causal Engine sets the color of the Source Node to yellow.

Node Down

An unresponsive device within your network can cause a variety of problems. If the troubled device is a
router, switch, or server, many devices could be unreachable. You receive a Node Down incident when
NNMi analyzed the situation and determined any of the following:

● A node with two or more connections is truly down.

● An SNMP node that has no discovered connections is unreachable.

● A node belongs to the Important Nodes Group and has become unreachable. Your NNMi admin-
istrator assigns devices to this Node Group (these devices can have any number of connections).

● A non-SNMP node is unreachable.
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A Node Down incident is generated with Severity set to Critical, and the map icon is set to red (see Map
Displays). Any Interface Down incident on neighbors that are one hop from the node are correlated under
the Node Down incident.

If the device becomes responsive again, the Node Down incident is automatically closed. In the cor-
relation Notes attribute, an annotation explains exactly why it was closed.

Note: When NNMi cannot determine whether the node or connection is down, it generates a Node or Con-
nection Down incident. See "Node or Connection Down" (on page 180) for more information.

NNMi does not generate a Node Down incident under the following conditions:

● If the node is in the shadow of another problem that causes the to be unreachable.

● If the node is in an ATM or FrameRelay cloud that causes the node to be unreachable.

When the Node Has Two or More Connections

The Causal Engine uses the following criteria to verify which node is actually down:

Note: If the addresses are not being polled, only the last two criteria are used.

Stand-
Alone
Problem

Side Effect
of Another
Problem Criteria

+ + 100% of the addresses assigned to this node are unreachable.

+ + The SNMP agent installed on this machine is not responding.

+ - At least two of the neighboring devices can be reached and are reporting prob-
lems with connectivity to this node. Therefore, this is not a "Shadow" problem,
but is truly a problem with the identified node.

In the device's Node form, the Conclusions tab shows the relevant combination of conclusions, which
might include any of the following:

● AllUnresponsiveAddressesInNode (status = Minor) - (Appears only when addresses are being
polled)

● UnresponsiveAgentInNode (status = Minor)

● NodeWithAtleastTwoNeighborsUp (status = Normal)

When the SNMP Node has No Discovered Connections and is Unreachable

The Causal Engine generates a Node Down incident for an SNMP node when an unconnected node is
unreachable. (No connections have been discovered for the node.)

When a Node is in the Important Nodes Group

When a Node in the Important Node Group is unreachable, NNMi issues a Node Down incident.

Nodes in the Important Nodes Group may or may not have two or more connections. See "Connection Par-
tially Unresponsive" (on page 174) for more information about how nodes in an Important Node Group
are handled when the connection is partially unresponsive.

When a non-SNMP Node is Unreachable

The Causal Engine generates a Node Down incident for a non-SNMP node under the following con-
ditions:

● The interface on an SNMP node at one end of a connection is Down.

● The non-SNMP end node on the other end of the connection does not respond to ping.
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Map Displays

The Status of the Node Down device for an SNMP node changes to Critical and the device's map icon
color changes to red (Router 3 in the illustration below). The status of each unreachable interface changes
to Unknown and the interface map icon color changes to blue.

Any other devices that are unreachable because of this problem are in the "shadow" of the problem:

● The unreachable shadow devices' map icons change to blue.

● Members of the Important Nodes group's map icons change to red (Switch 1 in the illustration below).

The Status of the Node Down device for a non-SNMP node changes to Critical and the device's map icon
color changes to red. The Status of the interface on each end of the connection also changes to Critical
and each interface's map icon color changes to red.

Node or Connection Down

If a node is not responding to ICMP and SNMP queries, and only one neighbor is down, the Causal
Engine cannot determine whether the node itself is down or whether the connection to the node is down.

A Node or Connection Down incident is generated with Severity set to Critical.

On the source node's form, the information on the following tabs is updated:
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● Addresses

● Interface

● Status

● Conclusions

● Incidents

In the Conclusions list, trouble is indicated by the following message:

NodeOrConnectionDown (node status = Critical)

On the maps, the icon for the node is set to  red:

Non-SNMP Node Unresponsive

NNMi generates a Non-SNMP Node Unresponsive incident under the following conditions:

● A node does not have an SNMP agent

● NNMi is unable to  ping all of the addresses for the non-SNMP node

Reasons NNMi might not be able to ping all of the addresses for a node include one or more devices
between the non-SNMP node and its neighbor device are down.

Note: If a node does not have an SNMP agent, NNMi is able to gather only the address information for the
node.

A Non-SNMP Node Unresponsive incident is generated with Severity set to Critical.

On the node form, information on the following tabs is updated:

● Status

● Conclusions

In the Conclusions list, trouble with a connection is indicated by the following:

● Non-SNMPNodeUnresponsive (node status =Critical)

On the maps, NNMi's Causal Engine sets the color of the node to red:

Number of SNMP Traps Persisted in the Database has Reached or
Exceeded Trap Limit

A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit incident
indicates the number of SNMP traps has reached or exceeded the maximum limit. By default, the
SNMP trap limit is 100,000.
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Note: When the maximum limit is reached, NNMi no longer accepts traps from the Event system. The
NNMi administrator can reduce the number of traps in the NNMi database. See the nnmtri-
mincidents.ovpl Reference Page (Help→ Documentation Library→ Reference Pages, in the
Administrator Commands category).

A Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit incident is
generated with Severity set to Critical.

Power Supply is Malfunctioning

A Power Supply is Malfunctioning incident indicates the Source Node's specified power supply is not
operating correctly.

A Power Supply is Malfunctioning incident is generated with Severity set to Critical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps. 

On the map, the Causal Engine sets the color of the Source Node to yellow.

SNMP Agent Not Responding

NNMi periodically uses SNMP to check the availability of each SNMP Agent in your network environment.
If an SNMP Agent is not responding (for example, the SNMPv1 or SNMPv2c community string for this
agent changed, or the SNMPv3 user name for this agent changed, and the NNMi communication con-
figuration settings have not yet been updated):

On the source node's form, the SNMP Agent State attributes are updated. The information on the fol-
lowing tabs is updated:

● Interface

● Status

● Conclusions

In the Conclusions list, trouble with an SNMP agent is indicated by the following:

UnresponsiveAgentInNode (status = Minor)

On the maps, the icons for the monitored node (status = Minor) and its interfaces (status = Unknown) are
updated:

Temperature Sensor is Out of Range

A Temperature Sensor is Out of Range incident indicates the Source Node's temperature sensor is either
too hot or too cold.

A Temperature Sensor is Out of Range incident is generated with Severity set to Critical.
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On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps. 

On the map, the Causal Engine sets the color of the Source Node to yellow.

Voltage is Out of Range

A Voltage is Out of Range incident indicates the specified voltage on one of the Source Node's power
supplies is out of range.

A Voltage is Out of Range incident is generated with Severity set to Critical.

On the Source Node form, information on the following tabs is updated:

● Correlated Children

● Status

● Conclusions

The Correlated Children tab includes any associated traps. 

On the map, the Causal Engine sets the color of the Source Node to yellow.

Interpret Service Impact Incidents

Service Impact incidents indicate a relationship between incidents in which a network service is affected
by other incidents. The Service Impact incident helps to identify the service that is affected. Any associated
incidents that have contributed to the reason for the Service Impact appear under the Conclusions tab for
the Service Impact incident.

A Service Impact incident is indicated using the incident Correlation Nature attribute.

Note: NNMi determines the Correlation Nature for an incident.
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NNMi Advanced. As an example of a Service Impact incident and its relationship between additional
incidents: an Interface Down incident on an interface that is part of a Router Redundancy Group can
effect the integrity of a Router Redundancy Group that is part of an HSRP service. To continue the exam-
ple, A Router Redundancy Group Degraded incident might be the Service Impact incident used to indi-
cate there is a problem with your HSRP service. The Interface Down incident would appear under the
Conclusions tab for the Router Redundancy Degraded incident to indicate that it is part of the reason the
Router Redundancy Group (and subsequent HSRP service) has become degraded.

NNMi provides the following incidents whose Correlation Nature is Service Impact:

● "Primary Device in Router Redundancy Group Switched (NNMi Advanced)" (on page 184)

● "No Primary Device in Router Redundancy Group (NNMi Advanced)" (on page 184)

● "Multiple Primary Devices in Router Redundancy Group (NNMi Advanced)" (on page 185)

● "No Secondary Device in Router Redundancy Group (NNMi Advanced)" (on page 185)

● "Multiple Secondary Devices in Router Redundancy Group (NNMi Advanced)" (on page 185)

● "Router Redundancy Group Degraded (NNMi Advanced)" (on page 185)

Note: NNMi determines the Correlation Nature for an incident.

See "Router Redundancy Group View (NNMi Advanced)" (on page 22) for more information about
Router Redundancy Groups.

Primary Device in Router Redundancy Group Switched (NNMi Advanced)

A Primary Device in Router Redundancy Group Switched incident means NNMi determined a primary role
(for example, HSRP Active or VRRP Master) moved from one device to another in a Router Redundancy
Group.

Note: The group is routing packets properly.

Reasons for this incident include one or more of the following:

● A router or interface in the Router Redundancy Group has gone down.

● A tracked object (interface or IP address) in the Router Redundancy Group has gone down.

When a Primary Device in Router Redundancy Group Switched incident is generated, the Router Redun-
dancy Group maintains its current status. 

A Primary Device in Router Redundancy Group Switched incident has Severity set to Critical.

No Primary Device in Router Redundancy Group (NNMi Advanced)

A No Primary Device in Router Redundancy Group incident means NNMi determined no primary device
(for example, HSRP Active or VRRP Master) is identified in a Router Redundancy group.

This typically indicates one of the following:

● Too many routers are down.

● Protocol specific communication between routers in the group is malfunctioning.

A No Primary Device in Router Redundancy Group incident has Severity set to Critical.
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Multiple Primary Devices in Router Redundancy Group (NNMi Advanced)

A Multiple Primary Devices in Router Redundancy Group incident means NNMi determined multiple pri-
mary devices (for example, HSRP Active or VRRP Master) are identified in a Router Redundancy Group.

This incident typically indicates that protocol specific communication between routers in the group is mal-
functioning.

A Multiple Primary Devices in Router Redundancy Group incident has Severity set to Critical.

No Secondary Device in Router Redundancy Group (NNMi Advanced)

A No Secondary Device in Router Redundancy Group incident means NNMi determined no secondary
device (for example, HSRP Standby or VRRP Backup) is identified in a Router Redundancy Group.

This incident typically indicates the following:

● Protocol-specific communication between routers in the group is malfunctioning.

● The group is routing packets properly because a single primary device has been identified.

A No Secondary Device in Router Redundancy Group incident has Severity set toWarning.

Multiple Secondary Devices in Router Redundancy Group (NNMi Advanced)

A Multiple Secondary Devices in Router Redundancy Group incident means NNMi determined more than
one secondary device (for example, HSRP Standby) is identified in a Router Redundancy Group.

Note: This incident applies to only Router Redundancy Groups using the HSRP protocol. VRRP allows mul-
tiple secondary (VRRP Backup State) routers.

This incident typically indicates that protocol specific communication between routers in the group is mal-
functioning.

A Multiple Secondary Devices in Router Redundancy Group incident has Severity set to Critical.

Router Redundancy Group Degraded (NNMi Advanced)

This incident only occurs in Router Redundancy Groups using the HSRP protocol and with more than two
members.

Note: The group is routing packets properly.

A Router Redundancy Group Degraded incident means NNMi determined the following:

● The Router Redundancy Group has a primary and secondary device.

● The remaining devices in the group are not in an expected protocol-specific state. For example, in
HSRP, devices other than the Standby and Active devices are expected to be in the "Listen" state.

● Protocol-specific communication between routers in the group is malfunctioning.

A Router Redundancy Group Degraded incident has Severity set toWarning.

Interpret Threshold Incidents (NNM iSPI for Performance)

NNM iSPI for Performance. If the NNMi administrator configures performance measurement thresholds,
NNMi monitors interfaces for acceptable operations ranges or threshold violations. NNMi can be con-
figured to create incidents when performance outside the acceptable range is detected. When the
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performance returns to within an acceptable range, NNMi closes the incident. NNM iSPI for Performance
provides exceptions reports to track the frequency of threshold violations.

The following table describes possible threshold incidents.

Note: Performance thresholds can affect the status of an interface, connection, or node. For example, if
an interface error rate is high, the interface status becomes Critical. NNMi's Causal Engine returns
the node status of Warning for any nodes whose interfaces are outside one or more threshold
boundaries.

Tip: See "Incident Form" (on page 132) for more information about each performance measurement.

Performance Meas-
urement

Interface Performance
State Message

Incident Sever-
ity

Input Utilization HIGH Interface Input Utilization
High

Critical

LOW Interface Input Utilization
Low

Minor

NONE Interface Input Utilization
None

Major

Output Utilization HIGH Interface Output Utilization
High

Critical

LOW Interface Output Utilization
Low

Minor

NONE Interface Output Utilization
None

Major

Input Error Rate HIGH Input Error Rate High Critical

Output Error Rate HIGH Output Error Rate High Critical

Input Discard Rate HIGH Input Discard Rate High Critical

Output Discard Rate HIGH Output Discard Rate High Critical

Threshold Incidents

Input and Output Utilization Incidents (NNM iSPI for Performance)

Utilization incidents are available if NNM iSPI for Performance is installed and your administrator con-
figured performance measurement thresholds.

Input and output utilization incidents enable you to identify interfaces that are over- or under-utilized.

You receive input and output utilization incidents when performance is not within the allowable range set
by your administrator. Reasons for setting utilization thresholds include:

● Monitor for under-utilization which wastes money

● Monitor for over-utilization, which may result in performance bottlenecks or service provider sur-
charges (over a pre-specified percentage)

The severity of utilization incidents depends on whether the measured value is over or under the allow-
able range. The following table describes the meaning of HIGH, NOMINAL, LOW, and NONE.
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Utilization
Value Description Incident Severity

NONE The measured value is zero. Minor

LOW The measured value is less than the allowable range. Minor

NOMINAL The measured value is within the allowable range. This incident
cancels any related HIGH, LOW, or NONE incidents.

Not applicable. No inci-
dent is generated.

HIGH The measured value is greater than the allowable range Critical

Information under the following Incident tabs is updated:

● Correlated Parents

● Correlated Children

● Custom Attributes

The following table describes a combination of conclusions leading to utilization errors. These appear in
the Conclusions lists on the associated interface and connection or node forms.

Form Conclusion Status

Interface InterfaceOutputUtilizationHigh Critical

Connection SomeConnectionThreshold ValuesHigh Minor

Possible Conclusion Combinations for Utilization Incidents (Interface and Connection)

Form Conclusion

Interface InterfaceOutputUtilizationHigh Critical

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Utilization Incidents (Interface and Node)

Input and Output Error Rate Incidents (NNM iSPI for Performance)

Error rate incidents are available if NNM iSPI for Performance is installed and your administrator con-
figured performance measurement thresholds.

Input and output error rate incidents allow you to identify interfaces that are dropping data.

You receive input and output error rate incidents when an error rate threshold is not within the allowable
range set by your administrator. For example, the error rate must not exceed 10 percent. Reasons for set-
ting error rate thresholds include:

● Check for corrupted data packets

● Detect configuration mismatches

● Detect faulty hardware

Only error rates that exceed the allowable range generate an incident. The severity of error rate incidents
is Critical.

Information on the following Incident tabs is updated:
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● Correlated Parents

● Correlated Children

● Custom Attributes

The following table describes a combination of conclusions leading to error rate incidents. These appear
in the Conclusions lists on the associated interface and connection or node forms.

Form Conclusion Status

Interface InterfaceInputErrorRateHigh Critical

Connection SomeConnectionThreshold ValuesHigh Minor

Possible Conclusion Combinations for Error Rate Incidents (Interface and Connection)

Interface InterfaceInputErrorRateHigh Critical

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Error Rate Incidents (Interface and Node)

Input and Output Discard Rate Incidents (NNM iSPI for Performance)

NNM iSPI for Performance. Prerequisite, your NNMi administrator configured performance measurement
thresholds.

Input and output discard rate incidents enable you to identify interfaces that have transmission buffer over-
flows or are bottlenecks.

You receive input and output discard rate incidents when a discard rate is not within the allowable range
set by your administrator. For example, the discard rate must not exceed 10 percent. Reasons for setting
discard rate thresholds include:

● Check for large data packets

● Monitor bottlenecks

● Detect faulty hardware

Only discard rates that exceed the allowable range generate an incident. The severity of discard rate is
Critical.

Information on the following Incident tabs is updated:

● Correlated Parents

● Correlated Children

● Custom Attributes

The following table describes a combination of conclusions leading to discard rate incidents. These
appear in the Conclusions lists on the associated interface and connection or node forms.

Form Conclusion Status

Interface InterfaceInputDiscardRateHigh Critical

Connection SomeConnectionThreshold ValuesHigh Minor

Possible Conclusion Combinations for Discard Rate Incidents (Interface and Connection)
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Interface InterfaceInputDiscardRateHigh Critical

Node SomeInterfacesOutsideThresholdBoundariesInNode Minor

Possible Conclusion Combinations for Discard Rate Incidents (Interface and Node)

Find a Node

As part of the investigation and diagnosis process, you might want to access the details for a specific
node. One way is to use the Tools→ Find Node option. This option is particularly useful when you want to
search for a node by any of its IP addresses.

You can find a node based on the values described in the following table.

Possible
Values Description

Hostname The fully-qualified DNS name or the IP address, whichever is available. (This is the name
that appears in the Hostname field on Node forms.)

IP
address
of any
interface

The IP address for any interface on the node.

System
name

The full system name; for example cisco5500.abc.xyz.com that is obtained from the
node's SNMP agent. (This is the name that appears in the System Name field on Node
forms.)

Name The type of name your administrator has configured using the Node Name Resolution

attribute during discovery configuration. For example, this might be the short DNS name, or
short system name. (This is the name that appears in the Name field on Node forms.)

Find Node Attribute

To find a node using the node's hostname, IP address, system name, or name attribute value:

1. From the console, select Tools→ Find Node.

2. At the Node Name field of the Specify Node dialog, enter the hostname, an IP address, system
name, or Name value for the node of interest.

Note: Names are case-sensitive.

3. Click Find.

NNMi searches the database to find a matching value using each of the attributes listed in the preceding
table.

NNMi shows the node form for the node you specified. If no node is found, NNMi shows an error mes-
sage. If multiple nodes are found, NNMi shows the first node it finds.
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See "Access Node Details" (on page 127) for more information about the kind of information that appears
in the Node form. See Access More Details (Quick View and Forms) for a description of additional ways to
access node details.

Find the Attached Switch Port (NNM iSPI NET)

As part of the investigation and diagnosis process, you might need to determine the switch to which a prob-
lem node is connected. For example, if a node in your network has a potential virus, you want to identify
the switch to which it is connected so that you can prevent the virus from moving to other nodes in your net-
work. One way to identify a switch port attached to a problem node is to use the Tools→ Find Attached
Switch Port option.

You can find the attached switch and the port that is connected from the switch to the problem node using
any of the values described in the following table. Each of these values is for the problem node.

Note: The node whose information you provide does not have to be discovered by NNMi.

Possible
Values Description

Hostname The fully-qualified DNS name of the node whose attached switch port you are trying to
identify. (This is the name that appears in the Hostname field on Node forms.)

IP address of
any interface

The IP address for any interface on the node whose attached switch port you are trying
to identify.

MAC address The MAC (Media Access Control) address of any interface on the node whose attached
switch you are trying to identify.

Find Attached Switch Port Attribute

To find a the switch port that is attached to a node:

1. From the console, select Tools→ Find Attached Switch Port.

2. At the End Node Name field of the Specify Hostname, IP Address, or MAC Address dialog, enter
the hostname, an IP address, or the interface MAC address for the node of interest.

Note: Names are case-sensitive.

3. Click Find.

NNMi searches the database to find a matching value using the hostname, IP address, or MAC address
provided.

NNMi shows the hostname of the node and the name of the node's interface or port number. Click the
node name to open the Node form for the switch attached to the node you specified. Click the interface
name to open the Interface form. If the node or attached switch port is not found, NNMi shows an error
message. If multiple attached switches are found, NNMi shows the first attached switch it finds.

See "Access Node Details" (on page 127) for more information about the kind of information that appears
in the Node form. See Access More Details (Quick View and Forms) for a description of additional ways to
access node details.

Display End Nodes Attached to a Switch (NNM iSPI NET)

As part of the investigation and diagnosis process, you might need to determine the end nodes attached
to a switch. For example, if you need to upgrade a switch, you might need to check which servers are
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attached to the switch so that you can fill out the change request properly.

 You can display the end nodes attached to a switch using the NNMi console Actions menu.

1. Navigate to the view or form of interest and select the switch whose attached end nodes you want to
display.

To navigate to a table view and select a switch:

a. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

b. Click the view that contains the switch whose attached end nodes you want to display; for exam-
ple Nodes.

c. From the table view, click the  selection box in the row that represents the switch of interest.

To navigate to a map view and select a switch:

a. Navigate to the table view.

b. From the table view, click the   selection box in the row that represents the switch of interest.

c. Select Actions→ Layer 2 Neighbor View, Layer 3 Neighbor View, Node Group Map, or Path
View.

d. In the map, click the map symbol representing the switch of interest.

To navigate to a form:

a. From a table view, click the  Open icon in the row that represents the switch of interest.

b. From a map view, click the switch of interest on the map and click the  Open icon.

2. Select Actions→ Show Attached End Nodes.

NNMi displays the following for each end node that it determines is attached to the switch:

■ Resolved hostname

■ MAC address of the connected interface

■ IP address

Note the following: 

■ If the end node does not have a resolvable hostname, NNMi repeats the node's IP address.

■ If NNMi is unable to locate any information about end nodes attached to the selected switch,
NNMi displays a message that it was unable to locate any entries for the switch.

6. Click any object name link to open the form for the selected object.

Note: If the object name appears without a link, this indicates NNMi has not discovered the node or
interface.

Related Topics

"Find the Attached Switch Port (NNM iSPI NET)" (on page 190)

Test Node Access (Ping)

You can verify that a node or IP address is reachable using the ping command from the NNMi console
Actions menu.

Note: NNMi uses the packet size used by the current operating system.
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From an incident view:

1. Click the  selection box that precedes the incident whose source node you want to ping.

2. Select Actions→ Ping (from server).

Note: NNMi pings the source node of the incident. It does not ping the source object. For example, if the
incident is related to an interface, NNMi pings the node on which the interface resides, not the inter-
face itself.

From other views or forms:

1. Navigate to the view or form of interest and select the node or IP address you want to ping.

To navigate to a table view and select a node:

a. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

b. Click the view that contains the node or IP address that you want to verify is reachable; for exam-
ple Nodes.

c. From the table view, click the  selection box in the row that represents the node or IP address.

To navigate to a map view and select a node:

a. Navigate to the table view.

b. From the table view, click the   selection box in the row that represents the node or IP address.

c. Select Actions→ Layer 2 Neighbor Views, Layer 3 Neighbor Views or Path View.

d. In the map, click the map symbol representing the node of interest.

To navigate to a form:

a. From a table view, click the  Open icon in the row that represents the node or IP address of
interest.

b. From a map view, click the node of interest on the map and click the  Open icon.

2. Select Actions→ Ping (from server)

NNMi displays the ping results, including reply times and ping statistics.

Find the Route (traceroute)

When investigating and diagnosing network problems, you might want to trace the route path using the
traceroute command. Using traceroute also lets you identify bottlenecks along the destination path pro-
vided. You can access the traceroute command from the NNMi console Actions menu.

Note: You can also use Path View to display the routing path between two nodes that have IPv4
addresses. See "Path Between Two Nodes that Have IPv4 Addresses" (on page 113) for more infor-
mation.

Note: The starting node is the NNMi management server on which you are running the trace route com-
mand.

To access the trace route command:

1. From an incidents view, select the incident whose source node on which you want to use trace route.

Or from a nodes view, select the node on which you want to use trace route.

2. Select Actions→ Trace Route (from server).
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NNMi displays the output from trace route, including the lists of routers that are traversed to reach the
destination node.

To navigate to a table view and select a node:

1. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

2. Click the view that contains the node whose communication settings you want to check; for example
Nodes.

3. From the table view, click the   selection box that precedes the node whose configuration you want
to check.

To navigate to a map view and select a node:

1. Navigate to the table view.

2. From a table view, click the   selection box that precedes the node of interest.

3. Select Actions.

4. From the drop-down menu, select the map view of interest.

5. From the map view, click the node whose configuration you want to check.

To navigate to a form:

1. From the table view, click the  Open icon that precedes the node of interest.

2. From a map view, click the node of interest on the map and click the  Open icon.

Establish Contact with a Node (telnet)

When investigating and diagnosing network problems, you might need to establish a connection to a node
to view or change configuration information. You can establish a connection to a node using the telnet
command from the NNMi console Actions menu.

Note: To access telnet from Microsoft Internet Explorer, you must first tune the FEATURE_DISABLE_TEL-
NET_PROTOCOL registry entry as described in: http://msdn2.microsoft.com/en-us/li-
brary/ms537169.aspx. More specifically, you will want to add the following registry key: [HKEY_
LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\F-

eatureControl\FEATURE_DISABLE_TELNET_PROTOCOL] to have the value: "iex-

plore.exe"=dword:00000000. HP recommends that you back up your registry before making
any changes. For information about how to back up and edit your registry, see the Microsoft Knowl-
edge Base article at http://support.microsoft.com/kb/322756.

To establish contact with a node using telnet:

From an incident view:

1. Click the   selection box that precedes the incident whose source node you want telnet. 

2. Select Actions→ Telnet (from client).

Note: NNMi telnets the source node of the incident. It does not telnet the source object. For example, if the
incident is related to an interface, NNMi telnets to the node on which the interface resides, not to the
interface itself.

From other views or forms:

1. Navigate to the view or form of interest and select the node to which you want to telnet.

To navigate to a table view and select a node:
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a. From the workspace navigation panel, select the workspace of interest; for example, Inventory.

b. Click the view that contains the node whose communication settings you want to check; for
example Nodes.

c. From the table view, click the   selection box that precedes the node whose configuration you
want to check.

To navigate to a map view and select a node:

a. Navigate to the table view.

b. From a table view, click the   selection box that precedes the node of interest.

c. Select Actions.

d. From the drop-down menu, select the map view of interest.

e. From the map view, click the node whose configuration you want to check.

To navigate to a form:

a. From a table view, click the  Open icon that precedes the node of interest.

b. From a map view, click the node of interest on the map and click the  Open icon.

2. Select Actions→ Telnet (from client).

NNMi displays a browser window and a telnet window.

Check Status Details for a Node Group

When diagnosing and troubleshooting problems, you might want to check the status for only a particular
set of nodes. Your network administrator is able to group sets of nodes into Node Groups. An example
Node Group could be all important Cisco routers, or all routers in a particular building. See About Node
and Interface Groups for more information about how your administrator sets up Node Groups. See Filter
by Node or Interface Group for more information about filtering views using Node Groups.

You can view Node Group status information using the Nodes Group View or Node Group Map view. See
"Node Groups View (Inventory)" (on page 23) or "Node Groups View (Monitoring)" (on page 125) as well
as "Node Group Maps" (on page 98) for more information. When you want more details about the number
of nodes that have a particular status within the Node Group, use the Actions menu.

Note: The Status Details window automatically refreshes Status Detail information every 5 minutes.

To check the status details for a Node Group using a table view:

1. Navigate to the Node Groups view of interest. For example, selectMonitoring→ Node Groups.

2. Click the selection box that precedes the Node Group of interest.

3. Select Actions→ Status Details.

For the Node Group selected, NNMi shows the following information:

● Node Group name

● Overall Node Group status

● Number of nodes in the group with each possible status

● Percentage of nodes in the group with each possible status

To check the status details for a Node Group using a map view:
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1. From the workspace navigation panel, select the Inventory or Monitoring workspace.

2. Select Node Groups.

3. In the Node Group view, click the  selection box that precedes the Node Group of interest.

4. Select Actions→ Node Group Map.

See About Map Status for more information about status colors.
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Checking the Status of NNMi

To confirm that NNMi is running properly, check NNMi status. If one or more of the NNMi processes or
services are not running, contact your NNMi administrator to have the process or service restarted.

To check the health of NNMi:

1. From the NNMi console, select Tools→ NNM Status.

NNMi displays a list showing the status of each process and service.

Each process and service should be running. If one is not, contact your NNMi administrator.

You can also check the health of the State Poller.

To check the health of the State Poller:

1.  From the NNMi console, select Help→ About HP Network Node Manager i-series.

NNMi displays the status of the State Poller as well as State Poller collection and queue information.
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Appendix A. Glossary Terms

A

Anycast Rendezvous Point
IP Address

Rendezvous Point addresses
are loopback addresses used
for routers in multi-cast net-
work configurations

L

Layer 2
Refers to the Data Link layer of
the multilayered com-
munication model, Open Sys-
tems Interconnection (OSI).
The Data Link layer moves
data across the physical links
in the network. The switches
and bridges are devices that
redirect data messages at the
layer 2 level, using the des-
tination Media Access Control
(MAC) address to determine
where to direct the message.

Layer 3
Refers to the Network layer of
the multilayered com-
munication model, Open Sys-
tems Interconnection (OSI).
The Network layer is con-
cerned with knowing the
address of the neighboring
nodes in the network, selecting
routes and quality of service,
and recognizing and

forwarding incoming mes-
sages to local host domains.
The router and switch-router
are the devices that redirect
data messages at the Layer 3
level. Everything in a subnet is
connected at the Layer 3 (IP)
level.

Link Aggregation
A Link Aggregation is com-
prised of an Aggregator Link,
Aggregator Interface, and the
physical interfaces and con-
nections that they represent.
An Aggregator Link object rep-
resents many-to-many phys-
ical connections. For example,
two nodes might be connected
with four physical connections.
These four physical con-
nections are depicted as a sin-
gle Aggregator Link object
using a thick line on the Layer
2 Neighbor View map. The
interface depicted at each end
of the Aggregator Link object is
an Aggregator Interface object.
An Aggregator Interface object
represents the collection of
physical interfaces for one end
of an Aggregator Link.

loopback address
The address associated with
the loopback interface. The
loopback interface is a virtual
interface on a device that pro-
vides a route for internal com-
munication. Many vendors
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provide a specially configured
loopback for management pur-
poses. Exact details of how
loopbacks are configured
varies by vendor and model.
See each device's doc-
umentation for details. NNM
identifies these loopback
addresses by using IfType 24,
softwareloopback from the
IANA ifType-MIB.
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Appendix B: Index

A

abnormal network behavior, troubleshooting12

accessing

device details 26, 54

node details 127

old NNM features 13

Path View 113

performance data 116

problem devices 127

related

incidents 128

traceroute command 192

Actions menu

accessing

maps 98-99, 146, 194

performance data 116

investigating devices 127

monitoring configuration settings 166

Path View 113

running diagnostics 44-45, 140

troubleshooting network problems 103, 110,
165

unassigning incidents 143

updating lifecycle states 145

active paths 114

adding

maps 102

node

capabilities 36

subnet notes 112

Additional Filters tab 89, 95

Additional Node form 90

Additional Nodes tab 89

Address Disabled 169

Address Not Responding 170

addresses

configuration settings 166

customizing views 23

disabled 169

identifying non-responsive 122

not

responding 170

polling policy 72, 78

administrative states 123

Advanced, NNMi

Aggregator Interface Degraded 170

Aggregator Interface Down 171

Aggregator Link Degraded 172

Aggregator Link Down 172

enhanced Path View 116

interface capabilities 65

Interface form 63, 70

Layer 2 Connection form 108

Management Stations view 24

Multiple Primary Device 185

Multiple Secondary Device 185

No Primary Device 184

No Secondary Device 185

node capabilities 34

Primary Device 184

RAMS 113

Router Redundancy Group

form 79, 83-84

view 22

Router Redundancy Group Degraded 185

Router Redundancy Member form 80, 82

Service Impact incidents 183

Tracked Objects form 82
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Virtual IP Addresses form 84

agents, SNMP

not responding 182

Aggregator Interface Degraded incidents 170

Aggregator Interface Down incidents 171

Aggregator Link Degraded incidents 172

Aggregator Link Down incidents 172

alerts, network 168

annotating information 12

Assigned To lookup field 143

assigning

incidents 142-143

attached switch ports, finding 190

attribute values

Additional Node form 90

device

author 57

category 57

family 56

profile 54

vendor 56

Find Attached Switch Port 190

Health Attribute form 41

IfType Filter form 95

IfTypes form 95

Incident Diagnostic Results form 140

Incident form 132, 134, 138, 140-141

incidents 139

Interface Capability form 67

Interface Custom Attributes form 68

Interface form 58, 61-63, 65, 68-72

Interface Group form 93-94

IP Address form 72, 74-75, 78

IP Subnet form 112

Layer 2 Connection form 105-108, 110

Lifecycle State 144

Management Stations form 96

Node Capability form 36

Node Component form 38, 40, 42-44

Node Custom Attributes form 37

Node Device Filter form 88

Node Diagnostic Results form 45

Node form 27, 32-33, 37-38, 44, 46-48

Node Group form 87-89, 92

Node Group Hierarchy form 91

nodes 189

Port form 86

RCA Active 144

Router Redundancy Group form 78-79

Router Redundancy Member form 80, 82

SNMP Agent form 49, 52-53

Tracked Objects form 82

Virtual IPaddresses form 84

VLAN form 85

attributes

IP addresses 23

Notes 144

Author form 57

B

broadcast domain, reduced 19

Buffer has Insufficient Capacity or is Malfunctioning incident173

C

calculation rules, Path View 114

capabilities

interface 65

node 34

Capabilities tab

Interface form 65

Node form 33-34
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categories

devices 57

incidents 154, 162

Causal Engine 147, 158, 165, 168, 178

causes, root

connectivity problems 103, 110

incident

messages 168

views 151, 156, 158-159

checking

NNMi status 196

node group status details 194

Child Node Group

attribute 91

displaying 99

Child Node Groups tab 91

CIAs 139

Cisco

protocols 116

routers 15

Closed Key Incidents view 156

colors

device connections 97

status 126

commands

ping 191

traceroute 116, 192

Component Health

tab 38

components

Causal Engine 147, 158, 165, 168

Conclusions tab

Interface form 71

IP Address form 75

Layer 2 Connection form 108

Node Component form 44

Node form 48

SNMP Agent form 52

configuration

monitoring settings 166

verifying device 165

configuring

device profiles 54

connecting to nodes 193

connection

mesh 103

Connection Down incident 173

Connection Partially Unresponsive incident174

connectivity

troubleshooting problems 103, 110

viewing network maps 97

Correlated Children tab 138

Correlated Parents tab 138

Correlation Nature attribute 183

CPU Utilization is Too High incident 175

creating

attributes

Author 57

Device Category 57

Device Family 56

Device Vendor 56

criteria

node down 178

Critical Interfaces view 118

Critical Nodes view 119

Critical status 118, 170-172, 181

custom attributes

for nodes 37

Custom Attributes tab 138

Interface form 68
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Node form 37

Custom Incident Attributes 139

Custom Incidents view 147, 161

Custom Interfaces view 22

Custom IP Addresses view 23

Custom Nodes view 21

customer network 116

customizing views

nodes 21

D

database

deleting objects 15

determining SNMP Agent attributes 49, 52-
53

SNMP trap limit 181

defining

interface groups 93

degraded aggregator

interface 170

link 172

deleting

abnormal network behavior 12

maps 102

nodes 15

detecting abnormal network behavior 12

determining

problem scopes 127

Device Category form 57

Device Family form 56

Device Filters tab 88

Device Profile form 54

Device Vendor form 56

devices

accessing problem 127

active path 114

categories 15, 20

connections 103

families 56

identifying 113, 126

managed 26

profiles 54

types 54

verifying

configuration details 165

status 168

VLANs 19

diagnosing network problems 165

diagnostic results, node 45

Diagnostics tab 44-45, 140

diagrams, flow 113

disabled

address 169

interface 176

discard rate incidents 188

discovering networks 14

updating information 165

Discovery, Spiral 54

displaying

incidents 128, 146

key incidents closed 156

Layer 2 connectivity 103

Layer 3 connectivity 110

network connectivity maps 97

Network Infrastructure Devices Overview map101

Node Group map 98-99

Node Group Overview map 100

paths between nodes 113

root cause incidents 158-159

category 154

closed 156
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family 155

lifecycle state 157

open 151

priority 153

unassigned 151

Routers map 102

Switches map 102

views 19

domain, reduced broadcast 19

down

aggregator

interface 171

link 172

connection 173-174, 180

interface 175

node 178, 180

E

enhanced Path View 116

error rate incidents 187

errors, Path View 116

expanding child in node group map 98

Express Forwarding, Cisco 116

extending capabilities

node 36

F

Failover in Router Redundancy Group message184

families

filtering views 155

Family

incidents 161

Fan Is Malfunctioning incident 175

fault management 12

features, accessing old 13

filtering

incidents 131

categories 154

custom 161

families 155

NNM 6.x/7.x events 162

priorities 153

severities 151

SNMP traps 162

interface

administrative state 123

custom 22

groups 15, 24

operational state 123

status 123

IP addresses 23, 124

node groups 15, 23

views 14, 20, 122, 157

filters

additional 95

interface

groups 94

types 95

Find Attached Switch Port option 190

finding

attached switch port 190

nodes 189

route path 192

flow

diagrams 113

forms

Additional Node 90

Author 57

Custom Incident Attribute 139

Device Category 57

Device Family 56
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Device Profile 54

Device Vendor 56

Health Attribute 41

IfType Filter 95

IfTypes 95

Incident 132, 134, 138, 140-141, 170-172

Incident Diagnostic Results 140

Interface 58, 61-63, 65, 68-72

Interface Capability 67

Interface Custom Attributes 68

Interface Group 93-95

IP Address 72, 74-75, 78

IP Subnet 112

Layer 2 Connection 105-108, 110

Management Stations 96

navigating 165, 191-193

Node 27, 32-34, 37-38, 44, 46-48

Node Capability 36

Node Component 38, 40, 42-44

Node Custom Attributes 37

Node Device Filter 88

Node Diagnostic Results 45

Node Group 87-89, 91-92

Node Group Hierarchy 91

Port 86

Router Redundancy Group 78-79, 83-84

Router Redundancy Member 80, 82

SNMP Agent 49, 52-53

Tracked Objects 82

updating lifecycle state 145

Virtual IPAddresses 84

VLAN 85

G

General tab 32, 61, 134

Global Load Balancing, Cisco 116

groups

defining

interface 93

H

Health Attribute

form 41

tab 40

health, component 38

health, network

verifying 196

historical information 12

HSRP

nodes 116

I

ICMP

displaying root cause incidents 158

incidents 147

ping command 170

icons

Interface form 69

node status 43

severity 130

identifying

critical nodes 119

devices 113

inteface performance 125

IP addresses 17, 23, 124

networks

interfaces managed by NNMi 16

management domain 18

nodes

by status 122

managed 15

non-normal

interfaces 120
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nodes 120

non-responsive addresses 122

IfType Filter

form 95

tab 94

IfTypes

form 95

important nodes

critical status 174, 178

Incident Diagnostic Results form 140

Incident form 132, 134, 138, 140-141, 170-
172

incidents

Address Not Responding 170

Aggregator Interface Degraded 170

Aggregator Interface Down 171

Aggregator Link Degraded 172

Aggregator Link Down 172

assigning 142-143

attributes 139

Buffer has Insufficient Capacity or is Malfunctioning173

Connection Down 173

Connection Partially Unresponsive 174

CPU Utilization is Too High 175

displaying

map 146

Fan is Malfunctioning 175

input and output

discard rate 188

error rate 187

utilization 186

Interface Disabled 176

Interface Down 175

Interface Unmanageable 177

key 149

key views 148

lifecycle 144-145

monitoring 130

No Primary Device in Router Redundancy Group184

No Secondary Device in Router Redundancy Group185

Node Down 178

Node or Connection Down 180

Non-SNMP Node Unresponsive 181

Number of SNMP Traps Persisted in the Database has Reached or Exceeded Trap Limit181

open 148

open root cause 159

organizing 131

owning 142

Power Supply is Malfunctioning 182

Service Impact 183

SNMP Agent Not Responding 182

Temperature Sensor is Out of Range 182

threshold 185

tracking

progress 145

troubleshooting 132, 134, 138, 140-141,
160, 168

unassigning 143

updating 144

views 147

categories 154

custom 161

families 155

lifecycle state 157

management stations 24

NNM 6.x/7.x events 162

priorities 153

related 128

root cause 158

router redundancy group 22
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severities 151

SNMP traps 162

Voltage is Out of Range 183

Incidents by Family view 161

Incidents tab

Interface form 70

IP Address form 74

Layer 2 Connection form 106

Node Component form 42

Node form 46

Router Redundancy Group form 84

SNMP Agent form 53

input

discard rate 69, 188

error rate 69, 187

utilization 69, 186

insufficient

buffer capacity 173

memory 178

interface

configuration settings 166

customizing views 22

disabled 169

filtering

administrative states 123

operational states 123

status 123

identifying non-normal 120

monitoring

views 118

notes 16

out-of-box

capabilities 65

performance states 69

polling policy 58

status 16

viewing

all 16

non-normal 120

Interface by Administrative State view 123

Interface by IfType view 20

Interface Capability form 67

Interface Custom Attributes form 68

Interface Disabled incident 176

Interface Down incident 175

Interface form 58

Capabilities tab 65

Conclusions tab 71

Custom Attributes tab 68

General tab 61

Incidents tab 70

Interface Groups tab 68

IP Addresses tab 62

Link Aggregation tab 63

Performance tab 69

Registration tab 72

Status tab 70

VLAN Ports tab 63

Interface Group

form 93-95

view 24

interface groups

defining 93

filters 15, 24

viewing

details 24

Interface Groups tab 68

Interface Performance view 125

Interface Unmanageable incident 177

Interfaces by Operational State view 123

- 206 -



Index: Interfaces by Status view – logical networks

Interfaces by Status view 123

Interfaces tab

Layer 2 Connection form 106

Node form 32

Interfaces view 16

interpreting threshold incidents 185

inventory

network 14

Inventory workspace

Interfaces view 16

Layer 2 Connections view 19

Management Stations view 13

Nodes view 15

investigating

network problems 165

IP Address form 72, 78

Conclusions tab 75

Incidents tab 74

Status tab 74

IP Addresses

tab 62

IP Addresses by State view 124

IP Addresses tab

IP Subnet form 112

Node form 32

IP Addresses view 17

IP Subnet form 112

IP Addresses tab 112

Registration tab 112

IP Subnets view 18

ipRoute tables 116

IPv4 addresses 113

Island Node Group 87, 146

isolating abnormal network behavior 12

iSPIs

NNM iSPI for Performance

configuration monitoring 166

Health Attribute form 41

incidents 185-188

interfaces 24, 93, 125

nodes 23, 38, 87

performance issues 116

K

Key Incident views 148

key incidents, viewing 149, 151, 153-156

L

LANs, virtual 19, 85

Layer 2 Connection form 105

Conclusions tab 108

Incidents tab 106

Interfaces tab 106

Link Aggregation tab 108

Registration tab 110

Status tab 107

Layer 2 Connections view 19

Layer 2 Neighbors view 97, 103

Layer 3 Neighbors view 97, 110

Layer 3 networks 101

Level 1 Operator role 143

Level 2 Operator role 143

lifecycle, incidents 144-145, 157

limits

Path View 116

SNMP traps in database 181

Link Aggregation tab

Interface form 63

Layer 2 Connection form 108

local area networks, virtual 85

logical networks 19
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M

MAC-based VLANs 19

malfunctioning

buffer 173

fan 175

memory 178

power supply 182

managed device, viewing details 26

management mode

interface 58

IP addresses 72

nodes 27

management network 116

Management Stations

form 96

view 13, 24

managing

incident assignments 142

map objects, viewing details 127

map views

checking node group 194

determining problem scopes 127

Device Profiles 54

incidents 146

monitoring network problems 126

navigating 165, 168, 191-193

network connectivity 97, 113

node groups 126

status colors 126, 168

viewing object details 26

maps

Network Infrastructure Devices Overview 101

Network Overview 101

Node Group 98-100

Node Group Overview 100

Routers 102

Switches 102

Maps

Island Node Group 146

memory, insufficient or malfunctioning 178

mesh connection 103

messages, incidents

root causes 168

monitoring

configuration settings 166

devices 20

incidents 130

interface

administrative states 123

operational states 123

network

problems 118, 126, 130

node groups 125

Mulitple Secondary Devices in Router Redundancy Group root cause message185

multiple

VLANs 19

Multiple Primary Devices in Router Redundancy Group root cause message185

My Open Incidents view 142, 148

N

navigating

forms 165, 191-193

map views 165, 168, 191-193

maps 99

table views 165, 168, 191-193

neighborhood view maps 97

network

abnormal behavior 12

alerts 168

connectivity maps 97

customer 116
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discovering 14

identifying issues 126

interfaces 16

inventory 14

investigating problems 165

management 116

monitoring

health 196

problems 118

protocol design 97

Network Infrastructure Devices Overview map101

Network Overview map 101

NNM iSPI for Performance 125

configuration monitoring 166

Health Attribute form 41

incidents 185-188

interfaces 24, 93, 125

nodes 23, 38, 87

performance issues 116

NNMi

6.x/7.x

Events by Category view 162

Events view 162

features 13

viewing incidents 147

viewing remote management stations 96

Advanced

Aggregator Interface Degraded 170

Aggregator Interface Down 171

Aggregator Link Degraded incidents 172

Aggregator Link Down 172

enhanced Path View 116

interface capabilities 65

Interface form 63, 70

Layer 2 Connection form 108

Management Stations view 24

Multiple Primary Devices 185

Multiple Secondary Devices 185

No Primary Devices 184

No Secondary Device 185

node capabilities 34

Primary Device 184

RAMS 113

Router Redundancy Group Degraded 185

Router Redundancy Group form 79, 83-
84

Router Redundancy Group view 22

Router Redundancy Member form 80, 82

Service Impact incidents 183

Tracked Objects form 82

Virtual IP Addresses form 84

checking status 196

using 12

No Primary Device in Router Redundancy Group incident184

No Secondary Device in Router Redundancy Group incident185

Node Capability form 36

Node Component configuration settings 166

Node Component form 38

Conclusions tab 44

Health Attributea tab 40

Incidents tab 42
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Index: Node Group – Nortel
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Index: Not Responding Address view – ports
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Index: Ports tab – root causes
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Index: Stream Correlation Incidents view – track priority
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Device Filters 88

Diagnostics 44-45, 140
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Performance 69
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devices 20
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Unassigned Key Incidents view 151

Unassigned Vital Incidents view 142-143

unassigning incidents 143

unmanageable interface 177

unresponsive
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nodes 181
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status 168
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node details 127
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Custom IP Addresses 23
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IP Addresses by State 124

IP Subnets 18

Key Incident 148

Layer 2 Connections 19

Layer 2 Neighbors 103

Layer 3 Neighbors 110

Management Stations 24

My Open Incidents 142, 148
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